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1.1 Informazioni su questo manuale 
 

Figura 1-1: Il *bisogno* di manuali (xkcd.com) 
 

Questo Manuale Utente è il prodotto di un grande gruppo di volontari della comunità MX 
Linux. Come tale, conterrà inevitabilmente errori ed omissioni, anche se abbiamo lavorato 
duramente per ridurli al minimo. Vi preghiamo di inviarci feedback, correzioni o suggerimenti 
utilizzando uno dei metodi elencati di seguito. Gli aggiornamenti avverranno secondo necessità. 

 
Il manuale è progettato per guidare i nuovi utenti attraverso i passi per ottenere una copia di 
MX Linux, installarlo, configurarlo per lavorare con il proprio hardware e metterlo in uso 
quotidiano. Mira a fornire un'introduzione generale leggibile, e dà volutamente la preferenza 
agli strumenti grafici quando disponibili. Per argomenti dettagliati o poco frequenti, l'utente 
dovrebbe consultare le Risorse o postare sul Forum. 

 
MX Fluxbox non è incluso qui perché differisce da Xfce e KDE così tanto che allungherebbe e 
complicherebbe questo manuale. Un documento di aiuto separato è incluso in ogni installazione 
di MX Fluxbox. 

 
I nuovi utenti potrebbero trovare alcuni dei termini usati in questo manuale poco familiari o 
confusi. Abbiamo cercato di limitare l'uso di termini e concetti difficili, ma alcuni sono 
semplicemente inevitabili. Il glossario situato alla fine del documento fornisce definizioni e 
commenti che aiuteranno a superare i passaggi difficili. 

 
Tutti i contenuti sono © 2021 di MX Linux Inc. e rilasciati sotto GPLv3. La citazione dovrebbe essere letta: 

 
MX Linux Community Documentation Project. 2021. Manuale utente per MX Linux. 

 
Feedback: 

 
• Email: manual AT mxlinux DOT org 

 
• Forum: Documentazione e video MX 

 1Introduzione 

https://forum.mxlinux.org/viewforum.php?f=101


1.2 Informazioni su MX Linux 

Gli utenti sono molto diversi nel loro atteggiamento verso MX Linux--o qualsiasi sistema 
operativo. Alcuni possono semplicemente volere un apparecchio che funzioni, come una 
caffettiera che produce una bevanda calda su richiesta. Altri possono essere curiosi di sapere 
come funziona veramente, cioè perché ottengono il caffè e non una fanghiglia densa. Questa 
sezione ha lo scopo di orientare il secondo gruppo. Il primo gruppo potrebbe preferire saltare 
avanti alla Sezione 1.3: "Informati! 

 
MX Linux è una versione desktop della fusione della collezione Gnu di software libero e del 
kernel Linux, entrambi iniziati nei primi anni '90. Gnu-Linux, o più semplicemente e 
comunemente chiamato "Linux", è un sistema operativo libero e open-source che ha un 
approccio unico e di grande successo a tutto, dal kernel agli strumenti alla struttura dei file 
(Sezione 7). Viene consegnato agli utenti attraverso distribuzioni o "distro", di cui una delle più 
antiche e popolari è Debian su cui è costruito MX Linux. 

 

1.2.1 Linux 

Per fornire una rapida panoramica, ecco un diagramma semplificato e una descrizione di un 
sistema operativo Linux, adattato da Anatomia del kernel Linux. 

 
 

 
 
 
 

• In cima c'è lo spazio utente, AKA application space. Questo è dove vengono eseguite le 
applicazioni utente fornite dalla distribuzione o aggiunte dall'utente. C'è anche 
l'interfaccia GNU C Library (glibc) che collega le applicazioni con il kernel. (Da qui il 
nome alternativo "GNU/Linux" visto nel diagramma). 

 
• Sotto lo spazio utente c'è lo spazio kernel dove esiste il kernel Linux. Il kernel è 

dominato dai driver hardware. 

https://www.gnu.org/
https://en.wikipedia.org/wiki/Linux
https://en.wikipedia.org/wiki/Linux_distribution
https://en.wikipedia.org/wiki/Debian


File system 

Uno dei primi problemi che molti nuovi utenti di Linux devono affrontare è come funziona 
il file system. Molti nuovi utenti hanno cercato invano di trovare l'unità C:\ o l'unità D:\, per 
esempio, ma Linux gestisce i dischi rigidi e altri supporti di memorizzazione in modo 
diverso da Windows. Piuttosto che avere un albero di file system separato su ogni 
dispositivo, MX Linux ha un unico albero di file system (chiamato 
/root/ del file system) che è marcata "/" e contiene ogni dispositivo collegato. Quando un 
dispositivo di memorizzazione viene aggiunto al sistema, il suo file system è collegato a una 
directory o sottodirectory del file system; questo si chiama montare un'unità o un dispositivo. 
Inoltre, ogni utente ha una sottodirectory dedicata sotto /home, e per impostazione predefinita 
questa è dove si cercano i propri file. Dettagli nella Sezione 7. 

La maggior parte dei programmi e delle impostazioni di sistema su MX Linux sono 
memorizzati in discreti file di configurazione di testo semplice; non c'è un "registro" che 
richiede strumenti speciali per essere modificato. I file sono solo semplici elenchi di parametri e 
valori che descrivono il comportamento dei programmi quando vengono lanciati. 

Avvertenze 

I nuovi utenti arrivano con aspettative dalla loro precedente esperienza. Questo è naturale, ma 
può portare all'inizio a confusione e frustrazione. Due nozioni fondamentali da tenere a mente: 

1. MX Linux non è Windows. Come indicato sopra, non c'è un registro, l'unità C:\ non 
esiste e la maggior parte dei driver sono già nel kernel. 

2. MX Linux non è basato sulla famiglia Ubuntu, ma su Debian stessa. Questo significa 
che i comandi, i programmi e le applicazioni (specialmente quelli nei "Personal Package 
Archives" o PPA) della famiglia Ubuntu potrebbero non funzionare correttamente o 
addirittura mancare. 

 

1.2.2 MX Linux 

MX Linux è un'impresa cooperativa tra le comunità antiX ed ex MEPIS rilasciata per la prima 
volta nel 2014, utilizzando i migliori strumenti e talenti di ogni distro e includendo il lavoro e le 
idee originariamente create da Warren Woodford. È un sistema operativo di medio peso 
progettato per combinare un desktop elegante ed efficiente con una configurazione semplice, 
alta stabilità, prestazioni solide e un ingombro medio. 

 
Facendo affidamento sull'eccellente lavoro a monte di Linux e della comunità open-source, con 
MX-21 distribuiamo il nostro ambiente desktop di punta Xfce 4.16, insieme a KDE/plasma 
5.20.5 e Fluxbox 1.3.7 come versioni separate e indipendenti. Il tutto poggia su una base Debian 
Stable (Debian 11, "Bullseye"), attingendo anche al nucleo del sistema antiX. Continui backport 
e aggiunte esterne ai nostri repo servono a mantenere i componenti aggiornati con gli sviluppi 
come richiesto dagli utenti. 

 
L'MX Dev Team è composto da un gruppo di volontari con vari background, talenti e 
interessi. Dettagli: Chi siamo. Un ringraziamento speciale per il forte e continuo sostegno a 
questo progetto va agli MX Linux Packagers, ai produttori di video, ai nostri grandi volontari 

https://antixlinux.com/
https://en.wikipedia.org/wiki/MEPIS
https://docs.xfce.org/start
https://docs.xfce.org/start
http://www.debian.org/
http://www.debian.org/
https://wiki.debian.org/DebianStable
https://mxlinux.org/about-us


e a tutti i nostri traduttori! 



1.3 Informati! 

Le icone sul desktop si collegano a due documenti utili: le FAQ e il Manuale Utente. 
 

• Le FAQ forniscono un rapido orientamento per i nuovi utenti rispondendo alle 
domande più comuni del forum. 

 
• Il manuale utente fornisce uno sguardo dettagliato al sistema operativo. Poche persone 

lo leggono dall'inizio alla fine, ma può essere consultato rapidamente 1) usando lo 
schema per saltare all'argomento generale che vi interessa, o 2) premendo Alt + F1 per 
aprirlo e Ctrl + F per cercare una voce particolare. 

 
• Altre fonti di informazione includono il Forum, il Wiki, la collezione di video online e 

vari social media. Queste fonti sono più facilmente raggiungibili attraverso la Home 
page. 

 
1.4 Supporto e EOL 

Che tipo di supporto è disponibile per MX Linux? La risposta a questa domanda dipende dal 
tipo di supporto che intendete: 

 
• Problemi basati sull'utente. Esiste una serie di meccanismi di supporto per MX 

Linux, da documenti e video a forum e motori di ricerca. Vedi la pagina del supporto 
della comunità per i dettagli. 

 
• Hardware. L'hardware è supportato nel kernel, dove c'è uno sviluppo continuo. 

Hardware molto nuovo potrebbe non essere ancora supportato, e hardware molto 
vecchio, sebbene ancora supportato, potrebbe non essere più sufficiente per le 
richieste del desktop e delle applicazioni. Tuttavia, la maggior parte degli utenti 
troverà il supporto per il proprio hardware disponibile. 

 
• Desktop. Xfce4 è un desktop maturo che rimane in fase di sviluppo. La versione 

fornita con MX Linux (4.16) è considerata stabile; gli aggiornamenti importanti 
saranno applicati quando saranno disponibili. L'ambiente KDE/plasma è mantenuto 
su base continua. 

 
• Applicazioni. Le applicazioni continuano ad essere sviluppate dopo il rilascio di 

qualsiasi versione di MX Linux, il che significa che le versioni fornite diventeranno 
più vecchie col passare del tempo. Questo problema è affrontato attraverso una 
combinazione di fonti: Debian (incluso Debian Backports), sviluppatori individuali 
inclusi gli sviluppatori di MX, e il Community Packaging Team, che accetta le 
richieste di aggiornamento degli utenti il più possibile. L'MX Updater segnala quando 
nuovi pacchetti sono disponibili per il download. 

 
• Sicurezza. Gli aggiornamenti di sicurezza di Debian copriranno gli utenti di 

https://mxlinux.org/
https://mxlinux.org/
https://mxlinux.org/
https://mxlinux.org/
https://mxlinux.org/support
https://mxlinux.org/support
https://mxlinux.org/support


MX Linux fino al prossimo futuro. Guardate ancora MX Updater per la notifica 
della disponibilità. 



Note per i traduttori 
Un po' di orientamento per le persone che traducono il manuale utente: 

• I testi in inglese dietro l'ultima release sono in un repo GitHub. Le traduzioni sono 
memorizzate nella directory "tr". 

◦ Puoi lavorare all'interno del sistema GitHub: clona il repo principale, fai delle 
modifiche e poi fai una richiesta di pull per farla rivedere per la fusione con il 
sorgente. 

◦ In alternativa, puoi scaricare ciò che ti interessa e lavorarci sopra localmente prima 
di notificare che è pronto o con una email a manual AT mxlinux DOT org o 
scrivendo sul forum. 

• In termini di importanza, si raccomanda di iniziare con le sezioni 1-3 che forniscono le 
informazioni più rilevanti per il nuovo utente. Una volta che queste sono fatte, possono 
essere distribuite agli utenti come traduzione parziale mentre le sezioni successive 
vengono tradotte. 

• Le traduzioni disponibili sono tracciate nel Wiki di MX/antiX. 

https://github.com/jerry3904/mxum
https://help.github.com/articles/cloning-a-repository/
https://help.github.com/articles/about-pull-requests/
https://mxlinux.org/wiki/help-files-other/users-manual-translations


2 Installazione 
2.1 Introduzione  
Un MX Linux LiveMedium (USB o DVD) avvia il computer senza accedere al disco rigido. 
Copia un file system virtuale nella RAM che agisce come centro di un sistema operativo 
temporaneo per il computer. Quando si termina la sessione Live, tutto ciò che riguarda il 
computer torna come prima, immutato (contrasto Sezione 6.6.1). 
Questo fornisce una serie di vantaggi: 

• Vi permette di eseguire MX Linux sul vostro computer senza installarlo. 
• Ti permette di determinare se MX Linux è compatibile con il tuo hardware. 
• Ti aiuta a farti un'idea di come funziona MX Linux e ad esplorare alcune delle sue caratteristiche. 
• Potete decidere se MX Linux è quello che volete senza alterare permanentemente il 

vostro sistema attuale. 

L'esecuzione da un LiveMedium ha anche alcuni svantaggi: 

• Poiché l'intero sistema funziona da una combinazione di RAM e supporto, MX Linux 
richiederà più RAM e potrebbe funzionare più lentamente che se fosse installato sul 
disco rigido. 

• Alcuni hardware insoliti che richiedono driver specializzati o configurazioni 
personalizzate potrebbero non funzionare in una sessione LiveMedium di sola lettura 
(come un DVD) dove i file permanenti non possono essere installati. Il nostro LiveUSB 
con soluzioni di persistenza non ha questo problema. 

 
2.1.1 PAE o non PAE?  
MX Linux è disponibile per due architetture: 32bit e 64bit, entrambe con PAE abilitato. PAE sta 
per Physical Address Extension, un modo per permettere ai sistemi operativi a 32 bit di accedere 
alla ram oltre i 4GB circa. È possibile utilizzare una versione non-PAE su un sistema PAE, ma 
non viceversa. Se la tua macchina non è in grado di gestire il PAE (cioè, è molto vecchia), allora 
ti raccomandiamo di installare invece la nostra distro sorella antiX Linux. 

 
Se non siete sicuri se avete bisogno della versione PAE o non PAE, usate il metodo qui sotto 
adatto al sistema operativo che usate attualmente. 

• Linux. Aprite un terminale ed inserite questo comando (installate prima inxi se 
necessario): inxi -f. Se la voce CPU Flags non include PAE nella lista, allora non sarete 
in grado di installare MX Linux. 

• Mac. Le versioni Intel di OS X supportano PAE. 
• Windows 

• Windows2000 e precedenti: non-PAE 
• Windows XP e Vista. Fai clic destro su Risorse del computer > Proprietà, 

scheda Generale. Se c'è scritto Physical Address Extension (=PAE) in basso, 
allora PAE è la versione corretta da installare. 

https://en.wikipedia.org/wiki/32-bit
https://en.wikipedia.org/wiki/64-bit_computing
http://en.wikipedia.org/wiki/Physical_Address_Extension
https://antixlinux.com/


• Windows 7. Aprite la finestra del Prompt dei comandi cliccando sul pulsante 
Start > Tutti i programmi > Accessori > Prompt dei comandi. Apparirà una 
finestra di terminale. Inserisci questo codice nel prompt dei comandi dove è 
posizionato il cursore: 

wmic os get PAEEnabled 
Se PAE è abilitato, otterrete un ritorno come questo: PAEEnabled. Questo 
ritorno può essere seguito o meno dalla parola TRUE. 

• Windows 8 e successivi. PAE abilitato di default. 
 

2.1.2 32 o 64 bit? 

Qual è l'architettura della vostra cpu? 
Segui il metodo appropriato qui sotto per scoprire se la tua macchina è a 32 o 64 bit. 

• Linux. Aprite un terminale e digitate il comando lscpu, poi esaminate le prime linee per 
l'architettura, il numero di core, ecc. 

• Windows. Consultate questo documento Microsoft. 
• Apple. Consultate questo documento Apple. 

*Se invece volete conoscere l'architettura del sistema operativo, il comando uname -m probabilmente funzionerà 
su tutte le piattaforme. 

 
In generale, se hai una cpu a 64 bit e la RAM richiesta per la tua particolare macchina e 
processore, dovresti usare la versione a 64 bit. Questo perché 64-bit è generalmente più veloce, 
anche se si potrebbe non notare la differenza nell'uso quotidiano. A lungo termine, inoltre, un 
numero crescente di applicazioni più grandi sarà probabilmente limitato alle versioni a 64-bit. 
Si noti che un'applicazione o un sistema operativo a 32 bit può funzionare su una cpu a 64 bit, 
ma non il contrario. 

 
OLTRE: qui 

Quanta memoria (RAM) avete? 
• Linux. Aprite un terminale e inserite il comando free -h e guardate il numero nella 

colonna Total. 
• Windows. Aprite la finestra Sistema usando qualsiasi metodo raccomandato per la 

vostra versione, e cercate la voce "Memoria installata (RAM)". 
• Apple. Clicca sulla voce "Informazioni su questo Mac" nel menu Apple su Mac OS X 

e cerca le informazioni sulla RAM. 
 

2.1.3 Requisiti di sistema 

Per un sistema MX Linux installato su un disco rigido, normalmente sono necessari i seguenti 
componenti. 

 
Minimo 

 
• Un drive CD/DVD (e un BIOS in grado di avviarsi da quel drive), o una USB live (e 

un BIOS in grado di avviarsi da USB) 

https://support.microsoft.com/en-us/kb/827218
https://support.apple.com/en-us/HT201948
https://www.techsupportalert.com/content/32-bit-and-64-bit-explained.htm


• Un moderno processore i686 Intel o AMD 
 

• 1GB di memoria RAM 
 

• 6 GB di spazio libero sul disco rigido 
 

• Da usare come LiveUSB, 4 GB liberi. 
 

Consigliato 
 

• Un drive CD/DVD (e un BIOS in grado di avviarsi da quel drive), o una USB live (e 
un BIOS in grado di avviarsi da USB) 

 
• Un moderno processore i686 Intel o AMD 

 
• 2 GB di memoria RAM o più 

 
• Almeno 20 GB di spazio libero sul disco rigido 

 
• Una scheda video con capacità 3D per il supporto del desktop 3D 

 
• Una scheda audio compatibile con SoundBlaster, AC97 o HDA 

 
• Per l'uso come LiveUSB, 8 GB liberi se si usa la persistenza. 

NOTA: Alcuni utenti di MX Linux 64-bit riportano che 2GB di RAM sono sufficienti per un 
uso generale, anche se almeno 4GB di RAM sono raccomandati se si eseguono processi (come 
la rimasterizzazione) o applicazioni (come un editor audio o video) che richiedono molta 
memoria. 

2.2 Creare un supporto avviabile 

2.2.1 Ottenere l'ISO 
MX Linux è distribuito come ISO, un file immagine del disco nel formato del file system 
ISO 9660. È disponibile in due formati nella pagina di download. 

• Il rilascio originale di una data versione. 
• Questa è una versione statica che, una volta rilasciata, rimane inalterata. 
• Più lungo è il tempo dal rilascio, meno è attuale. 

• Un aggiornamento mensile di una data versione. Questa ISO mensile è creata dalla 
versione originale usando MX Snapshot (vedi sezione 6.6.4). 

• Include tutti gli aggiornamenti dalla versione originale, e quindi rimuove la 
necessità di scaricare un gran numero di file dopo l'installazione. 

• Permette anche agli utenti di eseguire Live con la versione più recente dei programmi. 
• Disponibile solo come download diretto! 

http://en.wikipedia.org/wiki/ISO_9660
http://www.mxlinux.org/download-links


 
 

Fare un antiX/MX live-usb da Windows 

Acquisto 
Purtroppo non è più possibile acquistare un CD o una USB (solo la versione originale) con la 
ISO già caricata e pronta all'uso, poiché la società che li fornisce è fallita. Esistono altre 
opzioni: 

• I portatili precaricati e pre-testati sono disponibili da Starlabs. 

• Desktop virtuale sicuro da utilizzare su qualsiasi dispositivo da Shells. 
 
 
 

Figura 2-1: Distribuzione dei mirror MX Linux (settembre 2021) 

https://youtu.be/GTxphqvKYss
https://starlabs.systems/
https://www.shells.com/l/en-US/pricing?special=mx_linux


Scaricare 
MX Linux può essere scaricato in due modi dalla pagina di download. 

• Diretto. I download diretti sono disponibili dal nostro Direct Repo, o dai nostri Mirrors. 
Salva la ISO sul tuo Hard Disk. Se una fonte sembra lenta, prova l'altra. Disponibile sia 
per la versione originale che per l'aggiornamento mensile. 

• Torrent. La condivisione di file BitTorrent fornisce un protocollo internet per un 
efficiente trasferimento di massa di dati. Decentralizza il trasferimento in modo tale da 
utilizzare connessioni di buona larghezza di banda e minimizzare lo sforzo sulle 
connessioni a bassa larghezza di banda. Un ulteriore vantaggio è che tutti i client 
BitTorrent eseguono il controllo degli errori durante il processo di download, quindi non 
c'è bisogno di fare un controllo md5sum separato dopo che il download è stato 
completato. È già stato fatto! 
L'MX Linux Torrent Team mantiene uno swarm BitTorrent seminato dell'ultima ISO di 
MX Linux (solo la versione originale), registrato su archive.org entro 24 ore al più tardi 
dal suo rilascio ufficiale. I link ai torrent saranno nella pagina di download. 

• Vai alla pagina di download e clicca sul link Torrent corretto per la tua architettura. Il 
tuo browser dovrebbe riconoscere che si tratta di un torrent e chiederti come vuoi 
gestirlo. 
In caso contrario, clicca con il tasto sinistro del mouse sul torrent per vedere la pagina, 
clicca con il tasto destro per salvarlo. Cliccando sul torrent scaricato si avvierà il tuo 
client torrent (Transmission di default), mostrando il torrent nella sua lista; evidenzialo 
e clicca su Start per iniziare il processo di download. Se hai già scaricato la ISO, 
assicurati che sia nella stessa cartella del torrent che hai appena scaricato. 

 

2.2.2 Controllare la validità delle ISO scaricate 
Dopo aver scaricato una ISO, il passo successivo è quello di verificarla. Ci sono diversi metodi 
disponibili. 

md5sum 
Ogni ISO è accompagnata da un file md5sum corrispondente nel sorgente, e dovresti controllare 
il suo md5sum con quello ufficiale. Sarà identico al md5sum ufficiale se la vostra copia è 
autentica. I seguenti passi vi permetteranno di verificare l'integrità della ISO scaricata su 
qualsiasi piattaforma OS. 

• Windows 
Gli utenti possono controllare più facilmente con il creatore di USB avviabili Rufus; uno 
strumento chiamato WinMD5FREE è anche disponibile per il download e l'uso gratuito. 

• Linux 
In MX Linux, andate alla cartella dove avete scaricato la ISO e il file md5sum. Clicca 
con il tasto destro sul file md5sum > Controlla l'integrità dei dati. Una finestra di dialogo 
apparirà dicendo "<nome della ISO>: OK" se i numeri sono identici. Puoi anche cliccare 
con il tasto destro sulla ISO > Compute md5sum e confrontarla con un'altra fonte. 
Per situazioni in cui questa opzione non è disponibile, aprite un terminale nella 
posizione in cui avete scaricato la ISO (i file manager di Linux di solito hanno 

https://mxlinux.org/download-links
http://en.wikipedia.org/wiki/BitTorrent
https://mxlinux.org/download-links
https://rufus.akeo.ie/
http://www.winmd5.com/


un'opzione Open Terminal Here), quindi digitate 



md5sum nomefile.iso 
Assicuratevi di sostituire "filename" con il nome effettivo del file (digitate le prime due 
lettere e poi premete Tab e sarà compilato automaticamente). Confronta il numero 
ottenuto da questo calcolo con il file md5sum scaricato dal sito ufficiale. Se sono identici, 
la vostra copia è identica alla versione ufficiale. 

• Mac 
Gli utenti Mac devono aprire una console/terminale e andare nella directory con i file 
ISO e md5sum. Poi eseguite questo comando: 

md5 -c nomefile.md5sum 
Assicuratevi di sostituire filename con il nome effettivo del file. 

 
sha256sum 
Una maggiore sicurezza è fornita da sha256 e sha512 a partire da MX-19. Scarica il file per 
verificare l'integrità della ISO. 

• Windows: il metodo varia a seconda della versione. Fate una ricerca sul web su 
"windows <versione> check sha256 sum". 

• Linux: seguire le indicazioni per md5sum, sopra, sostituendo 
"sha256sum" o "sha512sum" per "md5sum". 

• Mac: aprite una console, passate alla directory con i file ISO e sha256 ed eseguite questo 
comando: 

shasum -a 256 /path/to/file 
 

 
Firma GPG 
Dal 16 marzo 2016, i file ISO di MX Linux da scaricare sono stati firmati dai loro sviluppatori. 
Questo metodo di sicurezza permette all'utente di essere sicuro che la ISO è quello che dice di 
essere: una ISO ufficiale dello sviluppatore. Istruzioni dettagliate su come eseguire questo 
controllo di sicurezza possono essere trovate nel Wiki tecnico di MX/antiX. 

 

2.2.3 Creare il LiveMedium 

DVD 
Masterizzare una ISO su un DVD è facile, a patto di seguire alcune importanti linee guida. 

• Non masterizzare la ISO su un CD/DVD vuoto come se fosse un file di dati! Una ISO è 
un'immagine formattata e avviabile di un sistema operativo. Devi scegliere Masterizza 
immagine disco o Masterizza ISO nel menu del tuo programma di masterizzazione 
CD/DVD. Se semplicemente la trascini in una lista di file e la masterizzi come un 
normale file, non otterrai un LiveMedium avviabile. 

• Usa un DVD-R o DVD+R scrivibile di buona qualità con una capacità di 4,7 GB. 
 

USB 
È possibile creare facilmente una USB avviabile che funziona sulla maggior parte dei sistemi. MX Linux 
include lo strumento 
Live-usb maker (vedi sezione 3.2) per questo lavoro. 

https://en.wikipedia.org/wiki/SHA-2
https://mxlinux.org/wiki/system/signed-iso-files
https://mxlinux.org/wiki/system/signed-iso-files


• Se vuoi creare una USB su una base Windows, ti suggeriamo di usare Rufus, che 
supporta il nostro bootloader, o una versione recente (post 625) di Unetbootin. 

• Se su base Linux, offriamo il nostro Live-usb-maker-qt come appimage a 64 bit. 
• Se la vostra USB si avvia ma vi lascia con un messaggio di errore: gfxboot.c32: not a 

COM32R image, dovreste essere ancora in grado di fare il boot digitando "live" al 
prompt nella riga successiva. Riformattare l'USB e reinstallare la ISO dovrebbe 
rimuovere l'errore. 

• Se i creatori grafici USB falliscono, è possibile utilizzare il comando "dd", un'opzione 
ora in Live-usb maker. 

• ATTENZIONE: fate attenzione a identificare correttamente l'USB di 
destinazione nella stringa della linea di comando dd elencata sopra, poiché il 
comando dd scriverà completamente sulla destinazione. 

• Per accertare il nome/lettera di dispositivo corretto per la vostra 
destinazione USB, aprite un terminale, digitate lsblk e premete Invio. 
Verrà elencato un elenco di tutti i dispositivi collegati al vostro sistema. Dovresti 
essere in grado di identificare l'USB di destinazione dalla sua dimensione di 
memoria elencata. 

• Per i dettagli, vedere la Wiki di MX/antiX. 
 

 
Figura 2-3: tipico output del comando lsblk, che mostra due hard disk con due partizioni ciascuno 

 
2.3 Pre-installazione 

2.3.1 Proveniente da Windows 
Se avete intenzione di installare MX Linux in sostituzione di Microsoft Windows®, è una buona 
idea consolidare e fare il backup dei vostri file e altri dati attualmente memorizzati in Windows. 
Anche se state pianificando il dual-boot, dovreste fare un backup di questi dati in caso di 
problemi imprevisti durante l'installazione. 

Backup dei file 
Individua tutti i tuoi file, come documenti d'ufficio, immagini, video o musica: 

• In genere, la maggior parte di questi si trova nella cartella Documenti. 
• Cercate dal menu delle applicazioni di Windows vari tipi di file per assicurarvi di 

averli trovati e salvati tutti. 
• Alcuni utenti fanno il backup dei loro font per riutilizzarli in MX Linux con 

applicazioni (come LibreOffice) che possono eseguire documenti Windows. 
• Una volta che avete individuato tutti questi file, masterizzateli su un CD o DVD, o 

copiateli su un dispositivo esterno come una chiavetta USB. 

https://mxlinux.org/wiki/system/dd-command
https://mxlinux.org/wiki/system/dd-command
https://mxlinux.org/wiki/system/dd-command


Backup di e-mail, calendario e dati di contatto 
A seconda del programma di posta elettronica o calendario che usi, i tuoi dati di posta 
elettronica e calendario potrebbero non essere salvati in una posizione ovvia o sotto un nome 
di file ovvio. La maggior parte delle applicazioni di posta elettronica o di pianificazione (come 
Microsoft Outlook®) sono in grado di esportare questi dati in uno o più formati di file. 
Consulta la documentazione di aiuto della tua applicazione per scoprire come esportare i dati. 

• Dati e-mail: Il formato più sicuro per le email è il testo semplice, dato che la maggior 
parte dei programmi di posta supporta questa funzione; assicurati di zippare il file per 
assicurarti che tutti gli attributi del file siano mantenuti. Se stai usando Outlook Express, 
la tua posta è memorizzata in un file .dbx o .mbx, entrambi i quali possono essere 
importati in Thunderbird (se installato) su MX Linux. Usa la funzione di ricerca di 
Windows per localizzare questo file e copiarlo nel tuo backup. La posta di Outlook 
dovrebbe essere importata prima in Outlook Express prima di essere esportata per 
essere usata in MX Linux. 

• Dati del calendario: esportate i dati del vostro calendario in formato iCalendar o 
vCalendar se volete usarli in MX Linux. 

• Dati di contatto: i formati più universali sono CSV (valori separati da virgola) o vCard. 
 

Conti e password 
Anche se di solito non sono memorizzati in file leggibili che possono essere sottoposti a backup, 
è importante ricordarsi di prendere nota di varie informazioni di account che si possono avere 
salvate nel computer. I vostri dati di accesso automatico per siti web o servizi come il vostro ISP 
dovranno essere inseriti di nuovo, quindi assicuratevi di memorizzare su disco le informazioni 
necessarie per accedere di nuovo a questi servizi. Alcuni esempi sono: 

• Informazioni di accesso ISP: Avrai bisogno almeno del tuo nome utente e della password 
per il tuo provider di servizi internet, e il numero di telefono per connetterti se sei in dial-
up o ISDN. Altri dettagli potrebbero includere un numero di uscita, il tipo di 
composizione (a impulsi o a toni), e il tipo di autenticazione (per la dialup); indirizzo IP e 
subnet mask, server DNS, indirizzo IP gateway, server DHCP, VPI/VCI, MTU, tipo di 
incapsulamento, o impostazioni DHCP (per varie forme di banda larga). Se non sei 
sicuro di cosa hai bisogno, consulta il tuo ISP. 

• Rete wireless: Avrai bisogno della tua password o passphrase e del nome della rete. 
• Passwords web: Avrai bisogno delle tue password per vari forum web, negozi online o 

altri siti protetti. 
• Dettagli dell'account di posta elettronica: Avrai bisogno del tuo nome utente e 

password, e gli indirizzi o gli URL dei server di posta. Potresti anche aver bisogno del 
tipo di autenticazione. Queste informazioni dovrebbero essere recuperabili dalla 
finestra di dialogo delle impostazioni dell'account del tuo client di posta elettronica. 

• Messaggistica istantanea: Il tuo nome utente e la password per il tuo account IM, la tua 
lista di amici e le informazioni di connessione al server, se necessario. 

• Altro: Se hai una connessione VPN (ad esempio verso il tuo ufficio), un server proxy 
o un altro servizio di rete configurato, assicurati di scoprire quali informazioni sono 
necessarie per riconfigurarlo nel caso in cui tu ne abbia bisogno. 

 



Preferiti del browser 
I preferiti del browser web (segnalibri) sono spesso trascurati durante un backup, e di solito non 
sono memorizzati in un luogo evidente. La maggior parte dei browser contiene un'utilità per 
esportare i tuoi segnalibri 



in un file, che può poi essere importato nel browser web di vostra scelta in MX Linux. 
Controllate la divisione dei segnalibri nel browser che usate per avere indicazioni specifiche 
aggiornate. 

 
Licenze software 
Molti programmi proprietari per Windows non sono installabili senza una chiave di licenza o 
una chiave CD. A meno che non siate decisi a fare a meno di Windows in modo permanente, 
assicuratevi di avere una chiave di licenza per ogni programma che la richiede. Se decidi di 
reinstallare Windows (o se il setup del dual-boot va storto), non potrai reinstallare questi 
programmi senza la chiave. 
Se non riesci a trovare la licenza cartacea fornita con il tuo prodotto, potresti essere in grado di 
localizzarla nel registro di Windows, o usare un keyfinder come ProduKey. Se tutto il resto 
fallisce, prova a contattare il produttore del computer per un aiuto. 

Esecuzione di programmi Windows 
I programmi di Windows non gireranno all'interno di un sistema operativo Linux, e gli utenti 
MX Linux sono incoraggiati a cercare equivalenti nativi (vedi Sezione 4). Le applicazioni che 
sono critiche per un utente possono essere eseguite sotto Wine (vedi Sezione 6.1), anche se 
varia un po'. 

 

2.3.2 Computer Apple Intel 
L'installazione di MX Linux su computer Apple con chip Intel può essere problematica, anche se 
la situazione varia in una certa misura con l'esatto hardware coinvolto. Agli utenti interessati alla 
questione si consiglia di cercare e consultare i materiali e i forum Debian per i recenti sviluppi. 
Un certo numero di utenti Apple lo hanno installato con successo, quindi si dovrebbe avere buona 
fortuna se si cerca o si postano domande sul forum di MX Linux. 

Link 
Installare Debian su computer Apple: 
Forum Debian 

 

2.3.3 FAQ sul disco rigido 

Dove dovrei installare MX Linux? 
Prima di iniziare l'installazione, è necessario decidere dove si intende installare MX Linux. 

• Intero disco rigido 
• Partizione esistente su un disco rigido 
• Nuova partizione su un disco rigido 

Potete semplicemente selezionare una delle prime due durante l'installazione, ma la terza 
richiede la creazione di una nuova partizione. Potete farlo durante l'installazione, ma si 
raccomanda di farlo prima di iniziare l'installazione. Su MX Linux, di solito si usa Gparted 
(Xfce) o PartitionManager (KDE) per creare e gestire graficamente le partizioni. 
Un formato di installazione tradizionale per Linux ha diverse partizioni, una per root, home e 
swap, come nella figura qui sotto, e si dovrebbe iniziare con questa se si è nuovi a Linux. 
Potreste anche aver bisogno di una partizione ESP formattata fat-32 per le macchine con 

http://www.nirsoft.net/utils/product_cd_key_viewer.html
https://wiki.debian.org/InstallingDebianOn/Apple
https://wiki.debian.org/InstallingDebianOn/Apple
http://forums.debian.net/


capacità UEFI. Sono possibili altre disposizioni delle partizioni, per esempio alcuni utenti 
esperti combinano root e home, con una partizione separata per i dati. 



 
 

Figura 2-2: Gparted mostra tre partizioni (sda1), (sda2) e swap (sda3). Le dimensioni delle 
unità sono a discrezione dell'utente (vedi Sezione 1.3 per i requisiti minimi) 

 

OLTRE: Manuale GParted 

 Creare una nuova partizione con 

GParted  Partizionare un sistema 

multi-boot 

Come posso modificare le partizioni? 
Lo strumento molto comodo usato in passato per tali azioni, Disk manager, non è più 
disponibile. Al suo posto è consigliato Gnome Disks (parte di gnome-disk-utility). Questa 
utility fornisce una presentazione grafica di tutte le partizioni della macchina (escluso lo swap) 
con una semplice interfaccia per montare, smontare e modificare rapidamente e facilmente 
alcune proprietà delle partizioni del disco. Le modifiche vengono scritte automaticamente e 
immediatamente in /etc/fstab e sono quindi conservate per il prossimo avvio. 

 
AIUTO: Dischi di Gnome 

Cosa sono quelle altre partizioni sulla mia installazione di Windows? 
I recenti computer domestici con Windows sono venduti con una partizione di diagnostica e 
una di ripristino, oltre a quella che contiene l'installazione del sistema operativo. Se vedete 
comparire in GParted più partizioni di cui non eravate a conoscenza, probabilmente sono quelle 
e dovrebbero essere lasciate stare. 

Devo creare una Home separata? 
Non è necessario creare una partizione home separata, poiché l'installatore creerà una directory 
/home all'interno di / (root). Ma avere una partizione separata rende gli aggiornamenti più facili 
e protegge dai problemi causati dagli utenti che riempiono il disco con molte immagini, musica 
o dati video. 

http://gparted.org/display-doc.php?name=help-manual
https://www.youtube.com/watch?v=lf8eXhCKghg
https://www.youtube.com/watch?v=lf8eXhCKghg
https://www.youtube.com/watch?v=khg6_sdrOBQ
https://www.youtube.com/watch?v=khg6_sdrOBQ
https://linuxhint.com/gnome_disk_utility/


Quanto dovrebbe essere grande / (radice)? 
• (In Linux, la barra "/" indica la partizione root.) La dimensione della base installata è un 

po' meno di 5 GB, quindi si raccomanda un minimo di 6 GB per consentire le funzioni di 
base. 

• Questa dimensione minima non vi permetterà di installare molti programmi, e può 
causare difficoltà nel fare gli aggiornamenti, eseguire VirtualBox, ecc. La dimensione 
raccomandata per un uso normale è quindi di 20 GB. 

• Se avete la vostra Home (/home) situata all'interno della directory Root (/) e memorizzate 
molti file grandi, allora avrete bisogno di una partizione root più grande. 

• I giocatori che giocano a grandi giochi (ad esempio, Wesnoth) dovrebbero notare che 
avranno bisogno di una partizione root più grande del solito per dati, immagini, file 
audio; un'alternativa è quella di utilizzare un'unità dati separata. 

 
È necessario creare una partizione SWAP? 
SWAP è lo spazio su disco utilizzato per la memoria virtuale. Questo è simile al file "Page" che 
windows usa per la memoria virtuale. L'installatore creerà una partizione SWAP per te (vedi 
Sezione 2.5.1). Se intendete ibernare (e non solo sospendere) il sistema, ecco le raccomandazioni 
per la dimensione dello spazio di swap: 

• Per meno di 1GB di memoria fisica (RAM), lo spazio di swap dovrebbe essere almeno 
uguale alla quantità di RAM e al massimo il doppio della quantità di RAM a seconda 
della quantità di spazio su disco disponibile per il sistema. 

• Per sistemi con grandi quantità di RAM fisica, lo spazio di swap dovrebbe essere 
almeno uguale alla dimensione della memoria. 

• Tecnicamente un sistema linux può funzionare senza swap, anche se alcuni 
problemi di prestazioni possono verificarsi anche su sistemi con grandi quantità 
di RAM fisica. 

Cosa significano nomi come "sda"? 
Prima di iniziare l'installazione, è fondamentale capire come i sistemi operativi Linux trattano i 
dischi rigidi e le loro partizioni. 

• Nomi delle unità. A differenza di Windows, che assegna una lettera di unità a ciascuna 
delle partizioni del disco rigido, Linux assegna un breve nome di dispositivo a ciascun 
disco rigido o altro dispositivo di archiviazione su un sistema. I nomi dei dispositivi 
iniziano sempre con sd più una singola lettera. Per esempio, il primo disco del sistema 
sarà sda, il secondo sdb, ecc. Ci sono anche mezzi più avanzati per nominare le unità, il 
più comune dei quali è l'UUID (Universally Unique IDentifier), usato per assegnare un 
nome permanente che non sarà cambiato dall'aggiunta o rimozione di apparecchiature. 

• Nomi delle partizioni. All'interno di ogni unità ogni partizione è indicata con un 
numero aggiunto al nome del dispositivo. Così, per esempio, sda1 sarebbe la prima 
partizione sul primo disco rigido, mentre sdb3 sarebbe la terza partizione sul secondo 
disco. 

• Partizioni estese. I dischi rigidi dei PC in origine potevano avere solo quattro partizioni. 
Queste sono chiamate partizioni primarie in Linux e sono numerate da 1 a 4. Puoi 
aumentare il numero trasformando una delle partizioni primarie in una partizione estesa, 
poi dividendola in partizioni logiche (limite 15) che sono numerate da 5 in poi. Linux 
può essere installato in una partizione primaria o logica. 

https://en.wikipedia.org/wiki/Universally_unique_identifier


Accesso Live Medium 
 

Nel caso vogliate uscire e rientrare, installare nuovi pacchetti, ecc., ecco i 
nomi utente e le password: 

 
• Utente regolare 

 
• nome: demo 

 
• password: demo 

 
• Superutente (Amministratore) 

 
• nome: radice 

 
• password: root 

2.4 Primo sguardo 
 
 
 

2.4.1 Avviare il LiveMedium 

LiveCD/DVD 
Basta mettere il DVD nel vassoio e riavviare. 

LiveUSB 
Potrebbe essere necessario fare qualche passo per far sì che il computer si avvii correttamente usando l'USB. 

• Per avviare con l'unità USB, molti computer hanno tasti speciali che si possono 
premere durante l'avvio per selezionare quel dispositivo. I tipici tasti del menu del 
dispositivo di avvio sono Esc, uno dei tasti funzione, Return o il tasto Shift. Guarda 
attentamente la prima schermata che appare al riavvio per trovare il tasto corretto. 

• In alternativa, potreste dover entrare nel BIOS per cambiare l'ordine dei dispositivi di avvio: 
• Avviare il computer e premere il tasto richiesto (ad esempio, F2, F10 o Esc) 

all'inizio per entrare nel BIOS 
• Clicca su (o freccia su) la scheda Boot 
• Identificate ed evidenziate il vostro dispositivo USB (di solito, USB HDD), poi 

spostatelo in cima alla lista (o entrate, se il vostro sistema è impostato per 
questo). Salvare e uscire 

• Se non siete sicuri o non vi sentite a vostro agio nel cambiare il BIOS, 
chiedete assistenza nei forum. 

• Sui vecchi computer senza supporto USB nel BIOS, puoi usare il Plop Linux 
LiveCD che caricherà i driver USB e ti presenterà un menu. Vedi il sito web per i 
dettagli. 

• Una volta che il sistema è impostato per riconoscere il drive USB durante il processo di 
avvio, basta inserire il drive e riavviare la macchina. 

http://www.plop.at/
http://www.plop.at/
http://www.plop.at/


UEFI 
 

 

 
 
 
Problemi di avvio UEFI e alcune impostazioni da controllare! 

 
Se la macchina ha già installato Windows 8 o successivo, allora devono essere prese misure 
speciali per gestire la presenza di (U)EFI e Secure Boot. La maggior parte degli utenti è invitata 
a disattivare Secure Boot entrando nel BIOS quando la macchina inizia ad avviarsi. 
Sfortunatamente, l'esatta procedura successiva varia a seconda del produttore: 

Nonostante il fatto che la specifica UEFI richieda che le tabelle delle partizioni 
MBR siano pienamente supportate, alcune implementazioni del firmware UEFI 
passano immediatamente all'avvio CSM basato sul BIOS a seconda del tipo di 
tabella delle partizioni del disco di avvio, impedendo effettivamente l'avvio 
UEFI da partizioni di sistema EFI su dischi con partizioni MBR. (Wikipedia, 
"Unified Extensible Firmware Interface", recuperato il 10/12/19) 

L'avvio e l'installazione UEFI sono supportati su macchine a 32 bit e 64 bit, così come su 
macchine a 64 bit con UEFI a 32 bit. Anche se le implementazioni UEFI a 32 bit possono 
ancora essere problematiche. Per la risoluzione dei problemi, si prega di consultare il Wiki 
MX/antiX, o chiedere sul Forum. 

Lo schermo nero 
Occasionalmente può accadere che ci si ritrovi a guardare uno schermo nero vuoto che può 
avere un cursore lampeggiante in un angolo. Questo rappresenta un fallimento nell'avviare X, 
il sistema a finestre usato da Linux, ed è più spesso dovuto a problemi con il driver grafico 
utilizzato. Soluzione: riavviare e selezionare le opzioni di avvio Safe Video o Failsafe nel 
menu; dettagli su questi codici di avvio nella Wiki. Vedi Sezione 3.3.2. 

2.4.2 La schermata di apertura standard 
 

 
 

Figura 2-3: schermata di avvio LiveMedium della ISO x64 

https://www.youtube.com/watch?v=cLFUZ6LtqiE
https://en.wikipedia.org/wiki/Unified_Extensible_Firmware_Interface
https://mxlinux.org/wiki/system/uefi
https://mxlinux.org/wiki/system/uefi
https://mxlinux.org/wiki/system/boot-parameters
https://mxlinux.org/wiki/system/boot-parameters


Quando il LiveMedium si avvia, vi verrà presentata una schermata simile alla figura qui sopra; la 
schermata installata ha un aspetto molto diverso. Le voci personalizzate possono anche apparire 
nel menu principale. 

Voci del menu principale 
Tabella 1: voci di menu nell'avvio live 

Ingresso Commento 
MX-XX.XX 

(<DATA DI 
RILASCIO>) 

Questa voce è selezionata di default, ed è il modo standard con cui la 
maggior parte degli utenti avvia il sistema Live. Premi 

semplicemente Return per avviare il sistema. 
Avvio da disco fisso Avvia qualsiasi cosa sia attualmente installata sul disco rigido del 

sistema 
Test di memoria Esegue un test per controllare la RAM. Se questo test passa, allora 

potrebbe esserci ancora un problema hardware o anche un problema 
con la RAM, ma se il test fallisce, allora sai che qualcosa non va. 

 
Nella riga inferiore lo schermo mostra una serie di voci verticali, sotto le quali c'è una riga 
di opzioni orizzontali; premete F1 quando guardate quella schermata per i dettagli. 

Opzioni 
• F2 Lingua. Imposta la lingua per il bootloader e il sistema MX. Questa verrà 

trasferita automaticamente sul disco rigido quando si installa. 
• F3 Fuso orario. Imposta il fuso orario per il sistema. Questo verrà trasferito 

automaticamente sul disco rigido quando si installa. 
• F4 Opzioni. Opzioni per controllare e avviare il sistema Live. La maggior parte di 

queste opzioni non vengono trasferite sul disco rigido quando si installa. 
• F5 Persist. Opzioni per mantenere le modifiche alla LiveUSB quando la macchina si spegne. 
• F6 Opzioni video Safe/Failsafe. Opzioni per le macchine che non si avviano di default su X. 
• F7 Console. Imposta la risoluzione delle console virtuali. Può entrare in conflitto con 

l'impostazione della modalità Kernel. Può essere utile se si sta avviando in Command 
Line Install o se si sta cercando di eseguire il debug del processo di avvio iniziale. 
Questa opzione sarà trasferita quando si installa. 

Altri codici cheat per LiveUSB possono essere trovati nella Wiki di MX/antiX. I codici cheat per 
l'avvio di un sistema installato sono diversi, e possono essere trovati nella stessa posizione. 
OLTRE: Processo di avvio di Linux 

https://mxlinux.org/wiki/system/boot-parameters
http://en.wikipedia.org/wiki/Linux_startup_process


2.4.3 La schermata di apertura UEFI 
 

Figura 2-4: Schermata di avvio LiveMedium di x64 (MX-21 e superiori) quando viene rilevato UEFI 
Se l'utente sta usando un computer impostato per l'avvio UEFI (vedi MX/antiX Wiki), la 
schermata di apertura per l'avvio UEFI Live apparirà invece con scelte diverse. 

• I menu sono utilizzati per impostare le opzioni di avvio al posto dei menu del tasto F 
• L'opzione in alto avvierà il sistema operativo con tutte le opzioni selezionate abilitate. 
• Le opzioni avanzate impostano cose come la persistenza e altre voci presenti nei menu 

di avvio legacy F. 
• Lingua - Tastiera - Fuso orario imposta queste opzioni 

 

 
Figura 2-5: Esempi di schermate per LiveMedium (a sinistra) e opzioni installate. 

Se volete che le opzioni di avvio siano persistenti, assicuratevi di selezionare un'opzione di salvataggio. 

https://www.mxlinux.org/wiki/system/uefi


2.4.4 Schermata di accesso 
 

Figura 2-6: A sinistra: schermata di login di Xfce, con il pulsante di sessione in alto al centro 
A destra: Schermata di login di KDE/plasma 
A meno che tu non abbia selezionato l'autologin, il processo di avvio installato termina con la 
schermata di login; in una sessione Live viene mostrata solo l'immagine di sfondo, ma se ti 
disconnetti dal desktop vedrai la schermata completa. (Il layout dello schermo varia da una 
versione all'altra di MX.) Su schermi piccoli, l'immagine può apparire ingrandita; questa è una 
proprietà del display manager che viene utilizzato da MX Linux. 
Potete vedere tre piccole icone all'estremità destra della barra superiore; da destra a sinistra: 

• Il pulsante di accensione sul bordo contiene opzioni per sospendere, riavviare e spegnere. 
• Il pulsante della lingua permette all'utente di selezionare la tastiera appropriata per 

la schermata di accesso 
• Il pulsante degli aiuti visivi che soddisfa le esigenze speciali di alcuni utenti. 

 
Al centro c'è il pulsante della sessione che ti permette di scegliere quale desktop manager vuoi 
usare: Default Xsession, Xfce Session, insieme a qualsiasi altro si possa avere installato 
(Sezione 6.3). Fluxbox non è più incluso di default, anche se può essere installato con MX 
Package Installer. 
Se volete evitare di dovervi loggare ad ogni avvio (non raccomandato quando ci sono problemi 
di sicurezza), potete cambiare in autologin" nella scheda "opzioni" di MX User Manager. 

 
Le versioni di MX KDE/plasma sono dotate di una schermata di accesso diversa, contenente un 
selezionatore di sessioni, una tastiera su schermo e funzioni di accensione/spegnimento/riavvio. 



2.4.5 Diversi desktop 

MX-Xfce 
 

Figura 2-7: Il desktop Xfce predefinito 
 

MX-KDE 
 

Figura 2-8: il desktop predefinito di KDE/plasma 
 

Il desktop è creato e gestito da Xfce o KDE/plasma, e ogni aspetto e disposizione sono stati 
pesantemente modificati per MX Linux. Nota le due caratteristiche dominanti del primo 
sguardo: pannello e schermata di benvenuto. 

Pannello 
Il desktop predefinito di MX Linux ha un singolo pannello verticale sullo schermo. 
L'orientamento del pannello è facilmente modificabile in MX Tools > MX Tweak. Le 
caratteristiche comuni del pannello sono: 

 
• Pulsante di accensione, apre una finestra di dialogo per il logout, il riavvio, lo spegnimento e la 

sospensione. (xfce) 
• Orologio in formato LCD-click per un calendario (xfce) 
• Taskswitcher/Window Buttons: area dove vengono mostrate le applicazioni aperte 
• Browser Firefox 
• Gestore di file (Thunar) 
• Area di notifica 

• Aggiornare il manager 

http://docs.xfce.org/xfce/getting-started


• Gestore degli appunti 



• Direttore di rete 
• Responsabile del volume 
• Manager di potenza 
• Espulsore USB 

• Pager: visualizza gli spazi di lavoro disponibili (di default 2, clicca con il tasto destro per cambiare) 
• Menu delle applicazioni ("Whisker" su Xfce) 
• Altre applicazioni possono inserire icone nel Pannello o nell'Area di notifica 

quando sono in esecuzione. Per cambiare le proprietà del Pannello, vedi la sezione 3.8. 
 

Schermo di benvenuto 
 
 
 
 
 
 

[[AGGIUNGERE LA SECONDA SCHEDA]] 
 
 
 
 
 
 
 

Figura 2-9: Le schermate di Benvenuto e Informazioni su MX linux (installato) 
Quando l'utente si avvia per la prima volta, una schermata di benvenuto appare al centro dello 
schermo con due schede: "Welcome" offre un rapido orientamento e link di aiuto (Figura 2-7). 
mentre "About" mostra un riassunto di informazioni sul sistema operativo, il sistema in 
esecuzione, ecc. Quando si esegue Live, le password per gli utenti demo e root saranno mostrate 
in basso. Una volta chiuso, in esecuzione live o installato, può essere visualizzato di nuovo 
usando il menu o MX Tools. 

 
È molto importante che i nuovi utenti lavorino attentamente sui pulsanti, in quanto ciò 
risparmierà molta confusione e fatica nell'uso futuro di MX-Linux. Se il tempo a disposizione è 
limitato, si raccomanda di scorrere il documento delle FAQ collegato al Desktop, dove si 
risponde alle domande più comuni. 

http://gottcode.org/xfce4-whiskermenu-plugin


Suggerimenti e trucchi 
 

Figura 2-10: Impostazioni è la tua postazione unica per apportare modifiche. I contenuti variano. 
 

Alcune cose utili da sapere all'inizio: 

• Se hai problemi con il suono, la rete, ecc., vedi Configurazione (Sezione 3). 
• Regola il volume generale del suono scorrendo con il cursore sull'icona 

dell'altoparlante, o cliccando con il tasto destro sull'icona dell'altoparlante > Open 
Mixer. 

• Imposta il sistema sul tuo particolare layout di tastiera cliccando su Application 
Menu > Settings > Keyboard, Layout tab, e selezionando il modello con il menu a 
tendina. Qui è anche dove puoi aggiungere tastiere di altre lingue. 

• Regola le preferenze per il mouse o il touchpad cliccando su Application Menu > 
Settings > Mouse and Touchpad. 

• Il cestino può essere facilmente gestito nel File Manager, dove vedrete la sua icona nel 
pannello di sinistra. Cliccate con il tasto destro del mouse per svuotarlo. Può anche 
essere aggiunto al Desktop o al Pannello. È importante rendersi conto che l'uso della 
cancellazione, sia evidenziando e premendo il pulsante di cancellazione o tramite una 
voce del menu contestuale, rimuove l'elemento per sempre e non sarà recuperabile. 

• Mantenete il vostro sistema aggiornato osservando che l'indicatore (casella 
delineata) degli aggiornamenti disponibili su MX Updater diventi verde. Vedere 
la sezione 3.2 per i dettagli. 

• Combinazioni di tasti utili (gestite in Tutte le impostazioni > Tastiera > Scorciatoie delle applicazioni). 

Tabella 2: Combinazioni di tasti utili 
Colpi di 
chiave 

Azione 

F4 Fa cadere un terminale dall'alto dello schermo 
Chiave di 
Windows 

Fa apparire il menu Applicazione 

Ctrl-Alt-Esc Cambia il cursore in una x bianca per uccidere qualsiasi programma 
Ctrl-Alt-Bksp Chiude la sessione (senza salvare!) e ritorna alla schermata di login 



Ctrl-Alt-Del Blocca il desktop su Xfce. logout su KDE/plasma 
Ctrl-Alt-F1 Ti fa uscire dalla tua sessione X per una linea di comando; usa Ctrl-Alt-F7 per 

tornare indietro. 
Alt-F1 Apre questo manuale utente di MX Linux (solo Xfce, menu su KDE/plasma) 
Alt-F2 Fa apparire una finestra di dialogo per eseguire un'applicazione 
Alt-F3 Apre il Finder delle applicazioni che permette anche alcune modifiche delle 

voci di menu (solo Xfce) 
Alt-F4 Chiude un'applicazione a fuoco; sul desktop, fa apparire il dialogo di uscita. 
PrtScr Apre lo Screenshooter per le catture dello schermo 

 

Applicazioni 
Le applicazioni possono essere avviate in vari modi. 

 

Figura 2-11: SINISTRA: menu Xfce Whisker (i contenuti variano) DESTRA: menu KDE/plasma 
• Clicca sull'icona del menu Applicazione, in basso a sinistra. 

• Si apre alla categoria Preferiti, e si può passare il mouse su altre categorie sul 
lato destro per vedere i contenuti nel pannello di sinistra. 

• In alto c'è una potente casella di ricerca incrementale: basta digitare alcune 
lettere per trovare qualsiasi applicazione senza bisogno di conoscere la sua 
categoria. 

• Fai clic con il tasto destro del mouse sul desktop > Applicazioni. 
• Se conoscete il nome dell'applicazione, potete usare Application Finder, avviato 

facilmente in uno dei due modi. 
• Fare clic con il tasto destro del mouse sul desktop > Esegui comando ... 
• Alt-F2 
• Alt-F3 (Xfce) fa apparire una versione avanzata che permette di controllare 

i comandi, le posizioni, ecc. 

• Sul desktop KDE/plasma, basta iniziare a digitare 

• Usate una sequenza di tasti che avete definito per aprire un'applicazione preferita. 

• Xfce- Fai clic su Application Menu > Settings, poi Keyboard, scheda 
Application shortcuts. 

• KDE/plasma - Scorciatoie globali nel menu 
 



 
 



Figura 2-12: Application Finder che identifica l'applicazione 
 

Altro 

Informazioni sul sistema 
• Cliccate su Application Menu > Quick System Info che metterà i risultati del comando 

inxi -Fxrz negli appunti, pronto per essere incollato nei messaggi del forum, nei file di testo, ecc. 
• KDE/plasma - Clicca su Application Menu > System > Infocenter per una bella 

visualizzazione grafica 

Video e audio 
• Per le impostazioni di base del monitor, fare clic su Application Menu> Settings > Display 
• La regolazione del suono si fa tramite Menu Applicazioni > Multimedia > 

PulseAudio Volume Control (o cliccando con il tasto destro del mouse sull'icona 
Volume manager) 

NOTA: per la risoluzione dei problemi di aree come il display, il suono o internet, consultare la 
Sezione 3: Configurazione. 
Link 

• Documentazione su Xfce 
• Xfce FAQ 
• KDE 

 
 

2.4.7 Uscita da 
Quando apri il menu Application, vedrai di default quattro pulsanti di comando nell'angolo in 
alto a destra (cambia ciò che viene mostrato con un clic destro sull'icona del menu > 
Proprietà, scheda Comandi). Da sinistra a destra: 

• Tutte le impostazioni (All Settings) 
• Schermo di blocco 
• Interruttore Utenti 
• Esci 

 
 

 

Figura 2-13: pulsanti di 

comando In alto: Xfce 

A destra: KDE/plasma 
È importante uscire correttamente da 
MX Linux quando avete finito la 
vostra sessione in modo che il sistema 
possa essere portato giù in modo 
sicuro. Tutti i programmi in 
esecuzione vengono prima notificati 

http://www.xfce.org/about
https://wiki.xfce.org/faq
https://userbase.kde.org/Welcome_to_KDE_UserBase


che 



il sistema si sta spegnendo, dando loro il tempo di salvare qualsiasi file che si sta modificando, 
uscire dai programmi di posta e notizie, ecc. Se si spegne e basta, si rischia di danneggiare il 
sistema operativo. 

 
Opzioni simili ai pulsanti di comando sono disponibili nel menu LEAVE di KDE/plasma. 

Permanente 
Per lasciare definitivamente una sessione, selezionate una delle seguenti opzioni nella finestra di dialogo Log 
Out: 

• Log out. Scegliendo questo terminerà tutto quello che state facendo, chiedendovi di 
salvare il lavoro aperto se non avete chiuso voi stessi i file, e vi riporterà alla schermata 
di login con il sistema ancora in funzione. 

• Il comando in fondo allo schermo, "Salva sessione per futuri accessi", è 
selezionato di default. Il suo compito è quello di salvare lo stato del tuo desktop 
(le applicazioni aperte e la loro posizione) e ripristinarlo al prossimo avvio. Se hai 
avuto problemi con il funzionamento del tuo desktop, puoi deselezionarlo per 
avere un nuovo inizio; se questo non risolve il problema, clicca su Tutte le 
impostazioni > Sessione e avvio, scheda Sessione, e premi il pulsante Cancella 
sessioni salvate. 

• Riavvio o spegnimento. Opzioni autoesplicative che alterano lo stato del sistema 
stesso. Disponibile anche utilizzando l'icona nell'angolo in alto a destra della barra in 
alto nella schermata di login. 

CONSIGLIO: Nel caso di un problema, Ctrl-Alt-Bksp ucciderà la tua sessione e ti riporterà 
alla schermata di login, ma qualsiasi programma e processo aperto non sarà salvato. 

 
Temporaneo 
Puoi lasciare temporaneamente la tua sessione in uno dei seguenti modi: 

• Schermata di blocco. Questa opzione è facilmente disponibile da un'icona nell'angolo in 
alto a destra del menu dell'applicazione. Protegge il tuo desktop da accessi non autorizzati 
mentre sei via, richiedendo la tua password utente per tornare alla sessione. 

• Avviare una sessione parallela come un utente diverso. Questo è disponibile dal 
pulsante di comando Switch User nell'angolo in alto a destra del menu dell'applicazione. 
Si sceglie questo per lasciare la sessione corrente dov'è e permette di avviare una sessione 
per un utente diverso. 

• Sospendi usando il pulsante di accensione. Questa opzione è disponibile dalla finestra di 
dialogo Log Out e pone il sistema in uno stato di basso consumo. Le informazioni sulla 
configurazione del sistema, le applicazioni aperte e i file attivi sono memorizzati nella 
memoria principale (RAM), mentre la maggior parte degli altri componenti del sistema 
sono spenti. È molto comodo e generalmente funziona molto bene in MX Linux. 
Invocata dal pulsante di accensione, la sospensione funziona bene per molti utenti, anche 
se il suo successo varia a seconda della complessa interazione tra i componenti di un 
sistema: kernel, display manager, chip video, ecc. Se avete problemi, considerate di 
provare le seguenti modifiche: 

• Cambiare driver grafico, per esempio da radeon a AMDGPU (per le GPU 



più recenti), o da nouveau al driver proprietario Nvidia. 
• Regola le impostazioni in Application Menu > Settings > Power Manager. Per 

esempio: nella scheda Sistema, prova a deselezionare "Blocca schermo quando 
il sistema va in stand-by". 



• Clicca su Application Menu > Settings > Screensaver e regola i valori di 
Display Power Management nella scheda Advanced. 

• Schede AGP: aggiungere l'opzione "NvAgp" "1" alla sezione Device di xorg.conf 
• Sospendi usando la chiusura del coperchio del laptop. Alcune configurazioni 

hardware possono avere problemi con questo. L'azione sulla chiusura del coperchio 
può essere regolata nella scheda Generale di Power Manager, dove "Spegni display" si 
è dimostrato affidabile nell'esperienza degli utenti MX. 

• Ibernazione. L'opzione di ibernazione è stata rimossa dalla casella di logout nelle 
precedenti versioni di MX Linux perché gli utenti hanno riscontrato diversi problemi. 
Può essere abilitata in MX Tweak, scheda Other. Consultare anche la Wiki di 
MX/antiX. 

 

2.5 Il processo di installazione 

2.5.1 Passi dettagliati per l'installazione 

  Installazione di base di MX Linux (con 

partizionamento)  Installazione criptata di MX 
Linux (con partizionamento) 

 Impostazione della mia cartella di casa 
 

Per iniziare, avviate il LiveMedium, poi cliccate sull'icona dell'installatore nell'angolo in alto a 
sinistra. Se l'icona manca, clicca F4 e digita: minstall-pkexec (password di root sul LiveMedium: 
root). 

 

Figura 2-14: Schermo dell'installatore Home 

Commenti 

https://mxlinux.org/wiki/system/hibernate
https://mxlinux.org/wiki/system/hibernate
https://youtu.be/jSYycsZPm_Q
https://youtu.be/jSYycsZPm_Q
https://youtu.be/tQjftZsoySg
https://youtu.be/tQjftZsoySg
https://www.youtube.com/watch?v=twDhZFBMgJ0


• Il lato destro dello schermo dell'installatore presenta le scelte dell'utente mentre 
l'installazione procede; il lato sinistro fornisce chiarimenti sul contenuto del lato destro. 

• Keyboard Settings permette di cambiare la tastiera per il processo di installazione. 



 

Figura 2-15: Installatore impostato su Regular Install con Root & Home Slider 

Commenti 
• Usare il disco. Se non sei sicuro di quale sia la partizione che vuoi, usa i nomi che vedi 

in GParted. Il disco selezionato verrà esaminato da SMART per verificarne l'affidabilità. 
Se vengono rilevati problemi, si vedrà una schermata di avviso. Dovrai decidere se 
accettare questo rischio e continuare, selezionare un altro disco o terminare 
l'installazione. Per maggiori informazioni, clicca su Menu Applicazione > Sistema > 
GSmartControl e "Esegui test" sul disco. 

 

Figura 2-16: Avviso SMART di rischio di fallimento 

• Installazione regolare usando l'intero disco. Selezionare questa opzione se si 
intende utilizzare l'intero disco rigido per MX Linux. Il disco sarà ripartizionato e 
tutti i dati esistenti saranno persi. 

• Per impostazione predefinita verranno create una partizione root e una partizione 
di swap. Verrà creata anche una partizione /boot se si sceglie di usare la 
crittografia. 

• Se desideri una partizione home separata, puoi usare il cursore per 
dividere lo spazio disponibile tra le partizioni root e home. 

• Un messaggio pop-up vi chiede di confermare l'utilizzo dell'intero disco. 
 

• Personalizza il layout del disco: Se vengono rilevate partizioni esistenti sul disco, 
questa opzione sarà quella predefinita. Potrai usare la schermata di selezione delle 
partizioni per usare le partizioni esistenti. 

https://en.wikipedia.org/wiki/S.M.A.R.T


 
 

Figura 2-17: Selezione della partizione 
 
 
 

 

Figura 2-18: Cliccate con il tasto destro del mouse su un disco per mostrare le opzioni del modello. 
 

Commenti 
• Scegliete Partizioni. Specificate le partizioni root e swap che volete usare. Usate la 

colonna USE FOR per scegliere per cosa volete usare una partizione. Se avete 
impostato una partizione separata per la vostra home directory, specificatela qui, 
altrimenti lasciate /home impostata su root. 

• Molti utenti preferiscono collocare la loro home directory in una partizione 
diversa da quella di / (root), in modo che qualsiasi problema con - o anche la 
sostituzione totale di - la partizione di installazione lascerà intatte tutte le 
impostazioni e i file individuali dell'utente. 

• A meno che non stiate usando l'encrpytion o sappiate cosa state facendo, 
lasciate l'avvio impostato su root. 

• In questa schermata è disponibile una semplice gestione delle partizioni. Cliccate 
con il tasto destro del mouse su un disco per mostrare i modelli di partizione. I 
modelli sono adatti solo per modifiche all'intero disco, quindi se volete 



ridimensionare o mettere a punto i layout delle partizioni, usate un 



Il partition manager esterno (cioè: gparted) è disponibile facendo clic sul 
pulsante Partition Manager in basso a destra del Partition Chooser. 

 
• Preferenze. 

• Selezionate Preserva i dati in /home se state facendo un aggiornamento e avete 
già dei dati in una partizione o cartella esistente. Questa opzione non è 
generalmente raccomandata a causa del rischio che le vecchie configurazioni non 
corrispondano alla nuova installazione, ma può essere utile in situazioni 
specifiche, ad esempio per riparare un'installazione. 

• Selezionate Check for bad blocks se volete fare una scansione per i difetti fisici 
sul disco rigido durante la formattazione. Questo è raccomandato per gli utenti 
con dischi più vecchi. 

• Potete cambiare l'etichetta della partizione dove volete installare (per esempio, in 
"MX- 21 Testing Installation") nella colona Label. 

• Infine, si può opzionalmente selezionare il tipo di file system che si desidera 
utilizzare sul disco rigido. L'ext4 di default è raccomandato in MX Linux se 
non avete una scelta particolare. 

• Puoi mettere a punto le tue impostazioni di cifratura con il pulsante "Advanced 
Encryption Settings" o semplicemente mantenere le impostazioni predefinite. 

 

Figura 2-19: L'installatore chiede il metodo di avvio 
 

Commenti 
• Mentre il sistema operativo linux principale viene copiato sul disco rigido, è possibile 

fare clic sul pulsante "Next" per compilare alcune informazioni di configurazione 
aggiuntive. La Figura 2-18 mostra le opzioni di installazione del bootloader GRUB. 

• La maggior parte degli utenti medi accetterà le impostazioni predefinite qui, che 
installeranno il bootloader all'inizio del disco. Questa è la posizione abituale e non 
causerà alcun danno. 

• Gli utenti UEFI dovrebbero scegliere qualsiasi partizione ESP vogliano usare. Quella 
predefinita è la prima trovata. 

• Quando si clicca su Next, un messaggio pop-up controllerà che si accetti la posizione 
del bootloader GRUB. L'installazione di GRUB può richiedere alcuni minuti in alcune 



situazioni. 
• Notate che la partizione mostrata (sda) è solo un esempio; la vostra particolare 

scelta di partizione potrebbe essere diversa. 



 

Figura 2-20: Impostazione dei nomi di rete del computer 

Commenti 
• Molti utenti scelgono un nome unico per il loro computer: laptop1, MyBox, 

StudyDesktop, UTRA, ecc. Puoi anche lasciare il nome predefinito così com'è. 
• Puoi semplicemente cliccare su Next qui se non hai una rete di computer. 
• Se non avete intenzione di ospitare cartelle di rete condivise sul vostro PC, allora 

potete disabilitare samba. Questo non influenzerà la capacità del tuo PC di accedere 
alle condivisioni ospitate altrove sulla tua rete. 

 

 
Figura 2-21: Impostazioni di localizzazione, fuso orario e servizio 

Commenti 
• Le impostazioni predefinite saranno di solito corrette qui, a patto che siate stati attenti 

ad inserire eventuali eccezioni nella schermata di avvio di LiveMedium. 
• Le impostazioni possono essere cambiate di nuovo una volta che avete avviato Xfce. 



 
 

Figura 2-22: Abilita/Disabilita i servizi 

Commenti 
• Questa schermata viene visualizzata solo se si è cliccato su "View" nella 

schermata Locale, Timezone & Services Setting. 
• I servizi sono applicazioni e funzioni associate al kernel che forniscono capacità ai 

processi di livello superiore. Se non avete familiarità con un servizio, dovreste 
lasciarlo stare. 

• Queste applicazioni e funzioni richiedono tempo e memoria, quindi se siete preoccupati 
per la capacità del vostro computer, potete guardare questa lista per gli elementi di cui 
siete sicuri di non aver bisogno. 

• Se in seguito volete cambiare o regolare i servizi di avvio potete usare uno strumento a 
riga di comando chiamato sysv-rc-conf. Sysv-rc-conf è installato di default e deve essere 
eseguito come root. 

 
 
 

 

Figura 2-23: Configurazione utente 



Commenti 
• Il livello di sicurezza delle password che sceglierete qui dipenderà molto 

dall'impostazione del computer attuale. Un desktop domestico è generalmente meno 
probabile che venga scassinato. 

• Se selezionate Autologin, sarete in grado di bypassare la schermata di login e accelerare 
il processo di avvio. L'aspetto negativo di questa scelta è che chiunque abbia un qualche 
tipo di accesso al vostro computer sarebbe in grado di accedere direttamente al vostro 
account. È possibile in seguito cambiare le preferenze di autologin nella scheda 
"Opzioni" di MX User Manager. 

• Puoi trasferire qualsiasi modifica fatta al tuo desktop Live all'installazione HD 
selezionando l'ultima casella. Una piccola quantità di informazioni critiche (per 
esempio, il nome del tuo Access Point wireless) sarà tradotta automaticamente. 

• Se non si imposta una password di root, le autenticazioni della gui saranno impostate 
sulla password utente, se non lo sono già state. 

 
 

 

Figura 2-24: Installazione completa 

Commenti 
• Dopo che la copia del sistema è terminata e i passi di configurazione sono 

stati completati, verrà presentata una schermata "Installation Complete" e 
sarete pronti a partire! 

• Se non vuoi riavviare dopo aver finito l'installazione, deseleziona l'opzione di 
riavvio automatico prima di cliccare su Finish. 

 

2.6 Risoluzione dei problemi 

2.6.1 Nessun sistema operativo trovato 
Quando si riavvia dopo un'installazione, a volte succede che il computer segnala che non è stato 
trovato alcun sistema operativo o disco avviabile. Potrebbe anche non mostrare un altro sistema 
operativo installato, come Windows. Di solito, questi problemi significano che GRUB non è 
stato installato correttamente, ma è facile da correggere. 



• Se si avvia con UEFI, assicurarsi che Secure Boot sia disattivato nelle impostazioni 
del bios/UEFI del sistema. 



• Se potete avviare almeno una partizione, aprite un terminale di root ed eseguite 
questo comando: 
aggiornare-grub 

• Altrimenti, procedete con MX Boot Repair. 
• Avvio al LiveMedium. 
• Lanciate MX Tools > Boot Repair. 
• Assicurati che sia selezionato "Reinstall GRUB Bootloader", quindi clicca su OK. 
• Se questo ancora non risolve il problema, potreste avere un disco rigido difettoso. 

Di solito, avrete visto una schermata di avviso SMART al riguardo quando avete 
iniziato l'installazione. 

 

2.6.2 Dati o altre partizioni non accessibili. 
Le partizioni e le unità diverse da quella designata come avvio potrebbero non essere 
avviate o richiedere l'accesso come root dopo l'installazione. Ci sono un paio di modi per 
cambiare questo. 

• Per le unità interne, usate Start > Impostazioni > MX Tweak, altra scheda: spuntate 
"Enable mounting of internal drives by non-root users". 

• GUI. Se hai installato Gnome Disks, clicca su Application Menu > System > Disks. 
Spunta tutto quello che vuoi montare all'avvio e salva; quando riavvii dovrebbe 
essere montato e avrai accesso in Thunar. 

• CLI. Aprite un File Manager e navigate fino al file /etc/fstab; usate l'opzione click destro 
per aprirlo come root in un editor di testo. Cercate la linea che contiene la partizione o 
l'unità a cui volete accedere (potrebbe essere necessario digitare blkid in un terminale per 
identificare l'UUID). Cambiatelo seguendo questo esempio per una partizione dati. 

UUID=9501<snip>912 /data ext4 utenti 0 2 
Questa voce farà sì che la partizione venga montata automaticamente all'avvio e vi permetterà 
anche di montarla e smontarla come utente normale. Questa voce farà anche in modo che il file 
system venga controllato periodicamente all'avvio. Se non volete che venga montata 
automaticamente all'avvio, cambiate il campo delle opzioni da "user" a "user,noauto". 

• Se non volete che venga controllato regolarmente, cambiate il "2" finale con uno "0". 
Dal momento che hai un filesystem ext4 è suggerito che tu abiliti il controllo 
automatico. 

• Se l'elemento è montato ma non viene mostrato in File Manager, aggiungete un 
ulteriore "comment=x- gvfs-show" alla linea nel vostro file fstab, che forzerà il 
montaggio ad essere visibile. Nell'esempio di cui sopra, la modifica sarebbe come 
questa: 

UUID=9501<snip>912 /data ext4 users,comment=x-gvfs-show 0 2 
NOTA: nessuna di queste procedure cambierà i permessi di Linux, che sono applicati a 
livello di cartella e di file. Vedere la sezione 7.3. 

 

2.6.3 Problemi con i portachiavi 
Un portachiavi predefinito dovrebbe essere creato automaticamente e l'utente non dovrà fare 
nulla. Se si usa l'autologin, quando un'app accede al portachiavi all'utente verrebbe chiesto di 
inserire una nuova password per creare un nuovo portachiavi predefinito. Dettagli nel Wiki 
tecnico di MX/Antix. 

https://mxlinux.org/wiki/system/gnome-keyring
https://mxlinux.org/wiki/system/gnome-keyring
https://mxlinux.org/wiki/system/gnome-keyring


Notate che se agenti malevoli ottengono l'accesso fisico alla vostra macchina, usare una 
password vuota renderà più facile l'intrusione. Ma sembra abbastanza chiaro che se un agente 
malevolo ha accesso fisico alla vostra macchina è comunque tutto finito. 



2.6.4 Bloccaggio 
Se MX Linux si blocca durante l'installazione, di solito è dovuto a un problema di hardware 
difettoso o a un DVD difettoso. Se hai determinato che il DVD non è il problema, potrebbe 
essere dovuto a RAM difettosa, un disco rigido difettoso, o qualche altro pezzo di hardware 
difettoso o incompatibile. 

• Aggiungete una delle opzioni di avvio usando F4 all'avvio o consultando la Wiki 
MX/antiX. Il problema più comune deriva dal driver grafico. 

• Il tuo drive DVD potrebbe avere dei problemi. Se il tuo sistema lo supporta, crea 
una chiavetta USB avviabile da MX Linux e installala da quella. 

• I sistemi spesso si bloccano a causa del surriscaldamento. Aprite il case del computer e 
assicuratevi che tutte le ventole del sistema siano in funzione quando viene acceso. Se 
il tuo BIOS lo supporta, controlla le temperature della CPU e della scheda madre 
(inserisci i sensori in un terminale root se possibile) e confrontale con le specifiche di 
temperatura del tuo sistema. 

• Spegnete il computer e rimuovete qualsiasi hardware non essenziale, poi tentate di 
nuovo l'installazione. L'hardware non essenziale può includere dispositivi USB, seriali 
e con porta parallela; schede di espansione PCI, AGP, PCIE, modem o ISA rimovibili 
(escluso il video, se non hai un video integrato); dispositivi SCSI (a meno che tu non 
stia installando da o verso uno); dispositivi IDE o SATA che non stai installando da o 
verso; joystick, cavi MIDI, cavi audio e qualsiasi altro dispositivo multimediale 
esterno. 

https://mxlinux.org/wiki/system/boot-parameters
https://mxlinux.org/wiki/system/boot-parameters


3 Configurazione 

 Cose da fare dopo aver installato MX Linux 
 

Questa sezione copre le istruzioni di configurazione per far funzionare correttamente il vostro 
sistema da una nuova installazione di MX Linux, e una breve guida alla personalizzazione 
personale. 

 
3.1 Periferiche 

3.1.1 Smartphone 
 

 Smartphone & MX-16 (samsung galaxy s5 e iphone 6s) 
 

Android 
 

Condivisione di file con un dispositivo Android. 
 

• La maggior parte dei telefoni con Android 4.xx e successivi includono la capacità 
mtp, e si può utilizzare la seguente procedura. 

 
• Collegare il telefono e toccare il link che appare per assicurarsi che l'opzione 

di archiviazione id sia impostata su "scambio di file" o qualcosa di simile. 
 

• Aprire File Manager. Quando Dispositivi mostra il nome del tuo telefono (o: 
Storage), cliccaci sopra. Se non lo vedi, riavvia il telefono. Il tuo telefono 
potrebbe allora mostrare una finestra di dialogo che ti chiede se permetti 
l'accesso. 

 
• Naviga fino alla posizione che stai cercando. 

 
• Alcuni file possono essere visualizzati e gestiti con le applicazioni MX Linux: 

cliccate su Device nel pannello di sinistra, poi fate doppio clic su CD Drive se 
necessario. 

 
• Musica: usa il lettore musicale predefinito (clementina) 

 
• Immagini: usa l'applicazione predefinita per la visualizzazione delle 

immagini (gthumb, gwenview) o installa un'applicazione diversa come 
Shotwell o digikam. 

 
• In caso di problemi, i telefoni Android possono essere raggiunti tramite un browser 

https://youtu.be/aESEb8lTvz4
https://youtu.be/aESEb8lTvz4
https://www.youtube.com/watch?v=YoMRRXP3Pic
http://en.wikipedia.org/wiki/Media_Transfer_Protocol


web installando un'applicazione dal Play Store di Google come AirDroid. 

http://web.airdroid.com/


 
 
 
 

Figura 3-1: Thunar collegato a un telefono Android 
 

iPhone 
Un MX iDevice Mounter dedicato fornisce l'accesso attraverso Thunar. Vedere la sezione 3.2. 

 

3.1.2 Stampante 
 

 
Figura 3-2: schermata Nuova stampante delle impostazioni di stampa 

 
Allegato 

 
MX Linux offre due utility per configurare e gestire le stampanti. Print Settings di solito 
funziona bene, ma se sorgono problemi si raccomanda di passare a CUPS in un browser 
inserendo "localhost:631: nella barra degli indirizzi di un browser web. 



• Applicazione Impostazioni di stampa 
 

• Fare clic sul menu Start > Sistema > Impostazioni di stampa 
 

• Clicca sul pulsante "+Aggiungi" 
 

• Attendere sullo schermo New Printer mentre l'applicazione cerca le stampanti 
collegate e wireless. 

 
• Mostrerà il software raccomandato per ogni stampante trovata. 

 
• Segui le istruzioni per concludere l'installazione della stampante. 

 
HELP: il Wiki di Debian. 

 
 

Rete 
 

Samba su MX Linux permette di stampare attraverso la rete verso stampanti condivise su altri 
computer (Windows, Mac, Linux) e dispositivi NAS (Network Attached Storage) che offrono 
servizi Samba (sezione 3.5). 

 
Utilizzo delle impostazioni di stampa 

• Fare clic sul menu Start > Sistema > Impostazioni di stampa 
 

• Selezionare Server > Nuovo> Stampante 
 

• Selezionare Stampante di rete > Stampante Windows via SAMBA 
 

• Nella finestra di dialogo per smb:// inserire o servername/printername o server- 
ipaddress/printername. Per esempio: bigserver/usbprinter1 o 192.168.0.100/printer2 

 
• Se hai problemi a identificare i nomi dei server e delle stampanti, clicca su 

Menu Start > Sistema > Samba per i dettagli. 
 

• Lascia il pulsante selezionato per Prompt user if authentication is required, poi 
clicca su Forward 

 
• Lasciare il pulsante selezionato per Selezionare la stampante dal database e poi cliccare su Avanti 

 
• Selezionare il driver e poi Avanti 

 
• Descrivere la stampante se necessario e poi applicare 

https://wiki.debian.org/SystemPrinting
https://wiki.samba.org/index.php/Main_Page


• Quando la stampante appare nella finestra, clicca con il tasto destro del mouse su 
Properties > Print Test Page per assicurarti che la connessione e il driver 
funzionino correttamente. 

 
Risoluzione dei problemi 

 
• C'è un'utilità di risoluzione dei problemi integrata nell'applicazione Impostazioni di 

stampa. Clicca su Help > Troubleshooting. 
 

• Per le stampanti HP, il pacchetto extra hplip-gui installerà un'utile applet 
nell'area di notifica che fornisce strumenti per la risoluzione dei problemi. 

 
• Se la tua stampante smette improvvisamente di stampare, controlla che sia ancora 

abilitata cliccando sul menu Start > Sistema > Impostazioni di stampa, poi clicca 
con il tasto destro del mouse sulla tua stampante e abilitala di nuovo. 

 
• Se la vostra stampante non viene riconosciuta o non funziona correttamente, 

consultate la Wiki MX/antiX per un aiuto dettagliato su come ottenere il driver 
corretto. 

 

3.1.3 Scanner 
 

Gli scanner sono supportati in Linux da SANE (Scanner Access Now Easy), che è un'interfaccia 
di programmazione delle applicazioni (API) che fornisce un accesso standardizzato a qualsiasi 
hardware per scanner di immagini raster (scanner piano, scanner portatile, videocamere e 
fotocamere, frame-grabber, ecc.) 

 
Passi di base 

 
Potete gestire il vostro scanner in MX Linux con il Simple Scan predefinito. È molto facile da 
usare e può esportare in PDF con un solo clic. 

 
Risoluzione dei problemi 

 
• Alcuni scanner richiedono un diverso frontend (interfaccia di sistema con lo scanner): 

puoi installare gscan2pdf, cliccare su Edit > Preferences e usare il menu a tendina per 
selezionarne un altro (per esempio, scanimage). 

 
• Assicurati che il tuo scanner sia elencato come supportato da SANE in questa lista. 

 
• Se continuate ad avere problemi, controllate la Wiki di MX/antiX per le soluzioni. 

 

3.1.4 Webcam 
 

Molto probabilmente la tua webcam video funzionerà in MX Linux; puoi testarla lanciando il 
menu Start > Multimedia > webcamoid e usando le impostazioni in fondo alla finestra per 
regolare il tuo sistema. Se non sembra funzionare, c'è una recente discussione dettagliata sui 

https://mxlinux.org/wiki/hardware/printer-drivers
https://mxlinux.org/wiki/hardware/printer-drivers
http://www.sane-project.org/sane-mfgs.html
https://mxlinux.org/wiki/hardware/scanner
https://mxlinux.org/wiki/hardware/scanner
https://mxlinux.org/wiki/hardware/scanner


driver e la configurazione nella Wiki di Arch. L'audio della webcam a volte è più complicato, 
vedi la sezione 4.1 su Skype. 

https://wiki.archlinux.org/index.php/Webcam


3.1.5 Stoccaggio 
 

Unità disco (come SCSI, SATA e SSD), fotocamere, unità USB, telefoni, ecc. - queste sono tutte 
diverse forme di archiviazione. 

 
Montaggio 

 
Per impostazione predefinita, i dispositivi di archiviazione che sono collegati al sistema vengono montati 
automaticamente nella cartella 
/media/<username>/ directory, e poi si apre una finestra del browser dei file per ognuno (questo 
comportamento può essere cambiato in Thunar: Modifica > Preferenze o KDE: Impostazioni di 
sistema > Archiviazione removibile). 

 
Non tutti i dispositivi di archiviazione, specialmente i dischi interni extra e le partizioni, sono 
montati automaticamente quando sono inseriti in un sistema e possono richiedere l'accesso di 
root. Le opzioni possono essere regolate con MX Tweak > Other e Settings > Removable Drives 
and Media. 

 
Permessi 

 
L'estensione dell'accesso dell'utente alla memoria dipenderà dal file system che contiene. La 
maggior parte dei dispositivi di archiviazione esterni commerciali, specialmente i dischi rigidi, 
sono preformattati come fat32 o ntfs. 

 

Filesystem di 
archiviazione 

Permessi 

grasso32 Nessuna. 
ntfs Per impostazione predefinita, i permessi/proprietà sono 

concessi all'utente che monta il 
dispositivo. 

ext2, ext4 e la maggior 
parte dei file 
system Linux 

Montato di default con proprietà impostata su Root. 
Regolazione dei permessi: vedi sezione 7.3. 

 

Si può cambiare la necessità di essere Root per l'accesso ai dispositivi di archiviazione interna 
con filesystem Linux utilizzando MX Tweak, Other tab (Sezione 3.2). 

 
SSD 

 
Le macchine più recenti possono avere un SSD interno: un'unità a stato solido che non ha 
componenti mobili. Queste unità tendono ad accumulare blocchi di dati che non sono più 
considerati in uso, rallentando questa unità molto veloce. Per evitare che questo accada, MX 
Linux esegue un'operazione TRIM su una pianificazione settimanale che è possibile 
visualizzare aprendo il file /var/log/trim.log. 

 

3.1.6 Dispositivi Bluetooth 
 

I dispositivi esterni bluetooth come una tastiera, un altoparlante, un mouse, ecc. normalmente 

https://en.wikipedia.org/wiki/Solid-state_drive
https://en.wikipedia.org/wiki/Trim_(computing)


funzionano automaticamente. In caso contrario, seguite questi passi: 
 

• Fare clic sul menu Start > Impostazioni > Bluetooth Manager (oppure: fare clic con il 
tasto destro del mouse sull'icona Bluetooth nell'area di notifica > Dispositivi) 



• Controlla che il tuo adattatore sia abilitato e che sia visibile cliccando sul menu Start 
> Impostazioni > Adattatori Bluetooth 

 
• Assicurati che il dispositivo che vuoi sia visibile; in Bluetooth Manager clicca 

su Adapter > Preferences e seleziona l'impostazione di visibilità. 
 

• Se il dispositivo desiderato è nella finestra Devices, selezionalo e poi clicca su Setup. 
 

• In caso contrario, clicca sul pulsante Cerca e premi Connetti sulla linea del 
dispositivo per iniziare l'accoppiamento. 

 
• Per un telefono, dovrai probabilmente confermare il numero di accoppiamento sia 

sul dispositivo che sul desktop. 
 

• Dopo l'accoppiamento con il dispositivo Bluetooth, la finestra di dialogo Setup vi 
chiede di confermare il tipo di configurazione bluetooth da associare ad esso. 

 
• Quando il processo di Setup è finito, il dispositivo dovrebbe funzionare. 

 
Trasferimento di oggetti 

 
Per essere in grado di passare oggetti (documenti, foto, ecc.) avanti e indietro tra un desktop 
MX Linux e un dispositivo come un telefono usando il bluetooth, fate i seguenti passi: 

 
• Installare obex-data-server dai repo. 

 
• Porterà con sé libopenobex2. 

 
• In rari casi, il pacchetto obex-data-server può bloccare l'uso del mouse o 

della tastiera Bluetooth. 
 

• Confermare che il telefono e il desktop hanno entrambi il bluetooth abilitato e sono visibili. 
 

• Invia file 
 

• Dal desktop di MX Linux: fare clic con il tasto destro del mouse sull'icona 
Bluetooth nell'area di notifica > Invia file (o usare Bluetooth Manager) 

 
• Dal telefono: segui le istruzioni appropriate per il tuo dispositivo. 

 
• Tieni d'occhio il dispositivo ricevente per confermare l'accettazione dell'oggetto 

da trasferire. 
 

È anche possibile fare uso di hcitool sulla linea di comando. 

http://www.linuxjournal.com/content/bluetooth-hacks


Link 

• Risoluzione dei problemi di Blueman 
 

• Arch Wiki 
 

• Wiki Debian sull'accoppiamento 
 

3.1.7 Compresse a penna 
Le tavolette con penna Wacom sono rilevate automaticamente e supportate nativamente su 
Debian. Dettagli nella Wiki di MX/antiX. 

 
Link 

• Il progetto Linux Wacom 
 

3.2 Strumenti MX di base 

Un certo numero di applicazioni sono state sviluppate specificamente per MX Linux, adattate 
o portate da antiX, o adattate da fonti esterne per risparmiare lo sforzo dell'utente con compiti 
importanti che spesso comportano passaggi poco intuitivi. (L'istantanea e altri strumenti 
avanzati sono trattati nella sezione 6.6) 

 

 
Figura 3-3: dashboard di MX Tools (Xfce installato). Le dashboard Live e KDE sono 
un po' diverse. 

https://github.com/blueman-project/blueman/wiki/Troubleshooting
https://wiki.archlinux.org/index.php/Blueman
https://wiki.debian.org/BluetoothUser#Pairing
https://www.wacom.com/en-us/
https://mxlinux.org/wiki/hardware/wacom/
https://mxlinux.org/wiki/hardware/wacom/
https://linuxwacom.github.io/


3.2.1 MX Updater (ex Apt-Notifier) 
 

Questa versatile applet (solo Xfce, KDE usa Discover) si trova nell'area di notifica dove ti 
avvisa quando i pacchetti sono disponibili. Assicurati di controllare le importanti opzioni 
disponibili attraverso il menu contestuale (clic destro). Se non appare, lancia MX Updater per 
aggiornare. Solo Xfce, KDE usa 

 

 
Figura 3-4: Schermata di visualizzazione e aggiornamento da MX Updater 

 
 

Notate la scelta tra upgrade e dist-upgrade. 
 
 

• full-upgrade (dist-upgrade): l'azione predefinita. Aggiornerà tutti i pacchetti che hanno 
aggiornamenti, anche quelli in cui un aggiornamento comporterà la rimozione automatica 
di altri pacchetti esistenti o causerà l'aggiunta di nuovi pacchetti alla tua installazione in 
modo che tutte le dipendenze siano risolte. 

 
• upgrade: raccomandato solo per gli utenti più esperti. Aggiornerà solo i pacchetti 

aggiornabili che non comportano la rimozione o l'installazione di altri pacchetti. Usare 
questa opzione significa che alcuni pacchetti aggiornabili potrebbero rimanere 
"trattenuti" sul tuo sistema. 

 
• Un'opzione per unattended upgrade è disponibile in Preferenze. Avviene in 

background, e non aggiunge nuovi pacchetti o rimuove quelli esistenti, usando il 
metodo "upgrade" piuttosto che dist-upgrade. 

 
AIUTO: qui. 

 

3.2.2 Bash config 
 

Bash (il linguaggio di shell predefinito in MX Linux) può ora essere impostato con questa 
piccola applicazione. Permette all'utente avanzato di apportare modifiche agli alias e alla 
tematizzazione del prompt del terminale nel file nascosto bashrc dell'utente. 

https://userbase.kde.org/Discover
https://mxlinux.org/wiki/help-files/help-mx-apt-notifier


 
 

Figura 3-5: la scheda per aggiungere o cambiare un alias 
 

Aiuto: qui. 
 

3.2.3 Opzioni di avvio 
 

 
Figura 3-6: schermata principale che mostra varie opzioni 

 
 

Le opzioni di avvio includono parametri del kernel, temi GRUB, immagini Splash e altri 
elementi. Questa applicazione rende veloce e facile per gli utenti la gestione di questi elementi. 

https://mxlinux.org/wiki/help-files/help-bash-config/


AIUTO: qui. 
 

3.2.4 Riparazione degli stivali 
 

Il bootloader è il primo programma software ad essere eseguito ed è responsabile del 
caricamento e del trasferimento del controllo al kernel. A volte succede che il bootloader su 
un'installazione convenzionale (GRUB2) diventa disfunzionale, e questo strumento permette di 
ripristinare il bootloader ad uno stato funzionale da un avvio LIVE. 

 

 
Figura 3-7: Schermata principale di Boot Repair, con l'opzione più comune selezionata 

 
AIUTO: qui. 

 

3.2.5 Sistema di luminosità 
 

Questo strumento colloca un'icona nel systray che visualizza una piccola applicazione con la 
quale l'utente può regolare la luminosità dello schermo. 

 

 
Figura 3-8: pronto a regolare la luminosità 

 
 
 

3.2.6 Scansione di salvataggio di Chroot 
 

Questo strumento permette di entrare in un sistema anche se il suo 

initrd.img è rotto. AIUTO: qui. 

https://mxlinux.org/wiki/help-files/help-mx-boot-options
https://mxlinux.org/wiki/help-files/help-mx-boot-repair
https://mxlinux.org/wiki/system/chroot-rescue-scan/


 
 

Figura 3-9: risultati della scansione per i sistemi Linux 
 
 
 

3.2.6 Fissa le chiavi GPG (in precedenza Check apt GPG) 
 

Se cercate di installare pacchetti non autenticati, incontrerete un errore di apt: Le seguenti firme 
non possono essere verificate perché la chiave pubblica non è disponibile. Questa utile utility 
evita di compiere i molti passi necessari per ottenere tale chiave. 

 

 
Figura 3-10: Risultati del controllo delle chiavi pubbliche dei repo con le chiavi Fix GPG 

 
AIUTO: qui. 

https://mxlinux.org/wiki/help-files/help-mx-check-apt-gpg


3.2.7 Pulizia 
 

 
Figura 3-11: Cleanup pronto per andare al lavoro 

 
Questa piccola applicazione offre un modo facile e sicuro per rimuovere i file non necessari e 

ripristinare lo spazio. AIUTO: qui. 

3.2.8 Installatore di codec 
 

Un codec è un pezzo di software che permette di codificare/decodificare un flusso di dati digitali 
o un segnale. La maggior parte dei codec sarà installata in MX Linux, ma alcuni sono limitati. 
Libdvdcss2 (per leggere i dvd commerciali) e libtxc-dxtn0 (per certe texture di giochi 3D) 
saranno installati. Questo strumento permette una facile installazione di alcuni codec limitati 
trasferendo la responsabilità all'utente. 

 
 

 
Figura 3-12: schermata principale del programma di installazione dei codec 

 
AIUTO: qui. 

https://mxlinux.org/wiki/help-files/help-mx-cleanup/
https://mxlinux.org/wiki/help-files/help-mx-codecs-installer


3.2.9 Conky 
L'applicazione chiamata MX Conky funziona insieme a Conky Manager per manipolare i 
dettagli di un conky, specialmente il colore, nella collezione di conky MX molto facilmente. 
Un'applicazione "conky-toggle" per spegnere e accendere qualsiasi conky configurato è anche 
nel menu. 

 

Figura 3-13: Conky pronto a modificare i dettagli di un conky predefinito 
 

AIUTO: qui. 
 

3.2.10 iDevice Mounter 
 

Questa applicazione è in grado di mostrare il contenuto di un iPhone o iPad in Thunar, 
un'impresa altrimenti spesso difficile. 

 

 
Figura 3-14: iDevice Mounter pronto a montare un iPhone 6 

 
AIUTO: qui. 

https://teejeetech.in/conky-manager/
https://mxlinux.org/wiki/help-files/help-mx-conky
https://mxlinux.org/wiki/help-files/help-mx-idevice-mounter
https://mxlinux.org/wiki/help-files/help-mx-idevice-mounter


3.2.11 Programmatore di lavoro 
 

Questa comoda applicazione presenta un frontend grafico per l'applicazione a riga di comando 
crontab, facilitando la configurazione dei lavori. 

 

 
Figura 3-15: Programmatore di lavori 

HELP: file locale: /usr/share/job-schduler/locale/. 
 

3.2.12 Creatore di live-usb 
 

Questo semplice strumento permette di creare rapidamente un live-usb partendo da un file iso, 
un live - cd/dvd o un live-usb esistente o anche un sistema live in funzione. 

 

 
Figura 3-16: Creatore USB dal vivo 

 
AIUTO: qui. 

 

3.2.13 Editor di menu 
 

 Editor di menu MX 

https://mxlinux.org/wiki/system/crontab/
https://mxlinux.org/wiki/help-files/help-live-usb-maker
https://mxlinux.org/mx-menu-editor


Questo semplice editor di menu rende facile modificare, aggiungere o cancellare voci di menu. 
Qualsiasi modifica viene salvata nella directory dell'utente /.local/shared/applications/. Solo 
Xfce. KDE ha il proprio editor di menu. 

 

 
Figura 3-17: Editor di menu con la categoria Multimedia espansa 

 
AIUTO: qui. 

 

3.2.14 Assistente di rete 
 

Questa applicazione rende il processo di risoluzione dei problemi di rete molto più facile 
rilevando l'hardware, cambiando lo stato di uno switch hardware, permettendo di gestire i driver 
Linux e Windows, e fornendo strumenti di rete generali. 

 

 
Figura 3-18: Network Assistant rileva l'hardware wireless e cablato 

 
AIUTO: qui. 

 

3.2.15 Installatore di driver Nvidia 
 

Il nvidia graphics driver installer semplifica enormemente una procedura importante: 
installare un driver grafico proprietario utilizzando lo script sottostante ddm-mx. Cliccando 
sull'icona dell'installatore di driver Nvidia si apre un terminale, e tutto ciò che l'utente deve 
fare nella maggior parte dei casi è accettare l'impostazione predefinita. 

https://mxlinux.org/wiki/help-files/help-mx-menu-editor
https://mxlinux.org/wiki/help-files/help-mx-network-assistant


 
 

Figura 3-19: MX Nvidia driver installer trovando non c'è bisogno di continuare 
 

AIUTO: qui. 
 

3.2.16 Installatore di pacchetti 
 

 Installare applicazioni con MX Package Installer 
 

Il semplice gestore di pacchetti personalizzato per MX Linux permette di cercare, installare o 
rimuovere sia i pacchetti popolari che qualsiasi pacchetto nei repository MX/Debian Stable, 
MX Test, Debian Backports e Flatpak in modo rapido, sicuro e facile. 

 
 

 
 

Figura 3-20: Package Installer, che mostra i pacchetti popolari per lo sviluppo 
 

AIUTO: qui. 
 

3.2.17 Repo Manager 
 

Ci sono molte ragioni per cui l'utente potrebbe voler cambiare il mirror predefinito in uso, da un 
server offline a un cambiamento nella posizione fisica del computer. Questo grande strumento 
fornisce il cambio dei repo con un solo clic, risparmiando un sacco di tempo e fatica. Fornisce 
anche un pulsante che testerà tutti i repo (MX o Debian) e selezionerà il più veloce. 

https://mxlinux.org/wiki/help-files/help-amdati-and-nvidia-installers
https://www.youtube.com/watch?v=4kXSMfPkQSA
https://mxlinux.org/wiki/help-files/help-mx-package-installer


 
 
 

Figura 3-21: Scegliere un repository da utilizzare in Repo Manager 
 

AIUTO: qui. 
 

3.2.18 Scheda audio 
 

I computer spesso hanno più di una scheda audio disponibile, e l'utente che non sente nulla può 
concludere che il suono non funziona. Questa piccola applicazione intelligente permette 
all'utente di selezionare quale scheda audio deve essere usata dal sistema. 

 

 
Figura 3-22: Fare la selezione in Scheda Audio 

 
AIUTO: qui. 

 

3.2.19 Tastiera di sistema 
 
 

Figura 3-23: Schermo principale pronto per l'utente a selezionare una tastiera diversa 

https://mxlinux.org/wiki/help-files/help-mx-repo-manager
https://mxlinux.org/wiki/help-files/help-sound-card


Nel caso in cui l'utente abbia trascurato di selezionare la tastiera di sistema dal menu Login, 
abbia mancato di impostarla nella sessione Live, o semplicemente abbia bisogno di fare un 
cambiamento, questa piccola applicazione fornisce un modo semplice per effettuare tale 
operazione dal menu Start. 

 
AIUTO: qui. 

 

3.2.20 Lingue del sistema 
 

Figura 3-24: Presentazione dei locali che devono essere 
generato per l'utente. 

 

Nel caso in cui l'utente abbia trascurato di selezionare il locale di sistema dal menu Login, abbia 
mancato di impostarlo nella sessione Live, o abbia semplicemente bisogno di fare un 
cambiamento, questa piccola applicazione fornisce un modo semplice per effettuare tale 
operazione dal menu Start. 

 
AIUTO: qui. 

 

3.2.21 Suoni di sistema (solo Xfce) 
 

Questo piccolo strumento raccoglie in un unico luogo le varie azioni e scelte coinvolte 
nell'impostazione dei suoni di sistema come login/logout, azioni, ecc. 

 

 
Figura 3-25: Impostare i suoni di login e logout in System Sounds 

 
AIUTO: qui. 

https://mxlinux.org/wiki/help-files/help-mx-system-keyboard
https://mxlinux.org/wiki/help-files/help-mx-system-locales
https://mxlinux.org/wiki/help-files/help-mx-system-sounds


3.2.22 Data e ora 

MX Date & Time richiede l'accesso come root e permette di effettuare regolazioni di tutti i tipi 
da un'unica app. 

 

 

Figura 3-26: La scheda principale di Data e ora. A sinistra: Xfce, a destra: KDE 
 

AIUTO: qui e qui. 
 

3.2.23 Tweak   
 

MX Tweak riunisce una serie di piccole ma spesso utilizzate personalizzazioni come la gestione 
del pannello, la selezione del tema, l'abilitazione e la configurazione del compositore, ecc. su 
una base per desktop. 

 

 
 

Figura 3-27: Le facce di MX-Tweak. A destra: Plasma, sinistra: XFCE 
 

AIUTO: qui. 

https://mxlinux.org/wiki/help-files/date-time/
https://userbase.kde.org/System_Settings/Date_%26_Time
https://mxlinux.org/wiki/help-files/help-mx-tweak


3.2.24 Formato USB 
 
 

 
Figura 3-28: Formattatore USB pronto a riformattare con fat32 

 
Questo piccolo strumento conveniente pulirà e riformatterà un drive USB per renderlo 
disponibile per nuovi scopi. 

 
AIUTO: qui. 

 
3.2.25 Scomparsa USB 

 
Questo strumento per smontare rapidamente supporti USB e ottici si trova nell'area di notifica 
quando è abilitato (default). Un singolo clic visualizza i supporti disponibili per lo smontaggio 
con un doppio clic. 

 

 
Figura 3-29: USB Unmounter con un dispositivo evidenziato per lo smontaggio 

 
AIUTO: qui. 

 

3.2.26 Gestore degli utenti 
 

Questa applicazione aiuta ad aggiungere, modificare e rimuovere utenti e gruppi nel vostro sistema. 

https://mxlinux.org/wiki/help-files/help-mx-format-usb/
https://www.mxlinux.org/wiki/help-files/help-mx-usb-unmounter


 
 

Figura 3-30: Gestione utenti, scheda Amministrazione 

AIUTO: qui. 
 

3.2.3 Strumenti deprecati 
 

Alcuni utenti cercheranno strumenti che non esistono più o che sono stati incorporati in nuovi 
strumenti. 

 
• ATI/AMD Driver Installer: rimosso per mancanza di un candidato driver adatto. 

 
• Broadcom Manager: riscritto per esigenze più generali come Network Assistant. 

 
• Compton Manager: incorporato in MX Tweak. 

 
• Debian Backports Installer: incorporato nel Package Installer. 

 
• Default Look: incorporato in MX Tweak. 

 
• Find Network Shares: rimosso a causa di problemi di licenza. 

 
• Flash Manager: Adobe® Flash® Player è ora deprecato ed è stato completamente 

rimosso. 
 

• Orientamento del pannello: incorporato in MX Tweak. 
 

• Test Repo Installer: incorporato nel Package Installer . 

https://mxlinux.org/wiki/help-files/help-mx-user-manager


3.3 Visualizza 

3.3.1 Risoluzione 
 

Figura 3-31: Utilità di visualizzazione . A sinistra: Xfce, a destra: KDE/plasma. 
 

La risoluzione si riferisce al numero fisico di colonne e righe di pixel che creano il display (per 
esempio, 1920x1200). Nella maggior parte dei casi, la risoluzione è impostata correttamente dal 
kernel durante l'installazione o quando viene collegato un nuovo monitor. In caso contrario, è 
possibile cambiarla nei seguenti modi: 

 
• Clicca su Menu Start > Impostazioni > Schermo. Usa i menu a tendina per impostare i 

valori corretti per il monitor che vuoi regolare. Per più opzioni e un controllo più fine, 
installa xrandr dai repo. 

 
• 4.16 Display di Xfce ora rende possibile il ridimensionamento frazionato per i monitor 

HiDPI. Clicca sul menu a tendina per "Scale" e seleziona Custom. 
 

• Per le schede Nvidia, potete installare il pacchetto nvidia-settings che vi darà uno 
strumento grafico che potete usare per modificare le impostazioni come root con il 
comando: nvidia-settings 

 
• In situazioni difficili, è possibile modificare manualmente il file di configurazione 

/etc/X11/xorg.conf. Potrebbe non esistere, quindi potrebbe essere necessario crearlo 
prima. Fate sempre un backup del file prima di cambiarlo, e controllate il Forum per un 
aiuto sull'uso di quel file. 

 

3.3.2 Driver grafici 
 

Se non sei soddisfatto delle prestazioni del tuo display, potresti aver bisogno/volere aggiornare 
il tuo driver grafico (assicurati di fare prima un backup del file /etc/X11/xorg.conf, se usato). Si 
noti che dopo un aggiornamento del kernel potrebbe essere necessario ripetere questa 
operazione, si veda la Sezione 7.6.3. 

 
Ci sono vari metodi disponibili per farlo. 

https://xorg-team.pages.debian.net/xorg/howto/use-xrandr.html
https://wiki.debian.org/Xorg#What_if_I_do_not_have_a_xorg_config_file.3F


 
• Per la maggior parte delle schede Nvidia, il metodo di gran lunga più semplice è 

quello di utilizzare gli installatori accessibili dalla dashboard di MX Tools (vedi 
sezione 3.2). 



• Alcune schede video più vecchie o meno comuni richiedono driver (come 
openchrome, mach64 & fbdev) che sono facilmente installabili solo con 
sgfxi (Sezione 6.5.3). 

 
• Alcune schede Nvidia non sono più supportate in Debian Stable ("Jessie"), si 

veda la Wiki MX/antiX. Sono comunque supportate dai driver nouveau e vesa. 
 

• Consultare la Wiki di Debian sui driver open-source per ati, radeon e amdgpu. Si noti 
che i driver aperti per AMD non sono più disponibili. 

 
• È anche possibile, ma più complicato, scaricare direttamente dal produttore. Questo 

metodo vi richiederà di selezionare e scaricare il driver corretto per il vostro sistema; 
per informazioni sul sistema, aprite un terminale e digitate: inxi -Gxx. 

 
Ecco i siti web dei driver per le marche più popolari (fate una ricerca sul web su 
"<brandname> linux driver" per gli altri): 

 
• Nvidia 

 
• Intel 

 
I driver Intel devono essere compilati, ma i driver Nvidia scaricati sono facilmente installabili: 

 
• Navigare in Thunar fino alla cartella dove è stato scaricato il driver 

 
• Fare clic con il tasto destro del mouse sul file, selezionare la scheda Permessi, selezionare Is 

executable 
 

• Premere CTRL-ALT-F1 per uscire da X (l'ambiente grafico) e arrivare 
al prompt del terminale 

 
• Accedi come root 

 
• Tipo: servizio lightdm stop 

 
• Scrivi: sh <nome del file>.run (assicurati di usare il nome effettivo del file) 

 
• Permettere al driver NVIDIA di disattivare il kernel nouveau 

 
• Quando finisce, digitate: service lightdm start per avviare nuovamente lightdm e xorg. 

 
• Un'altra importante opzione di driver è mesa, un'implementazione open-source della 

specifica OpenGL - un sistema per il rendering della grafica 3D interattiva. Gli utenti 
su macchine ad alte prestazioni riferiscono che l'aggiornamento di questo porta una 
significativa stabilizzazione al loro sistema. 

https://mxlinux.org/wiki/hardware/unsupported-nvidia-gpus
https://mxlinux.org/wiki/hardware/unsupported-nvidia-gpus
https://en.wikipedia.org/wiki/Nouveau_(software)
https://wiki.debian.org/AtiHowTo
https://wiki.debian.org/AtiHowTo
https://wiki.debian.org/AtiHowTo
http://www.nvidia.com/Download/index.aspx
https://www.intel.com/content/www/us/en/download-center/home.html
https://mxlinux.org/wiki/applications-system/compiling-software
https://docs.mesa3d.org/
http://www.opengl.org/


• Una versione più recente potrebbe essere disponibile nel Test Repo; usa il MX 
Package Installer (Sezione 3.2) per ottenerla. Deseleziona la casella che 
nasconde i pacchetti lib e dev, cerca "mesa" e spunta i pacchetti che sono 
aggiornabili per l'installazione. 

 
• Le schede grafiche ibride combinano due adattatori grafici sulla stessa unità. Un 

esempio popolare è la NVidia Optimus, che è supportata su Linux con Bumblee. Le 
schede grafiche più recenti possono anche utilizzare le funzioni primus incorporate 
nel driver nvidia attraverso senza il sistema bumblee. Per eseguire un'applicazione 
sotto le funzioni primus usa "nvidia-run-mx APP" per avviare un'applicazione con 
l'accelerazione grafica abilitata. 

 

3.3.3 Font 
 

Regolazione di base 
 

1. XFCE- Fare clic su Menu Start > Tutte le impostazioni > Aspetto, scheda Caratteri 
 

2. KDE/plasma - Clicca su Menu Start > Impostazioni di sistema > Caratteri 
 

3. Clicca sul menu a tendina per vedere l'elenco dei font e delle dimensioni dei punti 
 

4. Selezionate quello che volete e cliccate su OK 
 
 
 

Regolazioni avanzate 
 

1. Un certo numero di opzioni sono disponibili eseguendo in un terminale di root: 
dpkg-reconfigure fontconfig-config 

 
2. Le singole applicazioni possono avere i propri controlli, spesso si trovano in 

Modifica (o Strumenti) > Preferenze 
 

3. Per ulteriori regolazioni, vedere la Wiki di MX/antiX. 
 

4. I display ad alta risoluzione hanno esigenze speciali, vedi la Wiki MX/antiX. 
 

Aggiunta di font 
 

1. Ce ne sono alcuni in MX Package Installer disponibili con un solo clic. Per altre 
possibilità, clicca su Start Menu > Sistema > Synaptic/Muon Package 
Manager. 

 
2. Usa la funzione di ricerca dei font. 

 
3. Seleziona e scarica quelli che vuoi. Il pacchetto Microsoft core fonts ttf- 

mscorefonts-installer (installato di default) fornisce una facile installazione dei 

https://en.wikipedia.org/wiki/Nvidia_Optimus
https://www.mxlinux.org/wiki/system/font-adjustment
https://www.mxlinux.org/wiki/system/font-adjustment
https://www.mxlinux.org/wiki/system/font-adjustment
https://mxlinux.org/wiki/other/high-resolution-displays


Microsoft True Type Core Fonts per l'uso con siti web e applicazioni MS che girano 
sotto Wine. 



4. Estrarre se necessario, poi copiare come root (più semplice in un Thunar root) la cartella dei font in 
/usr/share/fonts/. 

 
5. I tuoi nuovi font dovrebbero essere disponibili nel menu a tendina in Tutte le 

impostazioni > Aspetto, scheda Caratteri. 
 

3.3.4 Doppio monitor 
 

I monitor multipli sono gestiti in MX Linux Xfce con il menu Start > Impostazioni > Display. 
Puoi usarlo per regolare la risoluzione, selezionare se uno clona l'altro, quali saranno accesi, ecc. 
Spesso è necessario uscire e rientrare per vedere il display selezionato. Gli utenti dovrebbero 
anche guardare la scheda Display di MX Tweak. Un controllo più fine di alcune caratteristiche è 
talvolta disponibile con xrandr. 

 
Xfce 4.16 ha migliorato notevolmente la gestione dei monitor multipli, con impostazioni nella 
scheda Advanced di Display che permettono impostazioni dettagliate per ogni monitor e la 
possibilità di salvare i profili dei monitor e farli usare automaticamente quando lo stesso 
hardware è collegato di nuovo. Se i problemi persistono, cercate nel forum Xfce, nel forum MX 
Linux e nel WIki MX/antiX se avete problemi insoliti. 

 
in KDE/Plasma i doppi monitor sono impostati con lo strumento di configurazione dello schermo. 

 
 

Link 
 

• Xfce Docs: Visualizza 
 
 
 

3.3.5 Gestione della potenza 
 

Clicca sull'icona dei plugin di Power Manager nel Pannello. Qui puoi facilmente passare alla 
modalità Presentazione (Xfce), o andare alle Impostazioni per impostare quando un display si 
spegne, quando il computer va in sospensione, l'azione iniziata chiudendo il coperchio di un 
portatile, la luminosità, ecc. Su un computer portatile, lo stato della batteria e le informazioni 
sono visualizzate e un cursore di luminosità è disponibile. 

 

3.3.6 Regolazione del monitor 
Ci sono diversi strumenti disponibili per regolare la visualizzazione per particolari monitor. 

• La luminosità dello schermo può essere impostata con il menu Start > Impostazioni > 
Power Manager, scheda Display o con MX Tweak. C'è un nuovo strumento MX 
chiamato "Brightness systray" (3. che metterà un comodo widget nella systray. 

• Per gli utenti con Nvidia, usate nvidia-settings come root per la regolazione fine del display. 

• Per cambiare la gamma (contrasto), aprite un terminale ed entrate: 

xgamma -gamma 1.0 

https://forum.xfce.org/
https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff
https://docs.xfce.org/xfce/xfce4-settings/4.14/display
https://en.wikipedia.org/wiki/Gamma_correction


1.0 è il livello normale; cambialo in alto o in basso per diminuire/aumentare il contrasto. 

• Il colore dell'adattamento del display all'ora del giorno può essere controllato con 
fluxgui o Redshift. 

• Per una regolazione più avanzata e la creazione di profili, installate DisplayCAL. 

• I profili di colore possono essere creati: Start > Impostazioni > Profili di colore. Un 
profilo di colore è un insieme di dati che caratterizza un dispositivo di input o output di 
colore, e la maggior parte sono derivati dai profili ICC. 

 

 
Figura 3-32: Prepararsi ad aggiungere un profilo di colore 

AIUTO: qui. 
 

3.3.7 Strappo dello schermo 
Lo screen tearing è un artefatto visivo nella visualizzazione video in cui un dispositivo di 
visualizzazione mostra informazioni da più fotogrammi in un singolo disegno dello schermo 
(Wikipedia). Tende a variare notevolmente a seconda di fattori che includono l'hardware 
grafico, la particolare applicazione e la sensibilità dell'utente. Questo problema è stato 
notevolmente alleviato con il rilascio di Xfce 4.14 e successive versioni predefinite. 

In MX Linux, sono disponibili diverse soluzioni: 

• Fai clic sulla scheda Compositor in MX Tweak e usa il menu a tendina per passare da 
xfwm di default a Compton, un compositore indipendente. 

• Usa il menu a tendina per modificare la spaziatura verticale (vblank). 

• Quando viene rilevato un driver grafico Intel, una casella di controllo diventa disponibile 
nella scheda MX Tweak > Config Options che allontana il sistema dal "modesetting" 
predefinito, un interruttore che abilita l'opzione TearFree del driver Intel. Le opzioni 
Tearfree esistono anche per nouveau, radeon e amdgpu, e sono visualizzate come 
appropriate. 

Link 

• Wiki MX/antiX 

https://justgetflux.com/linux.html
http://jonls.dk/redshift/
https://displaycal.net/
https://en.wikipedia.org/wiki/ICC_profile
https://en.wikipedia.org/wiki/ICC_profile
https://docs.xfce.org/xfce/xfce4-settings/4.16/display
https://docs.xfce.org/xfce/xfwm4/start
https://en.wikipedia.org/wiki/Compositing
https://mxlinux.org/wiki/hardware/screen-tearing


3.4 Rete 

Le connessioni Internet sono gestite da Network Manager: 
 

--Cliccate con il tasto sinistro del mouse sull'applet nell'area di notifica per vedere lo stato, la connessione e le 
opzioni di esplorazione. 

 
--Fare clic con il tasto destro del mouse sull'applet > Modifica connessioni per aprire una finestra di 
impostazioni con cinque schede. 

 
• Cablato. Nella maggior parte delle situazioni questo non richiede attenzione; 

evidenzia e clicca sul pulsante Modifica per configurazioni speciali. 
 

• Wireless 
 

• Network Manager di solito rileva automaticamente la tua scheda di rete e la 
usa per trovare i punti di accesso disponibili. In alcune situazioni, lo 
strumento a riga di comando Ceni nei repo può essere utile. 

 
• Per i dettagli, vedere la sezione 3.4.2 qui sotto. 

 
• Banda larga mobile. Questa scheda consente di utilizzare un dispositivo mobile 3G/4G 

per l'accesso al web. Clicca sul pulsante Aggiungi per configurare. 
 

• VPN. Fai clic sul pulsante Add per configurare. Se hai problemi di configurazione, 
consulta il Wiki di MX/antiX. 

 
• DSL. Clicca il pulsante Add per impostare. 

 

 
Figura 3-33: Schermata principale di Network Manager 

 
OLTRE: Wiki di Ubuntu: Gestore della rete 

https://mxlinux.org/wiki/networking/vpn
https://mxlinux.org/wiki/networking/vpn
https://help.ubuntu.com/community/NetworkManager


3.4.1 Accesso via cavo 
 

MX Linux di solito prende l'accesso a internet via cavo all'avvio senza molti problemi. Se è 
richiesto un driver Broadcom (raro), allora usate MX Network Assistant (Sezione 3.2) 

 
Ethernet e cavo 

 
MX Linux è preconfigurato per una LAN (Local Area Network) standard che usa DHCP 
(Dynamic Host Configuration Protocol) per assegnare indirizzi IP e risoluzione DNS (Domain 
Name System). Questo funzionerà nella maggior parte dei casi così com'è. Puoi cambiare la 
configurazione con Network Manager. 

 
Quando avvii MX Linux, ai tuoi adattatori di rete viene assegnato un breve nome di interfaccia 
da udev, il gestore di dispositivi del kernel. Per i normali adattatori cablati questo è di solito eth0 
(con gli adattatori successivi eth1, eth2, eth3, ecc). Gli adattatori USB spesso si presentano 
sull'interfaccia eth0 in MX Linux, ma il nome dell'interfaccia può anche dipendere dal chipset 
dell'adattatore. Per esempio, le schede atheros spesso si presentano come ath0, mentre gli 
adattatori usb ralink possono essere rausb0. Per una lista più dettagliata di tutte le interfacce di 
rete trovate, aprite un terminale, diventate root, e digitate: ifconfig -a. 

 
È saggio connettersi a Internet attraverso un router, poiché quasi tutti i router cablati 
contengono firewall opzionali. Inoltre, i router usano NAT (Network Address Translation) per 
tradurre da indirizzi Internet grandi a indirizzi IP locali. Questo offre un altro livello di 
protezione. Collegati al router direttamente, o attraverso un hub o uno switch, e la tua macchina 
dovrebbe autoconfigurarsi tramite DHCP. 

 
ADSL o PPPoE 

 
Se usate ADSL o PPPoE, connettersi a internet è facile in MX Linux. Clicca con il tasto destro 
del mouse sull'icona Network Manager, poi sulla scheda DSL. Fai clic sul pulsante Aggiungi... 
e compila le informazioni richieste, controllando la connessione automatica se vuoi. 

 
NOTA: se si incontrano problemi quando si usa un dispositivo USB per la connessione, 
collegare l'unità al computer, aprire un terminale e digitare: 

dmesg | tail 

Posta l'output sul forum con per ottenere un aiuto nel trovare il driver di cui hai bisogno. 



 
 

Figura 3-34: Impostazione del servizio DSL 
 

Dial-Up 
 

Nella scheda Dispositivo è necessario impostare le informazioni seriali. Accettando l'impostazione predefinita 
/dev/modem può funzionare, ma potrebbe essere necessario provare un'altra interfaccia. Questi 
sono gli equivalenti Linux delle porte COM sotto MS-DOS e MS-Windows: 

 
Tabella 3: equivalenti Linux per le porte COM 

 

Porto Equivalente 
COM 1 /dev/ttyS0 
COM 2 /dev/ttyS1 
COM 3 /dev/ttyS2 
COM 4 /dev/ttyS3 

3.4.2 Accesso wireless 
 

MX Linux è preconfigurato per rilevare automaticamente una scheda WiFi, e nella maggior 
parte dei casi la vostra scheda sarà trovata e impostata automaticamente. Ci sono due modi 
standard in cui il wireless può essere supportato in MX Linux: 

 
• Con un driver nativo. Questo di solito viene fornito come parte del kernel Linux 

(esempio: ipw3945 per Intel), ma su alcune, specialmente le macchine più recenti, 
potrebbe essere necessario scaricare un driver usando le informazioni in Quick System 
Info > Network. 

 
• Con un driver Windows usando l'applicazione Ndiswrapper (disponibile nei repo), che 

"avvolge" il tuo driver Windows in modo che possa essere usato in un sistema Linux 
(esempio: bcmwl5 per alcuni chipset Broadcom). Vedi sotto per saperne di più. 

 
A volte sono disponibili sia un driver nativo per Linux che un driver per Windows. Potresti 
volerli confrontare per la velocità e la connettività, e potresti dover mettere in lista nera o 
rimuovere quello che non stai usando per evitare un conflitto. Le schede wireless possono 
essere interne o esterne. I modem USB (dongle wireless) di solito appaiono sull'interfaccia 



wlan, ma se non è così, controllate gli altri nella lista. NOTA: Il metodo di successo varia per 
gli utenti a causa del complicato 



interazioni tra il kernel Linux, gli strumenti wireless e il chipset della scheda wireless locale e il 
router. 

 
Passi senza fili di base 

 
Clicca sul menu Start > Impostazioni > Connessioni di rete (o semplicemente clicca 
sull'icona Network Manager nell'area di notifica), e poi sulla scheda Wireless. Si presenterà 
una di 3 situazioni. 

 
-È stata trovata una rete wireless. 

 
• Clicca sul nome della rete per utilizzarla. 

 
• Cliccate con il tasto destro del mouse sull'icona per accedere a ulteriori opzioni. 

 
• Al termine, fare clic su OK. 

 
-La rete trovata non funziona. 

 
Se le reti wireless vengono viste ma il vostro computer non riesce a connettersi, questo significa 
che 1) la scheda wireless è gestita correttamente dal giusto driver ma avete problemi relativi alla 
connessione al vostro modem/router, al firewall, al provider, al DNS, ecc; oppure 2) la scheda 
wireless è gestita in modo anomalo perché il driver non è il più appropriato per quella scheda o 
ci sono problemi di conflitto con un altro driver. In questo caso dovresti raccogliere 
informazioni sulla tua scheda wireless per vedere se i driver della scheda possono avere 
problemi e poi provare a testare la rete con un set di strumenti diagnostici. 

 
• Scoprite le informazioni di base aprendo un terminale e inserendone una alla volta: 

 
inxi -n 

 
lsusb | grep -i 

net lspci | grep -i 

net E come root: 

iwconfig 
 

L'output di questi comandi vi darà il nome, il modello e la versione (se presente) della vostra 
scheda wireless (esempio sotto), così come il driver associato e l'indirizzo mac della scheda 
wireless. L'output del quarto ti darà il nome del punto di accesso (AP) a cui sei collegato e altre 
informazioni sulla connessione. Per esempio: 

Rete 
Scheda-2:Qualcomm Atheros AR9462 Wireless Network Adapter driver: 
ath9k IF: wlan0 state: up mac: 00:21:6a:81:8c:5a 



A volte è necessario il numero mac del chipset oltre a quello della scheda wireless. Il modo più 
semplice per farlo è cliccare sul menu Start > Sistema > MX Network Assistant, scheda 
Introduzione. Per esempio: 

Adattatore di rete wireless Qualcomm Atheros AR9485 [168c:0032](rev 01) 

Il numero tra parentesi identifica il tipo di chipset della vostra scheda wireless. I numeri prima 
dei due punti identificano il produttore, quelli dopo il prodotto. 

 
Usa le informazioni che hai raccolto in uno dei seguenti modi: 

 
• Fate una ricerca sul web usando queste informazioni. Alcuni esempi utilizzando l'output lspci di cui 

sopra. 

linux Qualcomm Atheros AR9462 
linux 168c:0032 
debian stabile 0x168c 0x0034 

• Consultate i siti Linux Wireless e Linux Wireless LAN Support qui sotto per 
scoprire di quali driver ha bisogno il vostro chipset, quali conflitti 
potrebbero esistere, e se ha bisogno di un firmware installato separatamente. 
Pubblica le tue informazioni sul forum e chiedi aiuto. 

 
• Spegnere il firewall, se presente, fino a quando non si verifica il 

collegamento tra il computer e il router. 
 

• Prova a riavviare il router. 
 

• Usate la sezione di diagnostica in MX Network Assistant per fare il ping al 
vostro router usando l'indirizzo mac, il ping a qualsiasi sito web come Google 
o eseguire il traceroute. Se puoi fare il ping a un sito usando il suo IP (ottenuto 
da una ricerca sul web) ma non puoi raggiungerlo con il suo nome di dominio, 
allora il problema potrebbe essere nella configurazione del DNS. Se non 
sapete interpretare i risultati di ping e traceroute fate una ricerca sul web o 
postate i risultati sul forum. 

 
• A volte l'uso dell'applicazione terminale Ceni (nei repo) può rivelare punti di 

accesso nascosti e altri fattori difficili. NOTA: usare Ceni per configurare la 
vostra interfaccia di rete in MX Linux interferirà e/o disabiliterà la gestione di 
quell'interfaccia da parte del Network Manager di default. Ceni memorizza le 
sue informazioni di configurazione in /etc/network/interfaces. Qualsiasi 
interfaccia definita in /etc/network/interfaces sarà ignorata da Network 
Manager, in quanto Network Manager assume che se esiste una definizione, si 
vuole che qualche altra applicazione gestisca il dispositivo. 

 
-Nessuna interfaccia wireless è stata trovata. 

 
• Aprite un terminale e digitate i 4 comandi elencati all'inizio della sezione 

precedente. Identificate la scheda, il chipset e il driver di cui avete bisogno 

https://en.wikipedia.org/wiki/Traceroute


facendo una ricerca sul web e consultando i siti segnalati, secondo la procedura 
descritta sopra. 



• Cercate la voce di rete, e annotate le informazioni dettagliate sul vostro 
hardware specifico, e cercate maggiori informazioni su questo dal sito 
LinuxWireless elencato qui sotto, o chiedete sul Forum. 

 
• Se avete un dispositivo wifi esterno e non viene trovata nessuna 

informazione su una scheda di rete, scollegate il dispositivo, aspettate 
qualche secondo poi ricollegatelo. Aprite un terminale ed entrate: 

 
dmesg | tail 

 
Esaminate l'output per le informazioni sul dispositivo (come il mac address) 
che potete usare per perseguire il vostro problema sul web o sul forum. 

 
• Probabilmente l'esempio più comune di questa situazione che si verifica è con il 

Chipset wireless Broadcom; vedi MX/antiX Wiki. 
 

Firmware 
 

Per alcune schede è necessario installare un firmware (per esempio, firmware-ti-connectivity 
per Texas Instruments WL1251). MX Linux viene fornito con una buona quantità di firmware 
già disponibili, installati o nei repo, ma potreste dover rintracciare il vostro particolare bisogno, 
sempre usando il sito web LinuxWireless collegato qui sotto o controllando il Forum. 

 
Ndiswrapper 

 
Ndiswrapper è un driver software open-source "wrapper" che permette l'uso di driver Windows 
per dispositivi di rete wireless in Linux. Non è preinstallato in MX Linux, ma si trova nei repo. 
NOTA: il driver Windows che usi deve corrispondere all'architettura del sistema operativo (ad 
esempio, driver Windows 32-bit per MX Linux 32-bit edition). In generale, i driver di Windows 
XP sono richiesti. 

 
Il metodo più semplice per gestire Ndiswrapper è usare MX Network Assistant (Sezione 3.2). 
Vedere anche la discussione estesa nella Wiki di MX/antiX. 

 
Sicurezza 

 
La sicurezza wireless è gestita da Network Manager. Ecco i passi fondamentali da seguire: 

 
• Fare clic con il tasto destro del mouse sull'icona Network Manager nell'area di notifica > Modifica 

connessioni 
 

• Fare clic sulla scheda Wireless, ed evidenziare il nome del punto di accesso che 
si desidera collegare (ad esempio, "linksys" o "starbucks 2345") 

 
• Fare clic sul pulsante Modifica e poi sulla scheda Sicurezza wireless 

 
• Usa il menu a tendina per selezionare la sicurezza che vuoi (per esempio: WPA e 

https://mxlinux.org/wiki/hardware-networking/broadcom-wireless
http://en.wikipedia.org/wiki/NDISwrapper
https://mxlinux.org/wiki/applications-networking/ndiswrapper
https://mxlinux.org/wiki/applications-networking/ndiswrapper
https://mxlinux.org/wiki/applications-networking/ndiswrapper


WPA2 Personal) 



• Inserisci la password e clicca su Salva. 
 

 
Figura 3-35: Sicurezza wireless in Network Manager (sinistra: Xfce, destra: KDE/plasma) 

 
È ugualmente possibile utilizzare Ceni per gestire la sicurezza wireless, a patto che 
successivamente non si usi Network Manager, con il quale interferisce. 

 
Link 

 
• Linux senza fili 

 
• Supporto LAN senza fili per Linux 

 
• Debian Wiki: Wifi 

 
• Arch Wiki: Wireless 

 

3.4.3 Banda larga mobile 
 

Per l'accesso wireless a internet usando un modem 3G/4G, si faccia riferimento alle pagine 3G 
di Debian Wiki collegate qui sotto per informazioni sulla compatibilità. Molti modem 3G/4G 
saranno riconosciuti su MX Linux da Network Manager. 

 

3.4.4 Tethering 
Il tethering si riferisce all'uso di un dispositivo come un telefono cellulare o un hotspot wifi 
mobile per fornire un accesso internet mobile ad altri dispositivi, come un computer portatile. 
Un "hotspot" deve essere creato sul dispositivo con accesso per l'altro dispositivo da utilizzare. 
È facile impostare un telefono Android come hotspot, anche se le indicazioni variano in parte a 
seconda della versione di Android. In Android 9: Impostazioni 
> Connessioni > Hotspot mobile e Tethering > Hotspot mobile. Per rendere il portatile 
l'hotspot, consulta questo video. 

https://wireless.wiki.kernel.org/
http://linux-wless.passys.nl/
http://wiki.debian.org/WiFi
https://wiki.archlinux.org/index.php/Wireless
https://www.youtube.com/watch?v=WeKcWTQc7mY&feature=youtu.be


Risoluzione dei problemi 
 

Su alcuni sistemi, le connessioni via modem falliscono a causa di un aggiornamento dei 
pacchetti udev e libudev1. Per risolvere questo problema, aprite Synaptic, evidenziate i 
pacchetti e poi cliccate su Package> Force version... Usate il menu a tendina per passare a una 
versione inferiore e cliccate sull'icona Apply. 

 
In alcuni casi questa soluzione non ha funzionato in modo coerente per gli utenti, ma hanno 
trovato che la rimozione completa di Network Manager ha risolto i problemi. 

 
OLTRE: Debian Wiki: modem 3G 

 

3.4.5 Utilità della linea di comando 
 

Le utilità a riga di comando sono utili per vedere informazioni dettagliate e sono anche 
comunemente usate nella risoluzione dei problemi. Una documentazione dettagliata è disponibile 
nelle pagine man. Le più comuni qui sotto devono essere eseguite come root. 

 
Tabella 4: Utilità senza fili 

 

Comando Commento 
ifconfig Utilità di configurazione principale per le interfacce di rete. 

ifup <interfaccia> Porta in primo piano l'interfaccia specificata. Per esempio: 
ifup eth0 farà apparire la porta ethernet eth0 

sedown 
<interfaccia> 

Il contrario di ifup 

iwconfig Utilità per la connessione alla rete wireless. Usato da solo, visualizza 
lo stato del wireless. Può essere applicato a un'interfaccia specifica, 

ad esempio per selezionare un particolare punto di accesso 
rfkill Disabilita il softblock per le interfacce di rete wireless (ad 

esempio, wlan). 
depmod -a Verifica tutti i moduli e, se sono cambiati, abilita la nuova 

configurazione. 

 3.4.5DNS  statico 
 

A volte è auspicabile cambiare la vostra configurazione internet dal DNS automatico di default 
(Dynamic Name Service) ad uno statico manuale. Le ragioni per farlo possono includere una 
maggiore stabilità, una migliore velocità, il controllo dei genitori, ecc. Si può fare un tale 
cambiamento sia per l'intero sistema che per i singoli dispositivi. In entrambi i casi, prendete le 
impostazioni DNS statiche che userete da OpenDNS, Google Public DNS, ecc. 

 
Sistema 

 
Puoi fare il cambiamento per tutti quelli che usano il tuo router usando un browser. Avrete bisogno di: 

 
• l'URL del router (elencare qui se si è dimenticato) 

 
• la sua password, se ne hai impostata una 

http://wiki.debian.org/Modem/3G
https://en.wikipedia.org/wiki/Domain_Name_System
http://www.techspot.com/guides/287-default-router-ip-addresses/


Trova e cambia il pannello di configurazione del tuo router, seguendo le indicazioni per il tuo 
particolare router (lista di guide qui). 

 
Individuale 

 
Per la modifica di un singolo utente, potete usare Network Manager. 

 
• Clicca con il tasto destro del mouse sull'icona della connessione nell'Area di notifica > Modifica 

connessioni... 
 

• Evidenzia la tua connessione e clicca sul pulsante Modifica. 
 

• Nella scheda IPv4, usare il menu a tendina per cambiare il Metodo in "Solo 
indirizzi automatici (DHCP)". 

 
• Nella casella "DNS Servers" inserite le impostazioni DNS statiche che intendete utilizzare. 

 
• Fare clic su Salva per uscire. 

 
3.5 Gestione dei file 

La gestione dei file in MX Linux viene effettuata attraverso Thunar su Xfce e dolphin su 
KDE/plasma. Molto del loro uso di base è evidente, ma qui ci sono buone cose da sapere: 

 
• I file nascosti non sono visibili per impostazione predefinita, ma possono essere resi 

visibili tramite il menu (View > Show Hidden Files); o premendo Ctrl-H 
 

• Il riquadro laterale può essere nascosto e i collegamenti alle directory (cartelle) 
possono essere posizionati lì cliccando con il tasto destro del mouse > Invia a o 
trascinando 

 
• Il menu contestuale è stato popolato con procedure comuni ("Azioni personalizzate" 

su Xfce e "Azioni" e "Azioni radice" su KDE/plasma) che variano in base a ciò che è 
presente o sotto focus. 

 
• L'azione di root è disponibile tramite il menu contestuale per aprire un terminale, 

modificare come root o aprire un'istanza di File Manager con privilegi di root. 
 

• I File Manager gestiscono facilmente i trasferimenti FTP, vedi sotto. 
 

• Le azioni personalizzate aumentano notevolmente la potenza e l'utilità dei File 
Manager. MX Linux viene fornito con molte pre-installate, ma ce ne sono altre 
disponibili da copiare e l'individuo può crearle per esigenze individuali. Vedere 
Suggerimenti e trucchi (Sezione 3.5.1), sotto; e la Wiki di MX/antiX. 

https://support.opendns.com/forums/21618374
http://docs.xfce.org/xfce/thunar/custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions


  
 

Figura 3-36: Sinistra: azioni personalizzate impostate in Thunar Destra: Servizi personalizzati in Dolphin 
 

3.5.1 Suggerimenti e trucchi 
 

• Quando si lavora in una directory che richiede i privilegi di superutente, si può cliccare 
con il tasto destro del mouse > Open root Thunar here (o File > Open root Thunar here) 
o la simile "Root Action" in dolphin. 

 
• Il privilegio di superutente può essere cambiato in MX Tweak > Other tab usando la 

password dell'utente (default) o una password amministrativa, se ne è stata impostata una. 
 

• Puoi impostare le schede con File > New Tab (o Ctrl-T), poi spostare gli elementi da 
una posizione all'altra trascinandoli in una scheda e rilasciandoli. 

 
• È possibile assegnare un tasto di scelta rapida della tastiera all'azione personalizzata 

"Aprire il terminale qui". 
 

--Thunar/Xfce 
 

• Abilita gli acceleratori modificabili in Tutte le impostazioni > Aspetto > Impostazioni. 
 

• In Thunar, passate il mouse sulla voce di menu File > Open in Terminal e 
premete la combinazione di tasti che vorreste usare per quell'azione. 

 
• Poi, quando navighi in Thunar, usa la combinazione di tasti per aprire 

una finestra di terminale nella tua directory attiva. 
 

• Questo vale anche per altre voci del menu File di Thunar; per esempio, 
si potrebbe assegnare Alt-S per creare un collegamento simbolico per 
un file evidenziato, ecc. 



• Le azioni elencate nel menu contestuale possono essere 
modificate/cancellate, e se ne possono aggiungere di nuove, cliccando 
su Modifica > Configura azioni personalizzate... 

 
• dolphin/KDE-plasma: seleziona Impostazioni > Configura scorciatoie da 

tastiera e trova la voce Terminale. 
 

• Varie opzioni e comandi nascosti sono anche visibili, vedi Link qui sotto. 
 

• Sia Java che Python sono talvolta utilizzati per produrre applicazioni, portando il finale 
*.jar e *.py, rispettivamente. Questi file possono essere aperti con un solo clic, come 
qualsiasi altro file; non è più necessario aprire un terminale, capire qual è il comando, 
ecc. ATTENZIONE: fate attenzione ai potenziali problemi di sicurezza. 

 
• I file compressi (zip, tar, gz, xz, ecc...) possono essere gestiti con un clic destro sul file. 

 
• Per trovare i file: 

 
--Thunar/Xfce: apri Thunar e fai clic con il tasto destro su qualsiasi cartella > 
Trova file qui. Una finestra di dialogo apparirà per darti delle opzioni. In 
esecuzione in background c'è Catfish (menu Start > Accessori > Catfish). 

 
--dolphin/KDE-plasma: Usa Modifica > Cerca nella barra degli strumenti di Dolphin. 

 
• Collegamenti/symlink 

 
--Thunar/Xfce: Per impostare un soft link (AKA symlink)--un file che punta a un 
altro file o directory--clicca con il tasto destro del mouse sulla destinazione (file 
o cartella a cui vuoi che il link punti) 
> Create symlink. Poi cliccate con il tasto destro del mouse sul nuovo link 
simbolico, tagliatelo e incollatelo dove volete. 

 
--dolphin/KDE-plasma: Fai clic destro su un punto vuoto nella finestra di 
Dolphin e usa Create New > Basic link to file or directory 

 
• Azioni personalizzate Thunar. Questo è un potente strumento per espandere le funzioni 

del file manager. Per vedere quelle che sono predefinite durante lo sviluppo di MX 
Linux, clicca su Edit > Configure Custom Actions. La finestra di dialogo che si apre vi 
mostrerà ciò che è predefinito e vi darà un'idea di ciò che potete fare voi stessi. Per 
creare una nuova azione personalizzata, clicca sul pulsante "+" sulla destra. Dettagli nel 
wiki di MX/antiX. 

 
• Le cartelle possono essere visualizzate con immagini mettendo un'immagine che finisce 

in *.jpg o *.png nella cartella e rinominandola "cartella". 

https://mxlinux.org/wiki/applications/thunar-custom-actions


 
 

Figura 3-37: usare le immagini per etichettare le cartelle 
 

 3.5.2FTP 
 
 
 

 
 
 

Figura 3-38: Usare Thunar per accedere a un sito FTP 
 

Il File Sharing Protocol (FTP) è usato per trasferire file da un host a un altro host su una rete. 
 

Xfce 
 

• Aprite File Manager e cliccate su Browse Network in fondo al pannello di sinistra. 
Poi clicca sulla barra degli indirizzi nella parte superiore del browser (o usa Cntrl+L) 
e fai backspace per 

 
• Backspace nel campo dell'indirizzo per cancellare quello che c'è (network:///), poi 

digitate il nome del server con il prefisso ftp://. Per esempio, per raggiungere la 
documentazione MX (se avete il permesso) dovreste inserire questo indirizzo: 
ftp://mxlinux.org 



• Si apre una finestra di dialogo di autorizzazione. Inserisci nome utente e password, 
e lascia che salvi la password se ti va bene. 

 
• Questo è tutto. Una volta che hai navigato fino alla cartella che userai sempre, puoi 

cliccare con il tasto destro del mouse sulla cartella e in Thunar > Send to > Side Pane 
o in dolphin > Add to Places per creare un modo molto semplice di connettersi. 

 
KDE 

 
• Consultate la base utenti di KDE. 

 
Si possono anche usare applicazioni FTP dedicate come Filezilla. Per una discussione su come 
funziona l'FTP, vedi questa pagina. 

 

3.5.3 Condivisione di file 
 

Ci sono varie possibilità per condividere file tra computer o tra un computer e un dispositivo 
 

• Samba. SAMBA è la soluzione più completa per condividere file con le macchine 
Windows in rete senza apportare modifiche alle macchine Windows. SAMBA può 
anche essere usato da molti lettori multimediali di rete e dispositivi NAS (Network-
attached storage). SAMBA offre alcuni altri servizi per interfacciarsi con le reti 
Windows, come l'autenticazione del dominio, i servizi di messaggistica e la 
risoluzione dei nomi netbios. Per i dettagli, vedi sotto. 

 
• NFS. Questo è il protocollo Unix standard per la condivisione dei file. Molti 

ritengono che sia migliore di Samba per la condivisione di file, e può essere usato 
con macchine Windows (2000 & XP) se si installa "Services for Unix" o un client 
NFS di terze parti. Dettagli: vedi MX/antiX Wiki. 

 
• Bluetooth: Per lo scambio di file, installare blueman dai repo, riavviare, 

accoppiare con il dispositivo, quindi fare clic con il tasto destro sull'icona 
bluetooth nell'area di notifica > Invia file al dispositivo. 

https://userbase.kde.org/File_transfers
http://www.ncftp.com/libncftp/doc/ftp_overview.html
https://mxlinux.org/wiki/networking/nfs


3.5.4 Azioni (Samba) 
 

 
Figura 3-39: Condivisioni della rete di brunitura A sinistra: Thunar, a destra: Dolphin 

 
I File Manager possono connettersi a cartelle condivise (AKA Samba Shares) su computer 
Windows, Mac, Linux e dispositivi NAS (Network Attached Storage). Per la stampa con 
Samba, vedi la sezione 3.1.2. 

 
• Clicca su Browse Network nel pannello di sinistra per mostrare varie reti, tra 

cui Windows Network 
 

• Clicca sulla rete che vuoi vedere i gruppi di lavoro disponibili (spesso 
chiamati WORKGROUP di default). Ora fai un drill down per trovare quello 
che stai cercando. 

 
• Selezionare un gruppo di lavoro per i server Samba disponibili 

 
• Selezionare un server per le condivisioni Samba disponibili 

 
• Selezionare una condivisione Samba per vedere tutte le cartelle disponibili 

 
• Una scorciatoia per la condivisione selezionata sarà creata nella sezione della barra laterale della rete 

 
• A volte la navigazione non funziona, specialmente in ambienti misti (per esempio, 

Linux- Windows). Puoi accedere direttamente a una condivisione remota usando la 
barra di localizzazione di File Manager (Ctrl+L) e usando 
smb://servername/sharename. Questi luoghi possono essere inseriti come segnalibri 
nei riquadri laterali. 

 

3.5.5 Creazione di azioni 
 

Su MX, Samba può anche essere usato per creare condivisioni per altri computer (Windows, 
Mac, Linux) a cui accedere. La creazione di Condivisioni pubbliche è abbastanza semplice, ma 
tenete presente che la creazione di Condivisioni Samba è un'area complessa dal punto di vista 



della configurazione. Per esempio, il compito di creare delle condivisioni che siano specifiche 
per i singoli utenti e che siano autenticate correttamente va oltre lo scopo di questo manuale. 
Guide di riferimento complete possono essere trovate su Using Samba e Samba.org. 



Metodo di base 
 

Gli utenti di Thunar e KDE/plasma dolphin possono anche usare la scheda "share" nel dialogo 
delle proprietà della cartella per impostare una condivisione samba. 

 
NOTA: gli utenti trovano spesso che lo strumento di configurazione deve essere aumentato con 
il metodo manuale, sotto. 

 
Metodo manuale 

 

 Creare una condivisione manualmente 
 

Se per qualche ragione hai bisogno o vuoi creare manualmente delle condivisioni, segui questi passi. 
 

• Nella tua Home, usa una cartella esistente o creane una nuova e fai clic con il tasto 
destro del mouse per renderla in lettura e scrittura per Proprietario, Gruppo: utenti e 
Altri. In altre parole, rendila aperta al mondo. Iniziare con una semplice condivisione 
pubblica è un buon punto di partenza. NOTA: Se sei preoccupato per la sicurezza 
della rete non usare questo approccio. Invece, studiate i riferimenti di cui sopra per 
imparare a creare condivisioni sicure. 

 
• Per stabilire la condivisione Samba, dovete modificare il file di configurazione 

come root. Può essere trovato a: /etc/samba/smb.conf Modificate la linea: 
workgroup = xxxxx in modo che corrisponda al nome del gruppo di lavoro di 
Windows che state usando (quello predefinito è WORKGROUP) 

 
• Alla fine del file aggiungi le seguenti righe per stabilire la tua Share 

[SHARENAME] 
percorso = 
/home/username/foldername guest 
ok = sì 
solo lettura = 
no sfogliabile = 
sì 
forza creare modalità = 
777 forza modalità 
directory = 777 

• Salvare il file. Quando si aggiunge una condivisione, il demone Samba dovrebbe 
leggerla e implementare i cambiamenti immediatamente. Se si apportano modifiche 
ad una condivisione esistente, sarà necessario riavviare Samba per assicurarsi che le 
modifiche abbiano effetto andando nel terminale, diventando root e digitando: 
service samba restart 

 
• Potete anche controllare se ci sono errori in smb.conf eseguendo testparm dal terminale 

 
• Vai su un altro computer e prova la tua capacità di vedere la tua condivisione Samba 

navigando nella rete e testando la lettura e la scrittura sulla condivisione 

https://www.youtube.com/watch?v=l3KYukPvP7U


 
OLTRE: Xfce Docs: Thunar 

http://docs.xfce.org/xfce/thunar/start


3.6 Suono 

 Come abilitare l'audio HDMI con Linux 
 

Il suono di MX Linux dipende a livello di kernel da Advanced Linux Sound Architecture 
(ALSA), e a livello utente da PulseAudio. Nella maggior parte dei casi il suono funzionerà 
immediatamente, anche se potrebbe aver bisogno di qualche piccola regolazione. Clicca 
sull'icona dell'altoparlante per disattivare tutto l'audio, poi di nuovo per ripristinarlo - se è così 
che sono impostate le Preferenze. Posiziona il cursore sull'icona dell'altoparlante nell'area di 
notifica e usa la rotellina per regolare il volume. Vedi anche le sezioni 3.6.4, 3.6.5 e 3.8.9. 

 

3.6.1 Configurazione della scheda audio 
 

Se avete più di una scheda audio, assicuratevi di selezionare quella che volete regolare 
usando lo strumento MX Select Sound (sezione 3.2). La scheda audio viene configurata e il 
volume delle tracce selezionate viene regolato cliccando con il tasto destro sull'icona 
dell'altoparlante nell'area di notifica > Open Mixer. Se i problemi persistono dopo aver 
effettuato il logout e il login, vedi Risoluzione dei problemi, sotto. 

 

3.6.2 Uso simultaneo della carta 
 

Ci possono essere momenti in cui vorresti usare più di una scheda simultaneamente; per 
esempio, potresti voler sentire la musica sia attraverso le cuffie che attraverso gli altoparlanti 
in un altro luogo. Questo non è facile da fare in Linux, ma controlla le FAQ di PulseAudio. 
Inoltre, le soluzioni su questa pagina Wiki MX/antiX possono funzionare, se stai attento ad 
adattare i riferimenti delle schede alla tua situazione. 

 
A volte è necessario cambiare scheda audio, per esempio quando una è HDMI e l'altra 
analogica. Questo può essere fatto in PulseAudio, scheda Configuration; assicurati di 
selezionare l'opzione Profile che funziona per il tuo sistema. Per rendere questo cambio 
automatico, vedi lo script su questo sito GitHub. 

 

3.6.3 Risoluzione dei problemi 
 

• Il suono non funziona 
 

• Nessun suono, anche se l'icona dell'altoparlante è 
nell'area di notifica. 

 
• Prova ad alzare tutti i controlli ad un livello più alto. Per un suono di sistema 

come un login, usa la scheda Playback in Pulseaudio. 
 

• Modificare direttamente il file di configurazione: 
vedere la sezione 7.4. 

https://youtu.be/gjqcmZK5SnE
http://www.freedesktop.org/wiki/Software/PulseAudio/
http://www.freedesktop.org/wiki/Software/PulseAudio/FAQ/
https://mxlinux.org/wiki/sound-not-working
https://gist.github.com/3v1n0/ad3ad73e0bdd466d7f4a95b3aa376285
https://gist.github.com/3v1n0/ad3ad73e0bdd466d7f4a95b3aa376285
https://mxlinux.org/wiki/sound-not-working


• Nessun suono e nessuna icona dell'altoparlante nell'area di notifica. Potrebbe essere 
che la scheda audio sia mancante o non riconosciuta, ma il problema più comune è 
quello delle schede audio multiple, che affrontiamo qui. 

 
• Soluzione 1: clicca sul menu Start > Impostazioni > MX Sound Card, e 

segui lo schermo per selezionare e testare la scheda che vuoi usare. 
 

• Soluzione 2: utilizzare il controllo del volume di PulseAudio (pavucontrol) 
per selezionare la scheda audio corretta 

 
• Soluzione 3: entrare nel BIOS e disattivare l'HDMI 

 
• Controllate la matrice della scheda audio ALSA elencata qui sotto. 

 

3.6.4 Server audio 
 

Mentre la scheda audio è un elemento hardware accessibile all'utente, il Sound Server è un 
software che lavora in gran parte in background. Permette la gestione generale delle schede 
audio, e fornisce la possibilità di effettuare operazioni avanzate sul suono. Il più usato dai 
singoli utenti è PulseAudio. Questo avanzato server audio open-source può funzionare con 
diversi sistemi operativi, ed è installato di default. Ha un proprio mixer che permette all'utente 
di controllare il volume e la destinazione del segnale audio. Per l'uso professionale, Jack audio è 
forse il più noto. 

 
 

 
 

Figura 3-40: Utilizzo di PulseAudio Mixer Sinistra: Pavucontrol Destra: KDE Audio Volume 
 
 
 

3.6.5 Link 
 

• Wiki MX/antiX: Il suono non funziona 
 

• ALSA: matrice di schede audio 
 

• ArchLinux Wiki: Informazioni su PulseAudio 

http://jackaudio.org/
https://mxlinux.org/wiki/sound-not-working
https://wiki.archlinux.org/index.php/PulseAudio


• Documentazione su PulseAudio: Desktop gratuito 
 

3.7 Localizzazione 

MX Linux è mantenuto da un Dev Team internazionale che lavora costantemente per 
migliorare ed espandere le opzioni di localizzazione. Ci sono molte lingue in cui i nostri 
documenti non sono ancora stati tradotti, e se potete aiutare in questo sforzo per favore 
registratevi su Transifex e/o postate sul Forum di traduzione. 

 

3.7.1 Installazione 
 

L'atto primario di localizzazione avviene durante l'uso del LiveMedium. 
 

• Quando la schermata di avvio si presenta per la prima volta, assicuratevi di usare i 
tasti funzione per impostare le vostre preferenze. 

 
• F2. Selezionare la lingua 

 
• F3. Selezionare il fuso orario che si desidera utilizzare. 

 
• Se hai una configurazione complicata o alternativa, puoi usare i codici di 

avvio. Ecco un esempio per impostare una tastiera Tartar per il russo: 
lang=ru kbvar=tt . Una lista completa dei parametri di avvio (=cheat code) 
può essere trovata nella Wiki MX/antiX. 

 
• Se hai impostato i valori di localizzazione nella schermata di avvio, allora Screen 7 

dovrebbe mostrarli durante l'installazione. In caso contrario, o se vuoi cambiarli, 
seleziona la lingua e il fuso orario che vuoi. 

 
Altri due metodi sono disponibili dopo la schermata di avvio. 

 
• La prima schermata del programma di installazione permette all'utente di selezionare una particolare 

tastiera da usare. 
 

• La schermata di login ha dei menu a tendina nell'angolo in alto a destra dove si 
possono selezionare sia la tastiera che il locale. 

 

3.7.2 Post-installazione 
MX Tools include due strumenti per cambiare la tastiera e il locale. Vedere le sezioni 3.2.15 e 
3.2.16 sopra. 

Anche Xfce4 e KDE/plasma hanno i loro metodi: 

http://www.freedesktop.org/wiki/Software/PulseAudio/Documentation/User/
https://forum.mxlinux.org/viewtopic.php?f=96&t=38671
https://forum.mxlinux.org/viewforum.php?f=96
https://forum.mxlinux.org/viewforum.php?f=96
https://mxlinux.org/wiki/system/boot-parameters
https://mxlinux.org/wiki/system/boot-parameters


  
 

Figura 3-41: Aggiungere un altro layout di tastiera  Sinistra: XfceDestra:KDE 
 

Ecco i passi di configurazione che potete fare per localizzare il vostro MX Linux dopo l'installazione. 
 

• Cambiare la tastiera: 
 

Xfce 
 

• Clicca su Menu Start > Impostazioni > Tastiera, scheda Layout. 
 

• Deseleziona "Usa le impostazioni predefinite del sistema", poi clicca sul 
pulsante +Add in basso e seleziona la tastiera (o le tastiere) che vuoi avere a 
disposizione. 

 
• Esci, poi clicca su Keyboard Switcher (bandiera) nell'area di notifica per 

selezionare la tastiera attiva. 
 

KDE/plasma 

• Fare clic su Menu Start > Impostazioni > Dispositivi di input > Scheda Layout di tastiera 
 

• Selezionate "Configure Layouts" al centro della finestra di dialogo, poi cliccate su +Add 
in basso e seleziona la tastiera (o le tastiere) che vuoi avere a disposizione. 

 
• Esci, poi clicca su Keyboard Switcher (bandiera) nell'area di notifica per 

selezionare la tastiera attiva. 
 

• Ottieni i language pack per le principali applicazioni: clicca su Start menu > 
Sistema > MX Package Installer, fornisci la password di root, poi clicca su 
Language per trovare e installare i language pack per le applicazioni che usi. 

 
• Impostare il Pinyin semplificato cinese è un po' più complicato, vedi qui. 

 
• Cambia le impostazioni dell'ora: clicca su Start Menu > Sistema > MX Date & 

Time e seleziona le tue preferenze. Se stai usando l'orologio digitale DateTime, 
clicca con il tasto destro > Proprietà per scegliere 12h/24h e altre impostazioni locali. 

https://mxlinux.org/wiki/other/chinese-simplified-input


• Fai in modo che il correttore ortografico usi la tua lingua: installa il pacchetto aspell 
o myspell per la tua lingua (ad esempio, myspell-es). 

 
• Ottieni informazioni sul tempo locale 

 
• Xfce: fai clic con il tasto destro del mouse sul Pannello > Pannello > 

Aggiungi nuovi elementi > Aggiornamento meteo. Fai clic destro > 
Proprietà, e imposta il locale che vuoi vedere (indovinerà in base al tuo 
indirizzo IP). 

 
• KDE: Fai clic con il tasto destro del mouse sul desktop o sul pannello, a 

seconda di dove apparirà il widget, e poi Aggiungi widget. Cerca Meteo e 
aggiungi il widget 

 
• Per la localizzazione di Firefox, installa il pacchetto firefox-l10n- appropriato 

per la tua lingua di interesse; ad esempio, per lo spagnolo (Spagna), installa 
firefox-l10n-es. 

 
• Per Thunderbird, clicca su Modifica > Preferenze > Generale. Scorri fino alla 

sezione Lingua e aspetto e seleziona quella che vuoi usare 
 

• Potreste aver bisogno o voler cambiare le informazioni sulla localizzazione (lingua 
predefinita, ecc.) disponibili per il sistema. Per farlo, aprite un terminale, diventate 
root e digitate: dpkg-reconfigure locales 

 
• Vedrai una lista con tutte le località che puoi scorrere usando i tasti freccia su 

e giù. 
 

• Abilita e disabilita ciò che vuoi (o non vuoi), usando la barra spaziatrice per 
far apparire (o scomparire) l'asterisco davanti al locale. 

 
• Al termine, clicca su OK per passare alla schermata successiva. 

 
• Usa le frecce per selezionare la lingua predefinita che vuoi usare. Per gli 

utenti statunitensi, per esempio, sarebbe tipicamente en_US.UTF-8. 
 

• Fare clic su OK per salvare e uscire. 
 

OLTRE: Documentazione di Ubuntu 

https://help.ubuntu.com/community/Locale


 
 

Figura 3-42: Reimpostare la lingua predefinita per il sistema installato 
 
 
 

3.7.3 Altre note 
• È possibile cambiare temporaneamente la lingua di una particolare applicazione 

inserendo questo codice in un terminale (in questo esempio, per passare allo 
spagnolo): 

LC_ALL=es_ES.UTF8 <comando da lanciare>. 
 

Questo funzionerà per la maggior parte delle app che sono già localizzate. 

• Se avete selezionato la lingua sbagliata durante l'installazione, potete cambiarla una volta 
sul desktop installato, usando MX Locales per correggerla. Puoi anche aprire un 
terminale e inserire questo comando: 

sudo update-locale LANG=it_GB.utf8 
 

Ovviamente dovreste cambiare la lingua con quella che volete usare. 

• Può succedere che una singola applicazione non abbia una traduzione nella tua lingua; a 
meno che non si tratti di un'applicazione MX, non possiamo farci nulla, quindi dovresti 
inviare un messaggio allo sviluppatore. 

• Alcuni file del desktop che sono usati per creare il menu Start potrebbero mancare di un 
commento nella tua lingua, anche se l'applicazione stessa ha una traduzione in quella 
lingua; per favore facci sapere con un post nel forum delle traduzioni che fornisca la 
traduzione corretta. 

 
3.8 Personalizzazione 

I moderni desktop Linux come Xfce e KDE/plasma rendono molto facile cambiare la 
funzione di base e l'aspetto della configurazione di un utente. 

 
• Soprattutto, ricordate: Il tasto destro del mouse è tuo amico! 



• Un grande controllo è disponibile attraverso (Xfce) All Settings e 
(KDE/plasma) SystemSettings (icone del pannello). 

 
• Le modifiche dell'utente sono memorizzate in file di configurazione nella 

directory: ~/.config/. Questi possono essere interrogati in un terminale, vedi 
MX/antiX Wiki. 

 
• La maggior parte dei file di configurazione a livello di 

sistema sono in /etc/skel/ o /etc/xdg/ MORE: Trucchi e consigli 

su Xfce (PDF) 

3.8.1 Tematizzazione predefinita 
 

La tematizzazione predefinita è controllata da una serie di elementi personalizzati. 
 

Xfce 
 

• Schermata di accesso (modificare con Tutte le impostazioni > Impostazioni di LightDM GTK+ 
Greeter) 

 
• Tema: Adwaita-dark (MX-21) 

 
• Sfondo: in /usr/share/backgrounds/MXLinux/lightdm/ 

 
• Box di accesso: modificato il tema predefinito /usr/sbin/lightdm-gtk-greeter 

 
• Desktop: 

 
• Sfondo: Tutte le impostazioni > Desktop/. Quando selezioni da un'altra 

posizione, tieni presente che dopo aver usato la voce "Altro" devi navigare 
fino alla cartella che vuoi, poi clicca su "Apri"; solo allora puoi selezionare un 
particolare file in quella posizione. 

 
• Tutte le impostazioni > Aspetto. Imposta i temi e le icone GTK. Impostazioni 

incluse in MX Tweak - Temi (sezione 3.2). 
 

• Tutte le impostazioni > Gestione finestre. Imposta i temi dei bordi delle finestre. 
 

KDE/Plasma 
 

• Schermo di accesso (modificare con Impostazioni di sistema > Avvio e 
spegnimento poi scegliere Schermo di accesso, configurazione SDDM) 

 
• Breeze 

 

https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff#List%20configuration%20settings
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf


• Desktop: 



• Sfondo: Fare clic con il tasto destro del mouse sul desktop e 
selezionare "Configura il desktop e lo sfondo". 

Aspetto 
 

• Temi globali - combinazioni di temi in bundle 
Plasma Style - Imposta il tema degli oggetti del 
desktop al plasma 

• Stile di applicazione 

Stile dell'applicazione - Configura gli elementi dell'applicazione 

Decorazioni della finestra - stili dei pulsanti di minimizzazione, massimizzazione e chiusura 
 

• Si possono anche configurare colori, caratteri, icone e cursori. 
 

• Impostazioni del menu dell'applicazione 
 

1. Fare clic con il tasto destro del mouse sull'icona del menu per ottenere 
le opzioni di configurazione. Il pannello predefinito è quello 
dell'applicazione standard 

 

3.8.3 Pannelli 

3.8.3.1 Pannello Xfce 
 
 

 
Figura 3-43: Schermata delle preferenze per la personalizzazione dei pannelli 

 
 

MX Linux ora viene fornito di default con la Docklike Taskbar (xfce4-docklike-plugin) che 

https://mxlinux.org/wiki/docklike-taskbar/


sostituisce i pulsanti delle finestre di Xfce utilizzati nelle precedenti versioni di MX. Questo 
leggero, moderno e minimalista 



taskbar per Xfce fornisce la stessa funzionalità di Xfce Window Buttons, fornendo anche 
caratteristiche più avanzate di "dock". 

 
Per visualizzare le proprietà della barra delle applicazioni simile al 
dock: Ctrl + clic destro su qualsiasi icona. Oppure: MX Tweak > 
scheda Pannello, fare clic sul pulsante "Opzioni" sotto Docklike. 

 
I pulsanti della finestra possono essere ripristinati cliccando con il 
tasto destro del mouse su uno spazio vuoto > Pannello > Aggiungi 
nuovi elementi. 

 
 

Trucchi per la personalizzazione del pannello 

• Per spostare il pannello, sbloccalo cliccando con il 
tasto destro su un pannello > Pannello > Preferenze 
pannello. 

 
• Usa MX Tweak per cambiare la posizione del pannello: 

verticale o orizzontale, in alto o in basso. 

 
 

Figura 3-44: La barra 
delle applicazioni simile 
al dock con icone e menu 
contestuale 

 

• Per cambiare la modalità di visualizzazione all'interno delle impostazioni del 
Pannello, selezionare dal menu a tendina: Orizzontale, Verticale o Deskbar. 

 
• Per nascondere automaticamente il pannello, scegli dal menu a tendina: Mai, 

Sempre, o Intelligentemente (nasconde il pannello quando una finestra si 
sovrappone ad esso). 

 
• Installa nuovi elementi del pannello cliccando con il tasto destro del mouse su uno 

spazio vuoto nel pannello > Panel > Add New Items. Hai quindi 3 scelte: 
 

• Seleziona una delle voci dell'elenco principale che appare 
 

• Se quello che vuoi non c'è, seleziona Launcher. Una volta che è in posizione, 
fai clic con il tasto destro del mouse > Proprietà, clicca sul segno più e 
seleziona un elemento dalla lista che appare. 

 
• Se vuoi aggiungere un elemento non presente in nessuna delle due liste, 

seleziona l'icona dell'elemento vuoto sotto il segno più e compila la finestra 
di dialogo che appare. 

 
• Le nuove icone appaiono nella parte inferiore del Pannello verticale; per spostarle, 

fare clic con il tasto destro del mouse > Sposta 
 

• Cambia l'aspetto, l'orientamento, ecc. cliccando con il tasto destro del mouse 
sul pannello > Panel > Panel Preferences. 

 



• Cliccate con il tasto destro del mouse sul plugin dell'orologio "DateTime" per 
cambiare il formato del layout, della data o dell'ora. Per un formato orario 
personalizzato è necessario utilizzare "codici strftime" (consultare questa pagina o 
aprire un terminale e digitare man strftime). 

http://en.cppreference.com/w/c/chrono/strftime


• Crea una doppia fila di icone nell'Area di notifica cliccando con il tasto destro del 
mouse su di essa > Proprietà, e diminuendo la dimensione massima delle icone finché 
non cambia. 

 
• Aggiungi o cancella un pannello in Panel Preferences, cliccando sul pulsante più o 

meno a destra del menu a tendina del pannello superiore. 
 

• L'installazione del pannello orizzontale con un clic è disponibile da MX Tweak (sezione 3.2). 
 

OLTRE: Xfce4 docs: Pannello. 
 

3.8.3.2 Pannello KDE/plasma 
 

Figura 3-45: Schermata delle preferenze per la personalizzazione dei pannelli 
 
 

Trucchi per la personalizzazione del pannello: 
 

• Per spostare il pannello, fai clic destro sul pannello e poi Modifica pannello. Passa 
sopra "Bordo dello schermo" e spostalo nella posizione che preferisci. 

 
• Usa MX Tweak per cambiare la posizione del pannello: verticale (a sinistra), in alto 

o in basso. Oppure usa il metodo precedente per trascinare su qualsiasi bordo dello 
schermo. 

 
• Per cambiare la modalità di visualizzazione all'interno del pannello, una volta aperta 

la finestra di dialogo Modifica pannello, scegliete Altre opzioni Allineamento 
pannello > sinistra, centro o destra. 

 
• Per nascondere automaticamente il pannello, una volta aperta la finestra di dialogo 

Edit Panel, fare clic su "More Settings" e selezionare "Auto Hide". 
 

• Installa nuovi elementi del pannello cliccando sul pannello >Add Widgets. Puoi 
selezionare il widget desiderato da aggiungere dalla finestra di dialogo. 

 
• Create una doppia fila di icone nell'area di notifica utilizzando la finestra di dialogo 

Configure Panel e selezionando Height per cambiare l'altezza del pannello. Poi 
usando MX-Tweak 
> Plasma e impostando le dimensioni delle icone del vassoio di sistema più grandi o 
più piccole come desiderato per creare l'effetto doppia fila. Puoi anche fare in modo 
che le icone del vassoio di sistema scalino automaticamente con l'altezza del pannello 
cliccando con il tasto destro sulla freccia in alto del vassoio, Configura il vassoio di 
sistema e abilitando la scala con l'altezza del pannello. 

 
• Per mostrare tutte le applicazioni aperte, clicca su MX Tweak, scheda Plasma, 

http://docs.xfce.org/xfce/xfce4-panel/start


e attiva "Mostra le finestre di tutti gli spazi di lavoro nel pannello". 



3.8.4 Desktop 
 

 Personalizzare il desktop  
Cose da fare dopo aver installato MX Linux 

Il desktop predefinito (AKA wallpaper, sfondo) può essere cambiato in vari modi. 
 

• Clicca con il tasto destro del mouse su qualsiasi immagine > Imposta come sfondo 
 

• Se volete che gli sfondi siano disponibili per tutti gli utenti, diventate root e metteteli nella cartella 
cartella /usr/share/backgrounds; 

 
• Se volete ripristinare lo sfondo di default, è in /usr/share/backgrounds/. Ci sono anche 

link simbolici dei set di sfondi di MX in /usr/share/wallpapers per un facile utilizzo di 
MX-KDE. 

 
Sono disponibili molte altre opzioni di personalizzazione. 

 
• Cambiare il tema 

 
• Xfce - Aspetto. Il tema predefinito è un MX mx-comfort (chiaro e scuro) che 

ha bordi più grandi e specifica l'aspetto del menu Whisker. Assicurati di 
selezionare un tema di icone che si mostri bene, specialmente sulla versione 
scura. 

 
• KDE/plasma - Tema globale - Il tema MX è quello predefinito. Puoi anche 

impostare singoli elementi del tema in Stile Plasma, Stile applicazione, 
Colori, Caratteri, Icone e cursori. 

 
• Per rendere i bordi sottili più facili da afferrare, 

 
• Xfce - Usare uno dei temi Window Manager con "bordo spesso" o consultare 

la Wiki MX/antiX. 
 

• KDE/plasma - In Stile applicazione > Decorazioni finestra, imposta la 
"Dimensione del bordo" desiderata dal menu a discesa fornito. 

 
• Xfce - Aggiungere icone standard come il Cestino o la Home al desktop in 

Desktop, scheda icone. 
 

• Il comportamento delle finestre, come lo switching, il tiling e lo zoom, può essere personalizzato 

https://www.youtube.com/watch?v=QWVd1-8xpYI
https://youtu.be/aESEb8lTvz4
https://youtu.be/aESEb8lTvz4
https://mxlinux.org/wiki/xfce/changing-border-size-with-xfce4-window-manager/
https://mxlinux.org/wiki/xfce/changing-border-size-with-xfce4-window-manager/


• Xfce - Modifiche al gestore delle finestre. 
 

• Il cambio di finestra tramite Alt+Tab può essere personalizzato per 
usare un elenco compatto invece delle icone tradizionali 

 
• La commutazione delle finestre tramite Alt+Tab può anche essere 

impostata per mostrare le miniature invece delle icone o di un elenco, 
ma richiede l'attivazione del compositor che alcuni vecchi computer 
potrebbero avere difficoltà a supportare. Per abilitarlo, per prima cosa 
deseleziona Cycle on a list list nella scheda "Cycling", poi clicca sulla 
scheda "Compositor" e spunta 'Show windows preview in place of 
icons' quando si fa il cycling. 

 
• La piastrellatura delle finestre può essere realizzata trascinando una 

finestra in un angolo e rilasciandola. 
 

• Se il compositing è attivato, lo zoom della finestra è disponibile 
usando la combinazione Alt + Ruota del mouse. 

 
• KDE/plasma - Impostazioni di sistema 

 
• La piastrellatura delle finestre può essere realizzata trascinando una 

finestra in un angolo e rilasciandola lì. 
 

• La configurazione di una varietà di controlli dei tasti e del mouse può 
essere impostata come desiderato attraverso la finestra di dialogo 
Window Behavior. 

 
• La configurazione di Alt-tab, incluso il tema, può essere fatta 

nella finestra di dialogo Task Switcher. 
 

• Carta da parati 
 

• Xfce - Usa le impostazioni del desktop per scegliere gli sfondi. Per selezionare 
uno sfondo diverso per ogni spazio di lavoro, vai su Sfondo e deseleziona 
l'opzione "Applica a tutti gli spazi di lavoro". Poi seleziona uno sfondo e ripeti il 
processo per ogni spazio di lavoro trascinando la finestra di dialogo allo spazio di 
lavoro successivo e selezionando un altro sfondo. 

 
• KDE/plasma - fai clic destro sul desktop e seleziona "Configura desktop e 

sfondo". 

https://en.wikipedia.org/wiki/Compositing_window_manager


 
 

 

Figura 3-46: La casella non spuntata permette sfondi diversi per ogni spazio di lavoro A 
sinistra: Xfce, a destra: KDE. 

 
 

Conky 
 

È possibile visualizzare quasi ogni tipo di informazione sul desktop utilizzando Conky 
 

• Sia Conky Manager che MX Conky sono installati di default. 
 

• Quando si clicca su MX Conky, una finestra di dialogo apparirà se ci sono aggiornamenti disponibili. 
 

• Clicca sul menu Start > Accessori per trovare Conky Manager. MX Conky fa 
parte di MX Tools. 

 
• Un set di conkies che funzionerà OOTB è incluso di default. Puoi importare altri 

set usando l'icona dell'ingranaggio all'estremità destra della barra dei menu in 
Conky Manager 

 
• Evidenzia ogni conky e premi Anteprima per vedere come appare. Assicurati di 

chiudere ogni anteprima prima di passare ad un'altra. 
 

• Spunta la casella per selezionare qualsiasi conky che vuoi usare. Sarà auto-installato. 
 

• I file di configurazione sono memorizzati nella cartella ~/.conky/ in file tematici 
individuali; possono essere modificati evidenziando il conky nella lista e cliccando 
sull'icona di modifica (matita). 

 
AIUTO: Wiki tecnico di MX/antiX 

 
OLTRE: Conky home page 

https://mxlinux.org/wiki/help-files/help-mx-conky
http://conky.sourceforge.net/index.html


 
 

Figura 3-47: Schermata principale di Conky Manager che mostra uno dei conkies disponibili 
 
 
 
 

Terminale a strappo 
 

 Personalizzare il terminale a discesa 
 

MX Linux viene fornito con un terminale a tendina molto comodo attivato con F4. Se vuoi 
 disabilitarlo: Xfce- menu Start > Tutte le impostazioni > Tastiera, scheda Scorciatoie 
applicazioni. 

KDE/plasma - Impostazioni di sistema > Avvio e spegnimento > Avvio e spegnimento 
deleteYakuake. 

 
I terminali a discesa sono molto configurabili. 

 
Xfce - clic destro sulla finestra del terminale e selezionare Preferenze 
KDE/plasma - seleziona il menu "hamburger" nell'angolo in basso a destra del 

terminale. 
 

3.8.5 Touchpad 
 

Xfce - Le opzioni generali per il touchpad su un portatile si trovano cliccando su Impostazioni 
> Mouse e Touchpad. I sistemi che sono più sensibili alle interferenze del touchpad hanno un 
paio di opzioni: 

 
• Usare MX-Tweak, altra scheda per cambiare il driver del touchpad 

 
• Installa touchpad-indicator per vedere il controllo fine del comportamento.. Fai clic 

https://www.youtube.com/watch?v=_X4tVjO8uzo


destro sull'icona nell'area di notifica per impostare opzioni importanti come l'avvio 
automatico. 



KDE/Plasma - le opzioni del touchpad si trovano in Impostazioni di sistema > Hardware > 
Dispositivi di input. C'è anche un widget per il touchpad che può essere aggiunto al pannello 
(clic destro sul pannello > aggiungi widget) 

 
Le modifiche dettagliate possono essere fatte manualmente modificando il file 20-synaptics.conf sotto 
/etc/X11/xorg.conf.d (il file è solo "synaptics.conf su MX-19). 

 

3.8.6 Menu 
 

3.8.6.1 Xfce ("Whisker") 
 

 Personalizzazione del menu 

Whisker  Divertimento con il 
menu Whisker 

MX Linux XFCE usa di default il Whisker Menu, anche se un menu classico può essere 
facilmente installato cliccando con il tasto destro del mouse su un pannello > Pannello > 
Aggiungi nuovi elementi > Menu Applicazioni. Whisker Menu è altamente flessibile. 

 
• Cliccate con il tasto destro del mouse sull'icona del menu > Proprietà per impostare le preferenze, per 

esempio, 
 

> Sposta la colonna delle categorie per essere vicino al Pannello. 
 

> Cambia la posizione della casella di ricerca dall'alto in basso. 
 

> Decidete quali pulsanti d'azione volete mostrare. 
 

• I preferiti sono facili da aggiungere: clicca con il tasto destro del mouse su qualsiasi voce di menu > 
Aggiungi ai preferiti. 

 
• Basta trascinare e rilasciare i preferiti per disporli come si desidera. Clicca con il 

tasto destro del mouse su qualsiasi voce per ordinare o rimuovere. 
 

PIÙ: Caratteristiche del menu Whisker 
 

Modifica di 
 

Le voci di menu possono essere modificate con due applicazioni (i file "desktop" delle voci 
di menu si trovano in /usr/share/applications/ e possono anche essere modificati 
direttamente come root). 

 
• MX Menu Editor (sezione 3.2). 

 

https://www.youtube.com/watch?v=QWVd1-8xpYI
https://www.youtube.com/watch?v=QWVd1-8xpYI
https://www.youtube.com/watch?v=bgPn68jMqd0
https://www.youtube.com/watch?v=bgPn68jMqd0
http://gottcode.org/xfce4-whiskermenu-plugin/


• Cliccando con il tasto destro del mouse su una voce del menu Whisker è 
possibile modificare un lanciatore su una base specifica dell'utente. 



• Clicca sul menu Start > Accessori > Application Finder (o Alt-F3), e clicca con 
il tasto destro su qualsiasi voce. Il menu contestuale contiene Modifica e Nascondi 
(quest'ultimo può essere molto utile). Selezionando Modifica si apre una schermata 
in cui è possibile cambiare nome, commento, comando e icona. 

 

 
Figura 3-48: Schermata di modifica delle voci di menu 

 
 
 

3.8.6.2 KDE/plasma ("kicker") 
 

MX Linux KDE/plasma utilizza il menu Application Launcher per impostazione predefinita, 
anche se le alternative sono facilmente installabili con un clic destro sull'icona del menu e 
scegliendo "Mostra alternative alternative". Le applicazioni "preferite" sono mostrate come 
icone sulla sinistra del menu. 

 
• Fare clic con il tasto destro del mouse sull'icona del menu > Configure Application Menu per 

impostare le preferenze, ad es, 
 

> Mostra le applicazioni come solo nome o combinazioni di nome/descrizione 
 

> Cambia la posizione dei risultati della ricerca 
 

> Mostra gli elementi recenti o usati spesso 
 

> Appiattisci i sottolivelli del menu. 
 

• I preferiti sono facili da aggiungere: clicca con il tasto destro del mouse su qualsiasi voce di menu > 
Mostra nei preferiti. 

 
• Basta trascinare e rilasciare i preferiti per disporli come si desidera. Clicca con il 

tasto destro del mouse su qualsiasi voce per ordinarla. Per rimuovere dai Preferiti 
fai clic destro sull'icona e poi Mostra nei preferiti e deseleziona il desktop o 
l'attività appropriata. 



Modifica di 
 

Le voci di menu possono essere modificate con un clic destro su una voce del menu 
ed è possibile modificare un lanciatore su una base specifica dell'utente. I file 
"desktop" delle voci di menu si trovano in 
/usr/share/applications/ e può anche essere modificato direttamente come root. 

Figura 3-49: schermata di modifica delle voci di menu 
 

3.8.7 Accompagnatore di accesso 
 

L'utente ha un certo numero di strumenti per personalizzare il login greeter. Le iso Xfce usano il 
greeter lightdm, mentre le iso KDE/plasma usano SDDM. 

 
Lightdm 

 

Figura 3-50: l'app di configurazione di Lightdm 



• Cliccate sul menu Start > Impostazioni > Tutte le impostazioni > Impostazioni 
di LightDM GTK+ Greeter per regolare la posizione, lo sfondo, il carattere, ecc. 

 
• L'autologin può essere (in)attivato da MX User Manager, scheda Opzioni. 

 
• Alcune proprietà della casella di login predefinita sono impostate nel codice per 

il tema predefinito (greybird-thick-grip) e alcuni temi correlati. Cambia tema per 
una maggiore scelta. 

 
• Puoi fare in modo che il login greeter mostri un'immagine come segue: 

 
• Menu Start > Impostazioni > Chi sono (Mugshot) 

 
• Inserisci i dettagli che vuoi aggiungere. 

 
• Clicca sull'icona, naviga fino all'immagine che vuoi usare. Chiudi. 

 
• Manuale 

 
• Crea o seleziona un'immagine e usa gThumb o un altro editor di foto 

per ridimensionarla a circa 96x96 pixel 
 

• Salva quell'immagine nella tua cartella home come .face (assicurati di 
includere il punto e non aggiungere alcuna estensione come jpg o png). 

 
• Fai clic su Tutte le impostazioni > Impostazioni di LightDM GTK+ 

Greeter, scheda Aspetto: attiva l'interruttore Immagine utente. 
 

• Qualunque sia il modo scelto, fai il logout, e vedrai l'immagine accanto alla 
casella di login; apparirà anche nel menu Whisker una volta che avrai effettuato 
nuovamente il login. 

 
SDDM 

 

Figura 3-51: l'applicazione di configurazione SDDM 



• Le impostazioni sddm sono tutte in Impostazioni di sistema del desktop Plasma. Un 
lanciatore di scorciatoie per le Impostazioni di sistema può essere trovato nel 
pannello predefinito di MX, o puoi in ogni caso cercarlo nel menu Applicazioni. 
Nelle Impostazioni, vai su Avvio e spegnimento 
>> Schermo di accesso (SDDM). 

 
• La pagina delle impostazioni per sddm vi permetterà di: 

 
■ selezionare tra diversi temi se ne hai più di uno installato; 

 
■ scegliere di personalizzare uno sfondo per il tema selezionato; 

 
■ rimuovere (cioè eliminare) un tema installato; e 

 
■ per ottenere/installare nuovi temi direttamente da KDE Store online o da un file 

sul tuo disco/media di archiviazione (vedi sotto) 
 

• è richiesta la password di root - poiché desktop manager è un programma di sistema, 
qualsiasi modifica ad esso o alla sua configurazione influenzerà i file nella partizione 
di root, ed è per questo che ti verrà richiesta la password di root. 

 
• selezione dello sfondo - puoi cambiare lo sfondo del tema sddm selezionato. Alcuni 

temi hanno la loro immagine di sfondo predefinita preinstallata che verrà visualizzata 
se non si apportano modifiche. Anche questo richiederà la password di root. 

 
• I nuovi temi di sddm possono essere trovati nel KDE Store. Puoi anche sfogliare i 

temi direttamente dalla pagina delle impostazioni di sistema per sddm. 
• In SystemSettings > Startup and Shutdown > Login Screen (SDDM), Get New 

Login Screens in fondo alla finestra. 
 

• Per installare un tema: 
 

■ da un file zip scaricato, clicca sul pulsante "Install from File" nella pagina System 
Settings per sddm, poi seleziona il file zip desiderato dal selezionatore di file che 
si apre. 

 
■ Mentre nel browser dei temi sddm in-built di System Settings, clicca 

semplicemente sul pulsante "Install" del tema selezionato. 

ATTENZIONE: Alcuni temi nel KDE Store potrebbero essere incompatibili. MX 21 usa Plasma 
versione 5.20, che è la versione stabile disponibile per Debian, Bullseye ma l'ultima versione di 
Plasma è già alla versione 5.22 (all'inizio di gennaio 2021). Potresti quindi scoprire che alcuni 
degli ultimi temi sddm costruiti per utilizzare le ultime caratteristiche di Plasma potrebbero non 
funzionare con sddm di Plasma 5.20. Fortunatamente sddm viene fornito con una schermata di 
accesso di ripiego in modo che se un tema che hai applicato non funziona, puoi ancora accedere 
nuovamente al tuo desktop e da lì passare ad un altro tema sddm. Fai qualche prova; alcuni temi 
molto nuovi funzionano mentre altri no. 

 

3.8.8 Bootloader 
 

Il bootloader (GRUB) di un MX Linux installato può essere modificato con opzioni comuni 
cliccando sul menu Start > MX Tools > MX Boot Options (vedi Sezione 3.2.2). Per altre 

https://store.kde.org/browse/cat/101/order/latest


funzioni, installare Grub Customizer. Questo strumento dovrebbe essere usato con cautela, ma 
permette agli utenti di configurare 



Impostazioni di Grub come la configurazione dell'elenco delle voci di avvio, i nomi delle 
partizioni, il colore delle voci di menu, ecc. Dettagli qui. 

 

3.8.9 Suoni di sistema e di eventi di Xfce 
 

I bip del computer sono silenziati di default nelle linee "blacklist" nel file /etc/modprobe.d/pc- 
speaker.conf. Commentate (# all'inizio) queste linee come root se volete ripristinarle. 

 
I suoni degli eventi possono essere attivati a livello di sistema cliccando sul menu Start > 
Impostazioni > Aspetto, scheda Altro: spunta Abilita i suoni degli eventi e, se vuoi, Abilita i 
suoni di feedback in ingresso. Possono essere gestiti con MX System Sounds (sezione 3.2). Se 
non iniziate a sentire piccoli suoni quando chiudete una finestra o fate il logout, per esempio, 
provate questi passaggi: 

 
• Esci e rientra. 

 
• Clicca sul menu Start > Multimedia > PulseAudio Volume Control, scheda Playback, e 

regola il livello come necessario (inizia con 100%). 
 

• Cliccate sul menu start, digitate "!alsamixer" (non dimenticate il punto esclamativo). 
Apparirà una finestra di terminale con un solo controllo audio (Pulseaudio Master). 

 
• Usa F6 per selezionare la tua scheda audio, e poi regola i canali che 

appaiono a volumi più alti. 
 

• Cercate canali come "Surround", "PCM" "Speakers", "Master_Surround", 
"Master_Mono" o "Master". I canali disponibili dipendono dal vostro 
particolare hardware. 

 
Tre file audio sono forniti di default: Borealis, Freedesktop e Fresh and Clean. Tutti si trovano 
in /usr/share/sounds. Trovane altri nei repo o con una ricerca sul web. 

 

3.8.10 Applicazioni predefinite 

Generale 
 

Le applicazioni predefinite da utilizzare per le operazioni generali sono impostate cliccando su Application 
menu 
> Settings > Default Applications (Xfce) o System Settings > Applications > Default 
Applications (KDE/plasma). dove puoi impostare quattro preferenze (Xfce: schede 
separate per Internet e Utilities). 

 
• Browser web 

 
• Lettore di posta 

 
• Gestore di file 

https://answers.launchpad.net/grub-customizer/%2Bfaq/1355


• Emulatore di terminale 
 

Particolare 
 

Molti valori predefiniti per tipi di file specifici sono impostati durante l'installazione di 
un'applicazione. Ma spesso esistono più opzioni per un dato tipo di file, e un utente vorrebbe 
determinare quale applicazione lancerebbe il file, ad esempio il lettore musicale per aprire un 
file *.mp3. 

 
L'applicazione Applicazioni predefinite di Xfce ha una terza scheda, "Altri", dove questi tipi di 
MIME possono essere impostati utilizzando una comoda tabella di ricerca per trovare il tipo, 
quindi facendo doppio clic sullo spazio Applicazioni predefinite per impostare l'applicazione 
desiderata. 

 
Metodo generale 

 
• Clicca con il tasto destro del mouse su qualsiasi esempio del tipo di file che ti interessa 

 
• Fate una delle seguenti selezioni: 

 
• Apri con <applicazione elencata>. Questo aprirà il file con l'applicazione 

selezionata per questa particolare istanza, ma non influenzerà l'applicazione 
predefinita. 

 
• Apri con un'altra applicazione. Scorri l'elenco per evidenziare quello che vuoi 

(incluso "Usa un comando personalizzato"), quindi seleziona Apri. La casella in 
basso "Usa come predefinito per questo tipo di file" è deselezionata di default, 
quindi spuntala se vuoi che la tua selezione diventi la nuova applicazione 
predefinita che viene lanciata quando clicchi su qualsiasi file di quel particolare 
tipo. Tienila deselezionata per un uso una tantum. 

 

 
Figura 3-52: cambiare l'applicazione predefinita Sinistra: Thunar Destra: dolphin 



3.8.11 Conti limitati 
 

Per alcuni scopi, può essere desiderabile bloccare un'applicazione o un sistema per proteggerlo 
dagli utenti. Gli esempi includono i computer in una scuola o in un luogo pubblico per uso 
generale, dove il file system, il desktop e l'accesso a internet devono essere chiusi. Ci sono 
diverse opzioni disponibili. 

 
• Alcuni componenti di Xfce che supportano la modalità kiosk. Dettagli nella Wiki di Xfce. 

 
• KDE ha una modalità amministrativa, consultate la KDE Userbase. 

 
• Controlla il browser che usi per vedere se ha una modalità kiosk. 

 
• La distro Porteus dedicata ai chioschi. 

 
Di più: La guida di Alan D. Moore (un po' datata). 

https://wiki.xfce.org/howto/kiosk_mode
https://userbase.kde.org/KDE_System_Administration
http://porteus-kiosk.org/index.html
http://www.alandmoore.com/blog/2011/11/05/creating-a-kiosk-with-linux-and-x11-2011-edition/


4 Uso di base 
4.1 Internet 

4.1.1 Browser web 
 

• MX Linux viene fornito con il popolare browser Firefox installato, che ha un ampio 
set di componenti aggiuntivi per aumentare l'esperienza dell'utente. 

 
Pagina iniziale di Firefox 

 
Componenti aggiuntivi per Firefox 

 
• Gli aggiornamenti di Firefox arrivano attraverso i repo di MX Linux, e sono 

solitamente disponibili per gli utenti entro 24 ore dal rilascio. Per il download 
diretto, vedere la sezione 5.5.5. 

 
• I file di localizzazione per Firefox possono essere installati facilmente con MX Package Installer. 

 
• Firefox ha un servizio di sincronizzazione che facilita il trasferimento di segnalibri, 

cookie, ecc. da un'installazione esistente di Firefox. 
 

• Altri browser sono disponibili per un facile download e installazione tramite il MX 
Package Installer. Controlla la Wiki di MX/antiX per consigli e trucchi di 
configurazione. 

 

4.1.2 Email 
 

• Thunderbird è installato di default in MX Linux. Questo popolare client di posta 
elettronica si integra bene con Google Calendar e Google Contacts. Le versioni più 
recenti disponibili possono essere trovate con MX Package Installer > MX Test Repo. 

 
• I file di localizzazione per Thunderbird possono essere installati facilmente con MX Package Installer. 

 
• Per aiuto con i link che non aprono più un browser, consultate la Wiki di MX/antiX. 

 
• Altri client di posta elettronica leggeri sono disponibili dall'installatore di pacchetti MX. 

 

4.1.3 Chat 
 

• HexChat. Questo programma di chat IRC è installato di default in MX Linux, e 
rende lo scambio di messaggi di testo facile per l'utente. 

 
Home page di HexChat 

https://www.mozilla.org/
https://addons.mozilla.org/en-US/firefox/
https://mxlinux.org/wiki/applications/
https://www.mozilla.org/thunderbird/
https://mxlinux.org/wiki/applications/thunderbird/
https://hexchat.github.io/


• Pidgin. Questo client di messaggistica istantanea grafico e modulare è in grado di 
utilizzare più reti contemporaneamente. Installatore di pacchetti MX. 

 
Pagina iniziale di Pidgin 

 

Video Chat 
 

• Zoom. Questo programma di video chat molto popolare è multipiattaforma e può 
essere installato su MX Linux senza problemi usando MX Package Installer > 
Messaging. Si integra automaticamente con PulseAudio, che è installato di default. 

 
• Gmail ha una funzione di conversazione incorporata, ora chiamata Duo. Vedi sezione 4.10.6 

 
• Skype. Un popolare programma proprietario per la messaggistica istantanea e la chat 

vocale e video. 
 

Pagina iniziale di Skype 
 

Risoluzione dei problemi 
 

• Se la tua voce non viene captata anche dopo aver usato gli strumenti dell'app, 
prova questo: 

 
• Accedi alla tua applicazione di video chat, clicca su Opzioni e vai 

alla scheda Dispositivi audio. 
 

• Clicca sul pulsante per iniziare una chiamata di prova. Mentre la 
chiamata è in corso, apri PulseAudio Volume Control e vai alla 
scheda Registrazione. 

 
• Ancora mentre la chiamata di prova è in corso - cambia il microfono 

di Skype con quello della webcam. 
 

4.2 Multimedia 

Qui sono elencate alcune delle molte applicazioni multimediali disponibili in MX Linux. 
Esistono anche applicazioni professionali avanzate, e possono essere trovate attraverso 
ricerche mirate in Synaptic. 

http://pidgin.im/
https://zoom.us/
https://duo.google.com/
https://www.skype.com/en/


4.2.1 Musica 
 

 
Figura 4-1: Riproduzione di una traccia CD con Clementine 

 
• Giocatori 

 
• Clementine. Un moderno lettore musicale e organizzatore di librerie che può 

riprodurre ogni fonte, da un CD a un servizio cloud. Installato di default. 
 

Clementine home page 
 

• Audace. Un lettore e gestore musicale completo. Installatore di pacchetti MX. 
 

Home page di Audacious 
 

• DeaDBeeF. Un lettore leggero con un piccolo ingombro di memoria, un 
robusto set di funzioni di base e un focus sulla riproduzione della musica. 
Installatore di pacchetti MX. 

 
Pagina iniziale di DeaDBeeF 

 
• Ripper e redattori 

 
• Asunder. Un ripper ed encoder grafico di CD audio che può essere usato 

per salvare tracce da CD audio. Installato di default. 
 

Asunder home page 
 

• EasyTAG. Una semplice applicazione per visualizzare e modificare i tag nei file audio. 
 

Home page di EasyTAG 

https://www.clementine-player.org/
http://audacious-media-player.org/
http://deadbeef.sourceforge.net/
http://littlesvr.ca/asunder/
https://wiki.gnome.org/Apps/EasyTAG


4.2.2 Video 
 

 AGGIORNAMENTO: Netflix su 32 bit Linux 
 

• Giocatori 
 

• VLC. Riproduce una vasta gamma di formati video e audio, DVD, VCD, 
podcast e flussi multimediali da varie fonti di rete. Installato di default. 

 
Pagina iniziale di VLC 

 
• Un Browser YouTube per SM Player è installato di default. 

 
Home page di SMplayer 

 
• Netflix. La capacità desktop di streaming di Netflix è disponibile per 

Firefox e Google Chrome. 
 

Home page di Netflix 
 

 
Figura 4-2: Esecuzione di Netflix sul desktop in Google Chrome 

 
• Ripper e redattori 

 
• HandBrake. Un video ripper facile da usare, veloce e semplice. Installatore 

di pacchetti MX. 
 

Home page di HandBrake 

https://www.youtube.com/watch?v=fY_PqMJ5kG4
http://www.videolan.org/vlc/
http://smplayer.sourceforge.net/
https://www.netflix.com/us/
https://handbrake.fr/


• DeVeDe. Questa utility converte automaticamente il materiale in formati 
compatibili con gli standard CD audio e DVD video. 

 
Pagina iniziale di DeVeDe 

 
• DVDStyler. Un'altra buona utility di authoring. MX Package Installer. 

 
Home page di DVDStyler 

 
• OpenShot. Un editor video semplice da usare e ricco di funzionalità. Installatore di pacchetti 

MX. 
 

Home page di OpenShot 
 

4.2.3 Foto 
 

 
Figura 4-3: Uso dello strumento di ritaglio in Nomacs 

 
• Nomacs. Un visualizzatore di immagini veloce e potente installato di default. 

 
Home page di Nomacs 

 
• Mirage. Questa veloce applicazione è facile da usare e permette di visualizzare e 

modificare le foto digitali. Installatore di pacchetti MX. 
 

Pagina del progetto Mirage 

http://www.rastersoft.com/programas/devede.html
http://www.dvdstyler.org/en/
http://www.openshot.org/
https://nomacs.org/
http://sourceforge.net/projects/mirageiv.berlios/


• Fotoxx. Questa veloce applicazione permette un facile fotoritocco e la gestione 
delle collezioni mentre serve le esigenze dei fotografi seri. MX Package Installer > 
MX Test Repo. 

 
Fotoxx home page 

 
• GIMP. Il principale pacchetto di manipolazione delle immagini per Linux. L'aiuto 

(gimp-help) deve essere installato separatamente, ed è disponibile in molte lingue. 
Pacchetto base installato di default, completo disponibile da MX Package Installer. 

 
Pagina iniziale di GIMP 

 
• gThumb. un visualizzatore e browser di immagini dagli sviluppatori GNOME che 

include anche uno strumento di importazione per trasferire foto da fotocamere. 
Predefinito in MX-21. 

 
Wiki gThumb 

 
• LazPaint, un leggero editor di immagini multipiattaforma con livelli raster e 

vettoriali. Predefinito in MX-21. 
 

Documentazione su LazPaint 
 

• Gwenview, il visualizzatore di immagini del progetto KDE 
 

Figura 4-4: Gwenview 

http://www.kornelix.net/fotoxx/fotoxx.html
http://www.gimp.org/
http://gthumb.sourceforge.net/features.html
https://wiki.freepascal.org/LazPaint


4.2.4 Screencasting 
 

 
Figura 4-5: schermata principale di SimpleScreenRecorder 

 
• Simple ScreenRecorder. Un programma semplice ma potente per registrare 

programmi e giochi. Installatore di pacchetti MX. 
 

Home page di SimpleScreenRecorder 
 

• RecordMyDesktop. Cattura i dati audio-video di una sessione desktop linux. 
Installatore di pacchetti MX. 

 
Home page di RecordMyDesktop. 

 

4.2.5 Illustrazioni 
 

• mtPaint. Un'applicazione facile da imparare per creare pixel art e manipolare foto 
digitali. 

 
pagina iniziale di mtPaint 

 
• LibreOffice Draw. Diagrammi, disegni e immagini possono essere creati e modificati 

con questa applicazione. 
 

LO Draw pagina iniziale 
 

• Inkscape. Questo editor di illustrazioni ha tutto il necessario per creare computer art 
di qualità professionale. Installatore di pacchetti MX. 

 
Home page di Inkscape 

http://www.maartenbaert.be/simplescreenrecorder/
http://recordmydesktop.sourceforge.net/about.php
http://mtpaint.sourceforge.net/
http://www.libreoffice.org/discover/draw/
https://inkscape.org/en/


4.3 Ufficio 

4.3.1 Suite per ufficio 
 

4.3.1.1 Sul desktop 

 
LibreOffice 

 

MX Linux viene fornito con una grande suite per ufficio gratuita chiamata LibreOffice, che è 

l'equivalente per Linux e quasi il sostituto di Microsoft Office®. La suite è disponibile sotto 

Application Menu > Office > LibreOffice. LibreOffice supporta i formati di file .docx, .xlsx 

e .pptx di Microsoft Office 2007 e superiori. 

 

 
Figura 4-6: Pannello principale in LibreOffice 6 

 
• L'ultima versione disponibile nei repo predefiniti è installata di default. 

 
• Elaboratore di testi: LibreOffice Writer. Un elaboratore di testi avanzato 

compatibile con i file .doc e .docx. 
 

• Foglio elettronico: LibreOffice Calc. Un foglio di calcolo avanzato 
compatibile con i file .xls e .xlsx. 

 
• Presentazione: LibreOffice Impress. Presentazioni, compatibili con i 

file .ppt e .pptx. 
 

• Disegnare: LibreOffice Draw. Utilizzato per creare grafici e diagrammi. 
 

• Matematica: LibreOffice Math. Utilizzato per le equazioni matematiche. 
 

• Base: LibreOffice Base. Utilizzato per creare e manipolare database. Se usi 
questa applicazione per creare o usare database nel formato nativo di 
LibreOffice, devi installare anche libreoffice-sdbc-hsqldb e libreoffice-
base-drivers abbinati alla versione. 



• Gli utenti possono ottenere versioni più recenti con diversi metodi: 
 

• Scarica direttamente da LibreOffice. Vedere la Wiki di MX/antiX per i dettagli. 
 

• Scaricare da MX Package Installer, scheda Backports. 
 

• Scarica il flatpak (MX Package Installer) o l'appimage. 
 

LINK 
 

• Home page di LibreOffice. 
 

• MX/antiX Wiki. 
 

Sono disponibili anche altre suite desktop. 
 

• Softmaker Free Office -- MX Package Installer: Applicazioni popolari 
 

• Calligra Suite (parte del progetto KDE) -- MX Package Installer: Repo di prova 
 

4.3.1.2 Nella nuvola 
 

Google 
 

Google's Docs e Office Suite (quest'ultimo richiede un abbonamento) offrono eccellenti 
applicazioni online che includono tre componenti standard per l'ufficio: Docs, Sheets e Slides. 
È facile condividere i file e le opzioni di esportazione sono molto utili. 

 
Microsoft 

 
I prodotti Microsoft non sono FOSS, eppure molti utenti hanno bisogno o vogliono averne 
accesso, specialmente per affari, istituzioni e altri contesti simili. Anche se le applicazioni 
della suite Microsoft Office non possono essere installate nativamente sotto Linux, Microsoft 
Office365 (servizio a pagamento) o On-line Office (gratuito) sono solo normali pagine web 
che girano bene all'interno di qualsiasi browser moderno su MX Linux. Dettagli nella Wiki 
di MX/antiX. 

 
Altre opzioni 

 
• OnlyOffice (servizio a pagamento per le imprese) 

 

4.3.2 Finanze dell'ufficio 
 

• GnuCash. Software finanziario per l'ufficio. È facile da imparare e permette di tenere 
traccia di conti bancari, azioni, entrate e uscite. Può importare dati in QIF, QFX e 
altri formati, e supporta la contabilità a doppia entrata. Installatore di pacchetti MX. 
Il pacchetto Aiuto (gnucash-docs) deve essere installato separatamente. 

https://mxlinux.org/wiki/applications/libreoffice/
https://mxlinux.org/wiki/applications/libreoffice/
https://mxlinux.org/wiki/applications/libreoffice/
https://www.libreoffice.org/download/appimage/
https://www.libreoffice.org/
https://mxlinux.org/wiki/applications/libreoffice
https://www.freeoffice.com/
https://www.calligra.org/
https://www.google.com/docs/about/
https://www.office.com/
https://products.office.com/en-us/office-online/documents-spreadsheets-presentations-office-online
https://products.office.com/en-us/office-online/documents-spreadsheets-presentations-office-online
https://mxlinux.org/wiki/applications/microsoft-office/
https://mxlinux.org/wiki/applications/microsoft-office/
https://www.onlyoffice.com/


• Pagina iniziale di GnuCash 
 

 
Figura 4-7: Nuovo conto in GnuCash 

 
4.3.3 PDF 

 
• QPDFview. Un visualizzatore veloce e leggero che include una serie di strumenti di 

base. Installato di default. 
 

QpdfView pagina iniziale 
 

• Okular, il lettore di PDF e documenti del progetto 

KDE Documentazione Okular 

 
 

• Adobe Reader per Linux offre maggiori funzionalità (come il commento o la 
compilazione di moduli). MX Package Installer (sotto Office). 

 
Pagina iniziale di Adobe Reader 

 
• PDFShuffler rende semplice il riordino, la cancellazione e l'aggiunta di pagine PDF. 

Installato di default. 
 

PDFShuffler pagina iniziale 
 

• gscan2pdf è un metodo pratico per scansionare documenti in PDF oltre a servire 
le esigenze generali di scansione. MX Package Installer (MX/antix Wiki). 

 
gscan2pdf home page 

http://gnucash.org/
https://launchpad.net/qpdfview
https://okular.kde.org/
http://www.adobe.com/products/reader.html
http://pdfshuffler.sourceforge.net/
https://mxlinux.org/wiki/applications/gscan2pdf
http://gscan2pdf.sourceforge.net/


• SimpleScan è un software di scansione minimo che funziona molto bene per i compiti 
quotidiani. Installato di default su MX-21. 

 
Pagina iniziale di SimpleScan 

 
• Per altre funzioni (ad esempio, la creazione di un modulo PDF), vedere MX/antiX Wiki. 

 

4.3.4 Pubblicazione sul desktop 
 

• Scribus. Impaginazione professionale che produce output pronto per la stampa. 
Disponibile tramite MX Package Installer. 

 
Home page di 

Scribus 
 

4.3.5 Tracciatore del tempo del progetto 
 

• Kapow punch clock. App semplice ma ricca di funzioni per registrare il tempo del progetto. 
 

Kapow pagina iniziale 
 

 
Figura 4.8 Kapow impostato per tracciare il lavoro su un progetto 

 
• Altre opzioni 

 

4.3.6 Video riunione e desktop remoto 
 

• AnyDesk. Permette un facile accesso remoto. MX Package Installer, insieme ad altre opzioni. 
 

• TeamViewer. Applicazione multipiattaforma per il supporto remoto e le riunioni online. 
Gratis per uso privato. Installatore di pacchetti MX. 

 
Pagina iniziale di TeamViewer 

https://gitlab.gnome.org/GNOME/simple-scan
https://mxlinux.org/wiki/applications/pdf
https://www.scribus.net/
https://www.scribus.net/
https://gottcode.org/kapow/
https://www.linuxlinks.com/timetracking/
https://anydesk.com/en
https://www.teamviewer.us/


4.4 Casa 

4.4.1 Finanze 
 

• HomeBank. Facile gestione della vostra contabilità personale, del bilancio e delle finanze. 
 

HomeBank pagina iniziale 
 

• Grisbi è molto utile per la casa. Può importare file QIF/QFX e ha un'interfaccia 
intuitiva. Forse è più adatto alle banche al di fuori degli Stati Uniti. 

 
Grisbi home page 

 

4.4.2 Centro media 
 

• Plex Mediaserver. Ti permette di riunire tutti i tuoi media e di visualizzarli in un unico 
posto. Installatore di pacchetti MX. 

 
Pagina iniziale di Plex 

 
• Kodi Entertainment Center (ex XBMC) permette agli utenti di riprodurre e 

visualizzare video, musica, podcast e file multimediali da supporti di 
memorizzazione locali e di rete. Installatore di pacchetti MX. 

 
Pagina iniziale di Kodi 

 

4.4.3 Organizzazione 
 

• Note. Questo pratico plugin per Xfce (xfce4-notes-plugin) ti permette di creare e 
organizzare note adesive per il tuo desktop. 

 
Home page delle note 

 
• KDE Pim Application, una suite di applicazioni per gestire le informazioni 

personali. https://community.kde.org/KDE_PIM 

• Osmo. Bella applicazione compatta che include calendario, attività, contatti e note. 
 

Home page di Osmo 

http://homebank.free.fr/en/
http://www.grisbi.org/
https://www.plex.tv/
http://kodi.tv/
http://goodies.xfce.org/projects/panel-plugins/xfce4-notes-plugin
https://community.kde.org/KDE_PIM
http://clayo.org/osmo/


 
 

Figura 4-9: Il gestore di informazioni personali Osmo 
 

4.5 Sicurezza 

4.5.1 Firewall 
 

• Gufw. Un'utilità di configurazione personale del firewall che facilita all'utente la 
configurazione del firewall. Installato di default. 

 
Gufw home page 

 
Wikipedia: Firewall personale 

 

4.5.2 Antivirus 
 

• ClamAV. Utile per impedire agli utenti Linux di passare inconsapevolmente e-mail 
infette da virus e altri documenti a utenti Windows suscettibili. 

 
Pagina iniziale di ClamAV 

 

4.5.3 AntiRootkit 
 

• chkrootkit. Questa applicazione scansiona i sistemi alla ricerca di rootkit 
noti e sconosciuti, backdoor, sniffer ed exploit. 

 
pagina iniziale di chkrootkit 

 

4.5.4 Protezione con password 
 

• Password e chiavi. Un gestore di password e chiavi installato di default. Dettagli 
sull'uso nella Wiki di MX/antiX. 

 
Aiuto per password e chiavi 

http://gufw.org/
http://en.wikipedia.org/wiki/Personal_firewall
https://sourceforge.net/projects/clamav/
http://www.chkrootkit.org/
https://mxlinux.org/wiki/applications/passwords-and-keys
https://help.gnome.org/users/seahorse/stable/


• KeePassX. Un gestore di password o cassaforte che ti aiuta a gestire le tue password 
in modo sicuro. Installatore di pacchetti MX. 

 
KeePassX pagina iniziale 

 

4.5.5 Accesso al web 
 

• La maggior parte dei browser moderni hanno componenti aggiuntivi che permettono di filtrare 
facilmente il web. 

 
• FoxFilter è un esempio consolidato che si installa su Firefox, Chrome e Opera. 

 

 

Figura 4-10: La scheda delle preferenze per FoxFilter 
 

4.6 Accessibilità 

Esistono varie utility open-source per gli utenti di MX Linux con disabilità. 
 

• Tastiera su schermo. Onboard è installata di default, e Florence è nei repo. 
 

• Xfce. Clicca su Application Menu > Settings > Accessibility, e spunta Enable 
Assistive Technologies. Cambia le opzioni disponibili a tuo piacimento. 

 
Documentazione di Xfce4: Accessibilità 

 
• KDE mantiene una grande collezione di aiuti all'accessibilità. 

 
Applicazioni per l'accessibilità di KDE 

 
• Debian. Molti altri strumenti sono disponibili all'interno di Debian stessa. 

 
Wiki Debian 

http://www.keepassx.org/
http://docs.xfce.org/xfce/xfce4-settings/accessibility
https://userbase.kde.org/Applications/Accessibility
https://wiki.debian.org/accessibility


4.7 Sistema 

4.7.1 Privilegi di root 
 

Ci sono due comandi comuni per ottenere i privilegi di root (AKA amministratore, superutente) 
di cui avete bisogno per fare modifiche al sistema (ad esempio, l'installazione di software) 
utilizzando un terminale. 

 
• su: richiede la password di root e concede privilegi per l'intera sessione del terminale 

 
• sudo: richiede la tua password utente e concede privilegi per un breve periodo di tempo 

 
In altre parole, su ti permette di cambiare utente in modo che tu sia effettivamente loggato come 
root, mentre sudo ti permette di eseguire comandi nel tuo account utente con i privilegi di root. 
Inoltre, su usa l'ambiente (configurazione specifica dell'utente) dell'utente root, mentre sudo 
permette modifiche a livello di root ma mantiene l'ambiente dell'utente che emette il comando. 
A partire da MX-21, MX Linux usa di default sudo, che i membri del forum generalmente 
raccomandano. 

 
L'utente può decidere se usare "Root" o "User" nella scheda "Other" di MX Tweak. 

 
ALTRO: cliccate su Application Menu > inserite "#su" o "#sudo" (senza le virgolette) nello 
spazio di ricerca e tornate indietro per vedere le pagine man dettagliate. 

 
Esecuzione di un'applicazione root 

 
Alcune applicazioni che si trovano nel menu delle applicazioni richiedono che l'utente abbia i 
privilegi di root: gparted, lightdm gtk+ greeter, ecc. A seconda di come è scritto il comando di 
lancio, la finestra di dialogo che appare può mostrare che l'accesso di root sarà memorizzato 
(impostazione predefinita) per tutta la durata della sessione (cioè, fino a quando non si effettua il 
logout). 

 
 

 
Figura 4-11: finestra di dialogo quando il comando pkexec è usato senza memorizzare la password di root 



4.7.2 Ottieni le specifiche dell'hardware 
 

• Clicca su Application Menu > System > System Profiler and Benchmark per 
una bella visualizzazione grafica che include i risultati di vari test. 

 
• Clicca su Application Menu > MX Tools > Quick System Info. L'output 

viene automaticamente copiato negli appunti, e può anche essere incollato in 
un post del forum completo di tag di codice. 

 
Vedere la sezione 6.5 per le molte altre caratteristiche di inxi. 

 

4.7.3 Creare collegamenti simbolici 
 

Un link simbolico (anche soft link o symlink) è un tipo speciale di file che punta a un altro file o 
cartella, proprio come un collegamento in Windows o un alias in Macintosh. Un link simbolico 
non contiene alcun dato effettivo (come fa un hard link), punta solo a un'altra posizione da 
qualche parte nel sistema. 

 
Ci sono due modi per creare un collegamento simbolico: File Manager o la linea di comando. 

 
• Thunar 

 
• Navigare al file o alla cartella (destinazione del collegamento) che si vuole 

puntare da un'altra posizione o con un altro nome 
 

• Cliccate con il tasto destro del mouse su ciò che volete collegare > Create 
Symlink, e un symlink viene creato dove siete attualmente 

 
• Fare clic con il tasto destro del mouse sul nuovo collegamento simbolico > Taglia 

 
• Naviga fino a dove vuoi che il link sia, clicca con il tasto destro del mouse 

su un'area aperta> Incolla. Cambia se vuoi il nome del link. 
 

• delfino/KDE-plasma 
 

• Usate Create New > Basic Link to File or Directory 
 

• Linea di comando: Aprire un terminale e digitare: 

ln -s TargetFileOrFolder LinkName 
 

• Per esempio, per collegare un file chiamato "pippo" nella vostra cartella 
Downloads alla vostra cartella Documenti, digitate questo: 

 
ln -s ~/Downloads/foo ~/Documents/foo 



4.7.4 Trova file e cartelle 
 

GUI 
 

 
Figura 4-12: schermata di ricerca di Catfish che cerca "MX-" nella cartella Downloads 

 
Catfish è installato di default in MX Linux Xfce, e può essere lanciato dal Menu 
Applicazioni > Accessori, o semplicemente iniziando a digitare "cerca" nel campo di 
ricerca in alto. È anche integrato in Thunar in modo che l'utente possa fare clic destro su una 
cartella > Trova i file qui. 

 
Catfish home page 

 
Gli utenti di KDE/plasma possono accedere alla finestra di dialogo di ricerca integrata nella barra degli 
strumenti del gestore di file Dolphin. 

 

Figura 4-13: risultati della ricerca di Dolphin Find 
 

Altri software di ricerca più avanzati sono disponibili nei repo, come recoll. 

http://www.twotoasts.de/index.php/catfish/
https://www.lesbonscomptes.com/recoll/


CLI 
 

Ci sono alcuni comandi molto utili da usare in un terminale. 
 

• localizzare. Per ogni schema dato, locate cerca uno o più database di nomi di file e 
visualizza quelli che contengono lo schema. Per esempio, digitando: 

individuare firefox 

restituirà un elenco estremamente lungo con ogni singolo file che ha la parola "firefox" 
nel suo nome o nel suo percorso. Questo comando è simile a find ed è meglio usarlo 
quando il nome esatto del file è noto. 

 
Individuare esempi 

 
• whereis. Un altro strumento a riga di comando, installato di default. Per ogni schema 

dato, whereis cerca in uno o più database di nomi di file e visualizza i nomi di file che 
contengono lo schema, ma ignora i percorsi in modo che la lista di ritorno sia molto 
più breve. Per esempio, digitando: 

whereis firefox 

restituirà una lista molto più corta, come questa: 

firefox: /usr/bin/firefox /etc/firefox /usr/lib/firefox 
/usr/bin/X11/firefox /usr/share/firefox 
/usr/share/man/man1/firefox.1.gz 

Esempi di Whereis 
 

• quale: Probabilmente lo strumento più comodo di tutti, questo comando cerca di 
identificare l'eseguibile. Per esempio, digitando: 

quale firefox 

restituisce un singolo elemento: 

/usr/bin/firefox 

Quali esempi 
 

4.7.5 Uccidere i programmi di fuga 
 

• Desktop 
 

1. Premi Ctrl-Alt-Esc per cambiare il cursore in una "x". Clicca su qualsiasi 
schermata aperta per ucciderla, clicca con il tasto destro per cancellarla. Fai 
attenzione a non cliccare sul desktop o la tua sessione terminerà bruscamente. 

 
2. Xfce - Task Manager: Menu Applicazione > Preferiti, o clicca su Menu 

Applicazione > Sistema > Task Manager. Seleziona il processo che vuoi e 
clicca con il tasto destro per fermare, terminare o uccidere. 

http://www.tecmint.com/35-practical-examples-of-linux-find-command/
http://www.thegeekstuff.com/2012/03/locate-command-examples/
http://www.cyberciti.biz/faq/unix-linux-whereis-command-examples-to-locate-binary/
http://www.thegeekstuff.com/2013/04/linux-which-whatis-whereis/


1. KDE/plasma - Menu Applicazione > Preferiti, oppure clicca su Menu 
Applicazione > Sistema > Monitor di sistema 

 
3. È disponibile anche uno strumento tradizionale: clicca su Application Menu > 

System > Htop, che fa apparire un terminale che mostra tutti i processi in 
esecuzione. Individua il programma che vuoi fermare, evidenzialo, premi F9 e 
poi Return. 

 
 
 

• Terminale: Premere Ctrl-C, che di solito fermerà un programma/comando iniziato 
in una sessione di terminale. 

 
• Se le soluzioni di cui sopra non funzionano, provate questi metodi più estremi 

(elencati in ordine crescente di gravità). 
 

1. Riavvia X. Premi Ctrl-Alt-Bksp per uccidere tutti i processi della sessione, 
lasciandoti indietro alla schermata di accesso. Qualsiasi lavoro non salvato 
sarà perso. 

 
2. Usare il tasto magico SysRq (REISUB). Tenete premuto il tasto Alt (a volte 

solo il tasto Alt sinistro funziona) insieme al tasto SysRq (può essere anche 
etichettato come Print Screen o PrtScrn) con un'altra mano, poi lentamente, 
senza rilasciare Alt-SysRq, premete i tasti R-E-I-S-U-B uno dopo l'altro. 
Tenete premuto ogni tasto della sequenza REISUB per circa 1 o 2 secondi 
prima di passare al tasto successivo; il vostro sistema dovrebbe spegnersi 
correttamente e riavviarsi. Lo scopo di questo tasto magico è di passare 
attraverso diverse fasi che infermano il vostro sistema in modo sicuro da un 
guasto di qualche tipo, e spesso solo le prime 2 lettere sono sufficienti. Questo 
è quello che succede quando si passa attraverso le lettere: 

 
• R - cambia la modalità della tastiera. Si dice che questo "Switch the 

keyboard from raw mode, the mode used by programs such as X11 and 
svgalib, to XLATE mode" (da Wikipedia), ma non è sicuro che questo 
abbia normalmente qualche effetto degno di nota. 

 
• E - termina con grazia tutti i programmi in esecuzione. Questo invia 

il segnale SIGTERM a tutti i processi eccetto init e quindi chiede 
loro di terminare con grazia, dando loro la possibilità di riordinare e 
liberare le loro risorse, salvare i dati, ecc... 

 
• I - uccide forzatamente tutti i programmi in esecuzione. Questo è 

simile alla E, ma invia il segnale SIGKILL a tutti i processi tranne init, 
che li uccide immediatamente e forzatamente. 

 
• S - sincronizza tutti i dischi e lava le loro cache. Tutti i tuoi dischi 

https://en.wikipedia.org/wiki/Magic_SysRq_key


normalmente hanno una cache di scrittura, un pezzo di RAM dove il 
sistema memorizza i dati che vuole salvare sul dispositivo, per velocizzare 
l'accesso. La sincronizzazione dice al sistema di lavare 



queste cache ora ed eseguire tutte le scritture rimanenti. In questo modo 
non si perde nessun dato che è già stato memorizzato nella cache ma non 
ancora scritto, e si evita di lasciare il file system in uno stato 
inconsistente. 

 
• U - smonta tutti i dischi e rimontali in sola lettura. Questo è di nuovo 

abbastanza poco spettacolare, semplicemente rende tutti i dischi montati 
in sola lettura per prevenire qualsiasi ulteriore scrittura (parziale). 

 
• B - riavvia il sistema. Questo riavvia il sistema. Tuttavia, non 

esegue un arresto pulito, ma invece un hard reset. 
 

Wikipedia: REISUB 
 

3. Se non funziona nient'altro, tieni premuto il pulsante di accensione del tuo 
computer per 10 secondi circa finché non si spegne. 

 

 

Figura 4-14: Task Manager, pronto a uccidere un processo. IN ALTO: KDE/plasma FONDO: Xfce 
 

4.7.6 Prestazioni della pista 

Generale 
 

• GUI 
 

• Clicca su Application Menu > System > System Profiler and Benchmark, 
dove puoi non solo vedere molte specifiche ma anche eseguire test di 
performance. 

 
• Molti conkies mostrano le prestazioni del sistema; usate Conky Manager per 

vederne l'anteprima in base alle vostre esigenze e preferenze. Vedi Sezione 
3.8.3. 

 
• Plugin Xfce. Xfce 4.12 porta un certo numero di plugin per il monitoraggio 

del sistema che possono essere inseriti nel pannello, tra cui Battery Monitor, 
CPU Frequency Monitor, CPU Graph, Disk Performance Monitor, Free 
Space Checker, Network Monitor, Sensor plugin, System Load Monitor e 

https://en.wikipedia.org/wiki/Magic_SysRq_key


Wavelan. Essi 



possono essere tutti installati con il metapacchetto xfce4-goodies. KDE/plasma 
ha un insieme simile di pannelli e widget per il desktop. 

 
Home page di Xfce4 Goodies 

 
• CLI 

 
• lm-sensors. Questo pacchetto di monitoraggio della salute dell'hardware è 

installato di default in MX Linux. Aprire un terminale, diventare root ed 
entrare: 

sensori-rileva 

Cliccate su Return per rispondere sì a tutte le domande. Quando ha finito, potrai 
ottenere informazioni dettagliate sulle letture dei sensori che sono disponibili sul 
tuo sistema aprendo un terminale e digitando: sensors. 

 
Lm-sensors home page 

 

Batteria 
 

Il livello della batteria è monitorato dal plugin Power Manager sul pannello. Un plugin dedicato 
per il pannello chiamato Battery Monitor è disponibile anche facendo clic con il tasto destro del 
mouse su Pannello > Pannello > Aggiungi nuovi elementi ... KDE ha un widget del pannello 
Battery Monitor installato in modo predefinito. 

 

4.7.7 Pianifica i compiti 
 

• GUI 
 

• MX Job Scheduler, vedi 3.2.11. 
 

• Compiti programmati (gnome-schedule). Un modo molto comodo per 
programmare i compiti di sistema senza dover modificare direttamente i file di 
sistema. Home page di Gnome-schedule. 

 
• KDE ha un Task Scheduler con capacità simili. 

 

http://goodies.xfce.org/projects/panel-plugins/start
https://wiki.archlinux.org/index.php/Lm_sensors
http://gnome-schedule.sourceforge.net/
https://userbase.kde.org/System_Settings/Task_Scheduler


Figura 4-15: Schermata principale del Task Scheduler di KDE 



• CLI 
 

• È possibile modificare crontab, un file di testo con una lista di comandi da 
eseguire in momenti specifici. 

 
Panoramica di Crontab 

 
Generatore di crontab facile 

 

4.7.8 Tempo corretto 
 

L'impostazione corretta dell'ora è normalmente curata all'avvio di Live o durante l'installazione. 
Se l'ora dell'orologio è sempre sbagliata, ci sono 4 possibili problemi: 

 
• fuso orario sbagliato 

 
• selezione errata di UTC rispetto all'ora locale 

 
• Orologio del BIOS impostato male 

 
• deriva del tempo 

 
Questi problemi sono affrontati più facilmente usando l'applicazione appropriata di Date & 
Time; per le tecniche della linea di comando, vedere il Wiki di MX/antiX. 

 

4.7.9 Mostra il blocco della chiave 
Su molti portatili non c'è un indicatore luminoso per l'attivazione dei tasti CapsLock o 
NumLock, il che può essere molto fastidioso. Per risolvere questo problema con un notificatore 
sullo schermo, installate indicator-keylock dai repo. 

 

4.8 Buone pratiche 

4.8.1 Backup 
La pratica più importante è quella di eseguire regolarmente il backup dei dati e dei file di 
configurazione, un processo che è facile in MX Linux. Si raccomanda vivamente di fare il 
backup su un disco diverso da quello su cui si trovano i dati! L'utente medio troverà comodo uno 
dei seguenti strumenti grafici. 

https://mxlinux.org/wiki/system/crontab/
http://crontab-generator.org/
https://mxlinux.org/wiki/system/time-settings
https://wiki.archlinux.org/index.php/Backup_programs
https://wiki.archlinux.org/index.php/Backup_programs


 
 

Figura 4-16: Schermata principale di Lucky Backup 
 

• gRsync, un frontend grafico per rsync. 
 

Panoramica di gRsync 
 

• LuckyBackup. Un programma facile per il backup e la sincronizzazione dei file. Installato di default. 
 

Manuale di LuckyBackup 
 

• Déjà Dup. Uno strumento di backup semplice ma molto efficace. 
 

Déjà Dup pagina iniziale 
 

• BackInTime. Un'applicazione ben collaudata disponibile da MX Package Installer > 
MX Test Repo (preinstallata su MX KDE) 

 
 
 

• Servizio cloud. Ci sono molti servizi cloud che possono essere utilizzati per il 
backup o la sincronizzazione dei dati. DropBox e Google Drive sono 
probabilmente i più noti, ma ne esistono molti altri. 

 
• Clonazione. Crea un'immagine completa del disco 

rigido. 
 

• Clonezilla. Scaricate Clonezilla Live dalla home page di Clonezilla, e poi 
riavviatelo. 

 
• Timeshift. Backup/ripristino completo del sistema; nei repo. La home 

page di Timeshift include una panoramica dettagliata e un how-to. 
 

• Salvare il sistema in una ISO live (sezione 
6.6.3). 

https://en.wikipedia.org/wiki/Rsync
https://www.dedoimedo.com/computers/grsync.html
http://luckybackup.sourceforge.net/manual.html
https://launchpad.net/deja-dup
http://clonezilla.org/
http://clonezilla.org/
https://github.com/teejee2008/timeshift
https://github.com/teejee2008/timeshift
https://github.com/teejee2008/timeshift
https://github.com/teejee2008/timeshift


• Strumenti CLI. Vedere la discussione nella Wiki di Arch: Clonazione di 
 

• Comandi CLI per fare backup (rsync, rdiff, cp, dd, tar, ecc.). 
 

Dati 
 

Assicurati di fare il backup dei tuoi dati, inclusi documenti, grafica, musica e posta. Per 
impostazione predefinita, la maggior parte di questi sono memorizzati nella directory /home; si 
consiglia, se possibile, di avere una partizione dati separata, meglio se in una posizione dati 
esterna. 

 
File di configurazione 

 
Ecco una lista di elementi da considerare per il backup. 

 
• /home. Contiene la maggior parte dei file di configurazione personali. 

 
• /root. Mantiene le modifiche che hai fatto come root. 

 
• /etc/X11/xorg.conf. X file di configurazione, se ce n'è uno. 

 
• I file GRUB2 /etc/grub.d/ e /etc/default/grub. 

 
Elenco dei pacchetti di programmi installati 

 
È anche una buona idea salvare nella vostra directory /home o nel cloud (Dropbox, Google 
Drive, ecc.) un file che contiene la lista dei programmi che avete installato con Synaptic, apt-get 
o Gdebi. Se in futuro avrete bisogno di reinstallare, potrete recuperare i nomi dei file per la 
reinstallazione. 

 
Un comodo strumento per elencare i pacchetti installati da quando il sistema è stato inizialmente 
installato può essere trovato cliccando con il tasto destro sull'icona MX Updater nell'area di 
notifica > Apt History. Apparirà un elenco di programmi installati tramite il sistema apt che puoi 
copiare e incollare in un documento per memorizzare e fare riferimento. 

 
Potete creare un inventario di tutti i pacchetti installati sul vostro sistema dall'installazione 
copiando questo lungo comando ed eseguendolo in un terminale: 

dpkg -l | awk '/^[i|h]i/{ print $2 }' | grep -v -e ^lib[0-q\|s-z] -e ^libr[0-d\|f-z] -e ^libre[0-n\|p-z] -e -dev$ -e -dev: - 
e linux-image -e linux-headers | awk '{print $1" installed"}' | column -t > apps_installed.txt 

Questo creerà un file di testo nella vostra directory home chiamato "apps_installed.txt" che 
contiene tutti i nomi dei pacchetti. 

 
Per reinstallare TUTTI quei pacchetti in una volta sola: assicuratevi che tutti i repository 
necessari siano abilitati, quindi eseguite questi comandi uno alla volta: 

su 
dpkg \SpecialChar nobreakdash\SpecialChar nobreakdashset-selections < 
apps_installed.txt 
apt-get update 

https://wiki.archlinux.org/index.php/disk_cloning


apt-get dselect-upgrade 

NOTA: questo non dovrebbe essere tentato tra versioni di MX basate su versioni diverse di 
Debian (ad esempio, da MX-14.4 a MX-15 o MX-16) 

 
C'è uno strumento aptik nei repo che può aiutare se usato con cautela. È stato sviluppato per 
Ubuntu, ma farà risparmiare un sacco di fatica anche in MX Linux, soprattutto per quanto 
riguarda i file di impostazione che tendono ad essere trascurati. 

 

4.8.2 Manutenzione del disco 
Quando un sistema invecchia, spesso accumula dati che non vengono più utilizzati e riempie 
gradualmente il disco. Tali problemi possono essere alleviati dall'uso periodico di MX Cleanup. 

Vediamo un esempio. Quando la sua macchina stava rallentando, un utente ha controllato lo 
spazio libero sul disco usando inxi -D ed è rimasto sorpreso nel vedere che il disco era pieno al 
96%. Cliccando sul pulsante Run Disk Usage Analyzer in MX Cleanup ha fornito una buona 
analisi grafica, e cliccando sui grandi segmenti rossi ha rivelato che la cache era gonfia. 

 

Figura 4-17. Disk Usage Analyzer che visualizza una directory principale quasi piena 

Dopo essere stato pulito usando MX User Manager, la percentuale è scesa a circa il 63% e la 
lentezza è sparita. 

 

Figura 4-18. I risultati della cancellazione della cache come rappresentati da Disk Usage Analyzer 

https://mxlinux.org/wiki/other/application-migration-aptik


Deframmentazione di 
Gli utenti provenienti da Windows potrebbero chiedersi se sia necessario deframmentare 
periodicamente il disco. La deframmentazione non è probabilmente necessaria sul file system 
ext4 di default di MX, ma se è quasi pieno e non ha un'area contigua abbastanza grande per 
allocare il vostro file, vi ritroverete con la frammentazione. Potete controllare lo stato, se 
necessario, con questo comando: 

sudo e4defrag -c / 
 

Vedrete dopo pochi secondi un punteggio e una semplice dichiarazione se ha bisogno di 
deframmentazione o no. 

 

4.8.3 Controllo degli errori 
Molti messaggi di errore sono scritti nel file appropriato in /var/log/ che copre problemi 
nelle applicazioni, eventi, servizi e sistema. Alcuni importanti includono: 

• /var/log/boot 

• /var/log/dmesg 

• /var/log/kern.log 

• /var/log/messaggi 

• /var/log/Xorg.0.log 

Non sono sempre facili da leggere, ma spesso vale la pena guardarli se si sospetta un problema. 
Potete guardarli in un terminale usando il comando cat seguito dalla posizione del log che 
volete vedere. 

 

4.9 Giochi 
Scorrendo l'ampia lista di giochi disponibili attraverso Synaptic (clicca su Sections > Games in 
fondo al pannello di sinistra) o seguendo i link qui sotto, troverai molti altri titoli per il tuo 
divertimento. 

La seguente lista contiene alcuni esempi per stuzzicare l'appetito. 
 

4.9.1 Giochi di avventura e sparatutto 
• Chromium B.S.U.: Un veloce sparatutto spaziale a scorrimento dall'alto in stile 

arcade. Installato di default. 

Home page di Chromium B.S.U. 

• Beneath A Steel Sky: Un thriller fantascientifico ambientato in un tetro futuro post-

apocalittico. Beneath a Steel Sky home page 

• Kq: un gioco di ruolo in stile console, simile a Final Fantasy. 

Kq home page 

• Marte. "Un ridicolo tiratore". Proteggi il pianeta dai tuoi vicini gelosi! 

http://chromium-bsu.sourceforge.net/
https://en.wikipedia.org/wiki/Beneath_a_Steel_Sky
http://kqlives.sourceforge.net/


Home page di Marte 
 

 
Figura 4-19: Navi da guerra nemiche all'attacco in Chromium B.S.U 

 
4.9.2 Giochi arcade 

• Defendguin: Un clone di Defender, dove la tua missione è difendere i piccoli 

pinguini. Home page di Defendguin 

• Bolla congelata: Le bolle colorate sono congelate nella parte superiore dello schermo di 
gioco. Mentre la Pressa del ghiaccio scende, devi far scoppiare gruppi di bolle congelate 
prima che la Pressa raggiunga il tuo tiratore. 

Home page di Frozen Bubble 

• Planet Penguin Racer: un divertente gioco di corse con il tuo pinguino preferito. 

• Tuxracer home page 

• Ri-li: Un gioco di treni 

giocattolo. Ri-li home 

page 

• Supertux: Un classico gioco 2D a scorrimento laterale con salto e corsa in uno stile 
simile ai giochi originali di SuperMario. 

Home page di Supertux 

• Supertuxkart: Una versione molto migliorata di 

tuxkart. Pagina iniziale di Supertuxcart 

http://mars-game.sourceforge.net/?page_id=972
http://www.newbreedsoftware.com/defendguin
http://www.frozen-bubble.org/
http://tuxracer.sourceforge.net/
http://ri-li.sourceforge.net/
http://ri-li.sourceforge.net/
http://supertux.lethargik.org/
http://supertuxkart.sourceforge.net/


 
 

Figura 4-20: Il treno Ri-li deve girare presto 
 

4.9.3 Giochi da tavolo 
 

• Giochi Gottcode: tra quelli disponibili, Peg-E (gioco solitario Peg) installato di default. 
 

Gottcode pagina iniziale 
 

• Mine (gnomine): Un gioco di mine per 1 giocatore. 
 

Home page delle miniere 
 

• Do'SSi Zo'la: L'obiettivo del gioco base dell'Isola è quello di bloccare l'avversario 
distruggendo i quadrati che lo circondano. 

 
Do'SSi Zo'la home page 

 
• Gnuchess: Un gioco di scacchi. 

 
Gnuchess home page 

http://gottcode.org/
https://wiki.gnome.org/Apps/Mines
http://dossizola.sourceforge.net/
http://www.gnu.org/software/chess


 
 

Figura 4-21: Momento di alta tensione nelle miniere. 
 

4.9.4 Giochi di carte 
 

Ecco alcuni divertenti giochi di carte disponibili nei repo. 
 

• Pysolfc: Oltre 1.000 giochi di solitario da una singola applicazione. 
 

Home page di Pysolfc 
 

4.9.5 Divertimento da tavolo 
 

• Xpenguins. I pinguini camminano sullo schermo. Può essere personalizzato con 
altri personaggi come Lemmings e Pooh Bear (è necessario consentire 
l'esecuzione di programmi nella finestra principale). 

 
Xpenguins home page 

 
• Oneko. Un gatto (neko) segue il vostro cursore (il mouse) sullo schermo. Può 

essere personalizzato con un cane o un altro animale. 
 

Wikipedia: Neko 
 

• Algodoo. Questo gioco gratuito presenta un sandbox di fisica 2D dove si può giocare 
con la fisica come mai prima d'ora. La sinergia giocosa di scienza e arte è nuova, e lo 
rende tanto educativo quanto divertente. 

http://pysolfc.sourceforge.net/
http://xpenguins.seul.org/
https://en.wikipedia.org/wiki/Neko_(software)


Pagina iniziale di Algodoo 
 

• Xteddy. Mette un simpatico orsacchiotto sul vostro desktop. In alternativa puoi aggiungere la tua 
immagine. 

 
Xteddy homepage 

 
• Tuxpaint. Un programma di disegno per bambini di tutte le età. 

 
Home page di Tuxpaint 

 

 
Figura 4-22: Genio in erba al lavoro in Tuxpaint 

 
4.9.6 Bambini 

• Tre pacchetti di giochi e applicazioni educative sono disponibili da MX Package 
Installer. 

• Inoltre, Scratch è un linguaggio di programmazione gratuito e una comunità online 
dove puoi creare le tue storie interattive, giochi e animazioni. Installatore di pacchetti 
MX. 

 

 

http://www.algodoo.com/
http://staffwww.itn.liu.se/%7Estegu/xteddy/index.html
http://www.tuxpaint.org/
https://scratch.mit.edu/


Figura 4-23: Schermata di codifica per Dance Party usando Scratch 



4.9.7 Giochi di tattica e strategia 
 

• Freeciv: Un clone di Sid Meyer's Civilization© (versione I), un gioco di strategia 
multiplayer a turni, in cui ogni giocatore diventa il leader di una civiltà dell'età della 
pietra, cercando di ottenere l'ascendenza con il progredire delle epoche. 

 
Home page di Freeciv 

 
• Lbreakout2: LBreakout2 è un gioco arcade in stile breakout dove si usa la paletta per 

puntare una palla contro i mattoni fino a quando tutti i mattoni vengono distrutti. Molti 
livelli e sorprese. Installato di default. 

 
Lgames home page 

 
• Lincity: Un clone dell'originale Simcity. Dovete costruire e mantenere una città e 

mantenere la sua gente soddisfatta in modo che la vostra popolazione cresca. 
 

Lincity home page 
 

• Battaglia per Wesnoth: Un gioco di strategia a turni molto apprezzato con un tema 
fantasy. Costruisci il tuo esercito e combatti per riconquistare il trono. 

 
Home page di Battle for Wesnoth 

 

 
Figura 4-24: Cercare di sfondare il primo muro in Lbreakout 

 
4.9.8 Giochi per Windows 

 
Un certo numero di giochi per Windows possono essere giocati in MX Linux usando un 
emulatore di Windows come Cedega o DOSBox, o alcuni possono anche girare sotto Wine: 
vedi Sezione 6.1. 

http://www.freeciv.org/
http://lgames.sourceforge.net/
http://lincity.sourceforge.net/
http://www.wesnoth.org/


4.9.9 Servizi di gioco 
 

 
Figura 4-25: Peccati di un impero solare: Rebellion in esecuzione su Steam con Proton 
Esistono varie collezioni e servizi per l'utente che desidera giocare su MX Linux. Due dei più 
noti sono facilmente installabili con MX Package Installer. 

• PlayOnLinux. Un frontend grafico per Wine (Sezione 6.1) che permette agli utenti 
Linux di installare e usare facilmente numerosi giochi e applicazioni progettati per 
funzionare con Microsoft® Windows®. 

Homepage di PlayOnLinux. 

• Steam. Una piattaforma proprietaria di distribuzione digitale per acquistare e giocare ai 
videogiochi che fornisce l'installazione e l'aggiornamento automatico dei giochi. Include 
Proton, una distribuzione modificata di Wine. 

Homepage del vapore 
 

4.10 Strumenti di Google 

4.10.1 Gmail 
 

Gmail può essere facilmente impostato in Thunderbird seguendo le istruzioni. Può anche essere 
facilmente accessibile in qualsiasi browser. 

 

4.10.2 Contatti di Google 
 

I contatti di Google possono essere collegati a Thunderbird usando il componente aggiuntivo 

gContactSync. gContactSync home page 

4.10.3 Gcal 
 

Gcal può essere impostato su una scheda in Thunderbird con gli add-on Lightning e Google 

Calendar Tab. Pagina iniziale del calendario Lightning 

https://www.playonlinux.com/en/
https://store.steampowered.com/
http://www.pirules.org/addons/gcontactsync/
https://www.mozilla.org/en-US/projects/calendar/


4.10.4 Gtasks 
 

Gtasks può essere incluso in Thunderbird spuntando la voce Tasks del calendario. 
 

4.10.5 Google Earth 
 

Il metodo più semplice per installare Google Earth è usando MX Package Installer, dove si 
trova nella sezione "Misc". 

 
C'è anche un metodo manuale che può essere utile in alcune installazioni. 

 
• Installare googleearth.package dai repo o direttamente dal repo di Google. 

 
• Aprire un terminale ed entrare: 

make-googleearth-package 

• Una volta finito, diventate root e digitate: 

dpkg -i googleearth*.deb 

• Un messaggio di errore apparirà sullo schermo riguardo a problemi di dipendenza. 
Correggetelo inserendo quest'ultimo comando (sempre come root): 

apt-get -f install 

Ora finalmente Google Earth apparirà in Application Menu > Internet. 
 

4.10.6 Google Talk 
 

C'è un plugin per il browser chiamato google-talkplugin disponibile nei repo di Google che ti 
permette di fare una chiamata vocale o video dal tuo account Gmail ad un altro utente Gmail. 
È stato sostituito da Google Duo che può essere eseguito direttamente da Gmail aperto in un 
browser 

 

4.10.7 Google Drive 
Esistono comodi strumenti che forniscono un accesso locale al tuo account GDrive. 

• Una semplice app gratuita chiamata Odrive si installa e funziona bene. 

• L'app proprietaria multipiattaforma Insync permette la sincronizzazione selettiva e 
l'installazione su più computer. 

 

4.11 Bug, problemi e richieste 
I bug sono errori in un programma o sistema informatico che producono risultati errati o 
comportamenti anomali. "Richieste" o "miglioramenti" sono aggiunte richieste dagli utenti, sia 
come nuove applicazioni o nuove caratteristiche per applicazioni esistenti. MX Linux si 
occupa di queste nel modo seguente: 

 
• I bug sono gestiti per mezzo di MX e antiX Linux Bug Tracker. 

https://www.google.co.uk/earth/download/gep/agree.html
https://tools.google.com/dlpage/hangoutplugin
https://duo.google.com/
https://www.omgubuntu.co.uk/2019/02/odrive-google-drive-linux-client
https://www.insynchq.com/google-drive-linux
http://bugs.mxlinux.org/
https://us-bz3.devzing.com/mx_antix/


• Le richieste possono essere fatte con un post nel Forum dei bug e delle richieste, 
facendo attenzione a fornire informazioni su hardware, sistema e altri dettagli 

 
• Gli sviluppatori e i membri della comunità risponderanno a questi post con 

domande, suggerimenti, ecc. 
 
 

Figura 4-26: cruscotto del gestore di bug 

https://forum.mxlinux.org/viewforum.php?f=97


5 Gestione del software 
5.1 Introduzione 

5.1.1 Metodi 
 

MX Linux offre due metodi complementari di gestione del software: 
 

• MX Package Installer (MXPI) per l'installazione/rimozione con un solo clic delle 
applicazioni più popolari, così come delle applicazioni in Debian Stable, MX Test Repo, 
Debian Backports e Flatpaks repo. Vedere Sezione 3.2.11. 

 
• Synaptic Package Manager, uno strumento grafico completo per tutta una serie di 

azioni con i pacchetti Debian. 
 

MXPI ha una serie di vantaggi rispetto a Synaptic: 
 

• È molto più veloce! 
 

• La scheda Applicazioni popolari è limitata ai pacchetti usati più spesso, quindi tutto è 
facile da trovare. 

 
• Installa correttamente alcuni pacchetti che altrimenti sono complicati da fare 

correttamente (per esempio, Wine). 
 

• Include altre fonti oltre a Debian Stable in una singola applicazione: 
 

◦ Il nostro MX Test Repo con pacchetti più nuovi di quelli che Synaptic ha di default. 
 

◦ Debian Backports. 
 

◦ Flatpaks, non disponibile in Synaptic. 
 

Synaptic ha i suoi vantaggi: 
 

• Ha un gran numero di filtri avanzati impostati come Sezioni (categorie), Stato, ecc. 
 

• Offre informazioni dettagliate su pacchetti particolari. 
 

• Rende molto facile aggiungere nuovi repository di software. 



Questa sezione 5 si concentra su Synaptic, che è il metodo raccomandato ai principianti per 
gestire i pacchetti software oltre le capacità di MX Package Installer. Vedrà anche altri metodi 
che sono disponibili e che possono essere necessari per certe situazioni. 

 

5.1.2 Pacchetti 
 

Le operazioni di software in MX sono realizzate dietro le quinte attraverso il sistema Advanced 
Package Tool (APT). Il software viene fornito sotto forma di pacchetto: un fascio di dati 
discreti e non eseguibili che include le istruzioni per il gestore dei pacchetti per l'installazione. I 
pacchetti sono memorizzati su server chiamati repository (repo), e possono essere consultati, 
scaricati e installati attraverso uno speciale software client chiamato gestore di pacchetti. 

 
La maggior parte dei pacchetti ha una o più dipendenze, il che significa che hanno uno o più 
pacchetti che devono essere installati per poter funzionare. Il sistema APT è progettato per 
gestire automaticamente le dipendenze per te; in altre parole, quando cerchi di installare un 
pacchetto le cui dipendenze non sono già installate, il tuo gestore di pacchetti APT segnerà 
automaticamente anche quelle dipendenze per l'installazione. Può succedere che queste 
dipendenze non possano essere soddisfatte, impedendo l'installazione di un pacchetto; posta tali 
problemi sul Forum. 

 
5.2 Repos 

I repository APT sono molto più che semplici siti web con software scaricabile. I pacchetti sui 
siti di repository sono appositamente organizzati e indicizzati per essere accessibili attraverso 
un gestore di pacchetti, piuttosto che sfogliati direttamente. 

 
ATTENZIONE: non aggiungere altri repository alla cieca a MX Linux! Questo è 
particolarmente vero  per DebianSid o un PPA, che è molto probabile che rompa la 
vostra installazione in modo irreparabile. 

 

5.2.1 Depositi standard 
 

MX Linux viene fornito con una serie di repository abilitati che vi offrono sia sicurezza che 
scelta. Se siete nuovi di MX Linux (e specialmente se siete nuovi di Linux), si raccomanda in 
generale di attenersi ai repo di default all'inizio. Per ragioni di sicurezza, questi repo sono firmati 
digitalmente, il che significa che i pacchetti sono autenticati con una chiave di crittografia per 
essere sicuri che siano autentici. Se si installano pacchetti da repo non Debian senza la chiave, si 
otterrà un avviso che non possono essere autenticati. Per sbarazzarsi di questo avviso e 
assicurarsi che le proprie installazioni siano sicure, è necessario installare le chiavi mancanti 
utilizzando le chiavi MX Fix GPG. 

 
I repo sono più facilmente aggiunti, abilitati/disabilitati, rimossi o modificati attraverso Synaptic, 
sebbene possano anche essere alterati a mano modificando i file in /etc/apt/ in un terminale di 
root. In Synaptic, clicca su Settings > repository, poi clicca sul pulsante New e aggiungi le 
informazioni. Le informazioni sui repo sono spesso date come una singola linea, come questa: 

https://en.wikipedia.org/wiki/APT_(Debian)
https://en.wikipedia.org/wiki/APT_(Debian)
https://en.wikipedia.org/wiki/APT_(Debian)


deb http://mxrepo.com/mx/testrepo/ stretch test 

http://mxrepo.com/mx/testrepo/


Fate attenzione a notare la posizione degli spazi, che separano le informazioni in quattro parti 
che sono poi inserite in righe separate in Synaptic. 

 

 
Figura 5-1: Repos, con il repo di prova MX evidenziato 

 
Alcuni depositi hanno etichette speciali: 

 
• contrib, che dipendono o sono accessori ai pacchetti non liberi. 

 
• non-free, che non soddisfano le linee guida del software libero Debian (DFSG). 

 
• sicurezza, che contengono solo aggiornamenti relativi alla sicurezza. 

 
• backports, che contengono pacchetti di versioni più recenti di Debian che sono stati 

compilati all'indietro per Debian Stable (la versione con cui MX è costruito) per 
mantenere il vostro sistema operativo aggiornato. 

 
• MX, che contengono i pacchetti speciali che rendono MX quello che è. 

 
L'elenco attuale dei repo standard di MX è tenuto nel Wiki MX/antiX. 

 

5.2.2 Repository della comunità 
 

MX Linux ha i suoi Community Repos con pacchetti che i nostri Packagers costruiscono e 
mantengono. Questi pacchetti sono distinti dai pacchetti ufficiali MX provenienti da Debian 
Stable, e contengono pacchetti da altre fonti: 

 
• Backports di Debian, da test o anche sperimentali 

 
• La nostra distro sorella antiX 

https://en.wikipedia.org/wiki/Debian_Free_Software_Guidelines
https://en.wikipedia.org/wiki/Debian_Free_Software_Guidelines
https://mxlinux.org/wiki/system/repos-mx-linux
https://antixlinux.com/


• Progetti indipendenti 
 

• Host open-source come GitHub 
 

I Community Repos sono fondamentali per MX Linux, poiché permettono ad un sistema 
operativo basato su Debian Stable di stare al passo con importanti sviluppi software. 

 
Oltre al repo MX Main, il repo MX Test ha lo scopo di ottenere un feedback dagli utenti prima 
che i nuovi pacchetti vengano spostati su Main. Il modo più semplice per installare da MX Test 
è con l'installatore di pacchetti MX (Sezione 3.2), poiché gestisce automaticamente molti 
passaggi. 

 
Per saperne di più su ciò che è disponibile, chi sono i confezionatori e anche come partecipare, 
vedi MX Community Packaging Project. 

 

5.2.3 Repository dedicati 
 

Oltre ai repository generali come Debian, MX e Community, esiste anche un certo numero di 
repository dedicati associati a una singola applicazione. Quando si aggiunge uno di essi, 
direttamente o attraverso Synaptic, si ricevono gli aggiornamenti. Alcuni sono precaricati ma 
non abilitati, altri li aggiungerai tu stesso. 

 
Ecco un esempio comune (VirtualBox): 

deb https://download.virtualbox.org/virtualbox/debian/stable contrib 
 

I nuovi utenti provenienti da Ubuntu o da una delle sue derivate spesso chiedono informazioni 
sui repo PPA; Ubuntu si discosta da Debian standard, quindi tali repo devono essere trattati con 
cautela. Consultare la Wiki di MX/antiX. 

 

5.2.4 Repository di sviluppo 
 

Un'ultima categoria di repository esiste per acquisire la build più recente (e quindi meno stabile) 
di un'applicazione. Questo viene fatto attraverso un sistema di controllo della versione come Git 
che può essere consultato dall'utente finale per rimanere al corrente dello sviluppo. Una copia 
del codice sorgente dell'applicazione può essere scaricata in una directory su una macchina 
locale. I repository del software sono un metodo conveniente per gestire i progetti utilizzando 
Git, e MX Linux mantiene la maggior parte del suo codice nel proprio repo GitHub. 

 
Di più: Wikipedia: Deposito di software 

 

5.2.5 Specchi 
 

I repo MX Linux sia per i pacchetti che per le ISO sono "mirrorati" su server in diversi siti nel 
mondo; lo stesso vale per i repo Debian. Questi siti mirror forniscono fonti multiple delle stesse 
informazioni e funzionano per ridurre il tempo di download, migliorare l'affidabilità e fornire 
una certa resilienza in caso di guasto del server. Durante l'installazione, il mirror più probabile 

https://en.wikipedia.org/wiki/GitHub
https://mxlinux.org/community-repos/
https://mxlinux.org/wiki/system/add-ppa-repository
https://github.com/MX-Linux
https://github.com/MX-Linux
https://github.com/MX-Linux
http://en.wikipedia.org/wiki/Software_repository


sarà 



selezionato automaticamente per voi in base alla posizione e alla lingua. Ma l'utente può avere 
ragioni per preferirne un'altra: 

 
• L'assegnazione automatica all'installazione può essere sbagliata in alcuni casi 

 
• L'utente può cambiare la residenza 

 
• Un nuovo specchio può diventare disponibile che è molto più vicino, più veloce o più affidabile 

 
• Un mirror esistente può cambiare il suo URL 

 
• Lo specchio utilizzato può diventare inaffidabile o andare offline 

 
MX Repo Manager (Sezione 3.2) rende facile cambiare mirror, permettendoti di scegliere quello 
che funziona meglio per te. Assicurati di prendere nota del pulsante che seleziona il mirror più 
veloce per la tua posizione. 

 
5.3 Sinaptico 

La seguente sezione cerca di fornire una panoramica aggiornata sull'uso di Synaptic. Notate 
che è richiesta la vostra password di root e, naturalmente, dovrete essere connessi a Internet. 

 

5.3.1 Installare e rimuovere i pacchetti 

Installazione di 
 

Ecco i passi fondamentali per installare il software in Synaptic: 
 

• Fare clic sul menu Start > Sistema > Synaptic Package Manager, fornendo 
la password di root se richiesto. 

 
• Premi il pulsante Reload. Questo pulsante fa sì che Synaptic contatti i server dei 

repository online e scarichi un nuovo file indice con informazioni su quali pacchetti 
sono disponibili, quali versioni sono, e quali altri pacchetti sono necessari per 
installarli. Se ricevi un messaggio che alcuni repository non sono riusciti ad essere 
contattati, aspetta un minuto e poi riprova. 

 
• Se conosci già il nome del pacchetto che stai cercando, basta cliccare nel riquadro 

sulla destra e iniziare a digitare; Synaptic cercherà in modo incrementale mentre digiti. 
 

• Se non conosci il nome del pacchetto, usa la casella di ricerca nell'angolo in alto a 
destra per individuare il software in base al nome o alle parole chiave. Questo è uno 
dei maggiori vantaggi di Synaptic rispetto ad altri metodi. 

 
• In alternativa, usa uno dei pulsanti di filtro nell'angolo in basso a sinistra: 



• Le sezioni forniscono sottoaree come Editori, Giochi e divertimenti, Utilità, 
ecc. Vedrete una descrizione di ogni pacchetto nel pannello inferiore e potrete 
usare le schede per scoprire più informazioni su di esso. 

 
• Status raggruppa i pacchetti in base alla loro situazione di installazione. 

 
• Origin mostrerà i pacchetti da un repository specifico. 

 
• Filtri personalizzati fornisce varie opzioni di filtro 

 
• Search Results mostrerà una lista di ricerche precedenti per la sessione di 

Synaptic in cui ti trovi. 
 

• Fai clic sulla casella vuota all'estremità sinistra del pacchetto che vuoi e seleziona 
Mark for Installation nella schermata pop-up. Se il pacchetto ha delle dipendenze, 
sarai avvisato e anche queste saranno automaticamente contrassegnate per 
l'installazione. Puoi anche fare semplicemente doppio clic sul pacchetto se è l'unico 
che stai installando. 

 
• Alcuni pacchetti hanno anche dei pacchetti "Raccomandati" e "Suggeriti" che 

possono essere visualizzati cliccando con il tasto destro sul nome del pacchetto. 
Questi sono pacchetti aggiuntivi che aggiungono funzionalità al pacchetto 
selezionato, ed è una buona idea esaminarli. 

 
• Cliccate su Apply per iniziare l'installazione. Puoi tranquillamente ignorare 

qualsiasi messaggio di avvertimento: "Stai per installare un software che non può 
essere autenticato!" 

 
• Potrebbero esserci ulteriori passaggi: segui semplicemente le istruzioni che ricevi 

finché l'installazione non è completata. 
 

 
Figura 5-2: Controllo dei pacchetti raccomandati durante l'installazione dei pacchetti. 



Rimozione di 
 

La rimozione di software dal sistema con Synaptic sembra semplice come l'installazione, ma c'è 
più di quello che si vede: 

 
• Per rimuovere un pacchetto, basta cliccare sulla stessa casella dell'installazione e 

selezionare Mark for Removal o Mark for Complete Removal. 
 

• La rimozione disinstalla il software, ma lascia i file di configurazione del 
sistema nel caso vogliate mantenere le vostre impostazioni. 

 
• La rimozione completa rimuove il software e anche i file di configurazione del 

sistema (purging). I tuoi file di configurazione personali relativi al pacchetto 
non verranno rimossi. Controlla anche altri resti di file di configurazione nella 
categoria Not installed (residual config) di Synaptic. 

 
• Quando hai altri programmi che dipendono dal pacchetto che viene rimosso, anche 

quei pacchetti dovranno essere rimossi. Questo di solito accade quando si 
rimuovono librerie software, servizi o applicazioni a riga di comando che servono 
come back-end per altre applicazioni. Assicurati di leggere attentamente il riassunto 
che Synaptic ti dà prima di cliccare su OK. 

 
• La rimozione di grandi applicazioni che sono composte da molti pacchetti può portare 

complicazioni. Molte volte questi pacchetti sono installati usando un meta-pacchetto, 
che è un pacchetto vuoto che dipende semplicemente da tutti i pacchetti necessari 
all'applicazione. Il modo migliore per rimuovere un pacchetto complicato come questo 
è controllare l'elenco delle dipendenze del meta-pacchetto e rimuovere i pacchetti 
elencati lì. Fate attenzione, però, a non disinstallare una dipendenza di un'altra 
applicazione che volete mantenere! 

 
• Potreste scoprire che la categoria di stato Autoremoveable inizia ad accumulare 

pacchetti. Questi sono stati installati da altri pacchetti e non sono più necessari, quindi 
puoi fare clic su quella categoria di stato, evidenziare tutti i pacchetti nel pannello di 
destra e poi fare clic con il tasto destro per rimuoverli. Assicuratevi di esaminare 
attentamente l'elenco quando appare la casella di verifica, perché a volte potreste 
scoprire che le dipendenze elencate per la rimozione includono pacchetti che in realtà 
volete mantenere. Usate apt -s autoremove per fare una prova simulata (= 
l'interruttore -s) se non siete sicuri. 



 
 

Figura 5-3: Prepararsi a liberare i pacchetti auto-rimovibili. 
 

5.3.2 Upgrade e downgrading 
 

Synaptic vi permette di mantenere rapidamente e comodamente il vostro sistema aggiornato. 
 

Aggiornamento di 
 

A meno che tu non stia usando un metodo manuale in Synaptic o un terminale, l'aggiornamento 
è tipicamente innescato da un cambiamento nell'icona di MX Updater nell'area di notifica 
(default: la casella vuota diventa verde). Ci sono due modi per procedere quando appare questa 
freccia. 

 
• Cliccate con il tasto sinistro del mouse sull'icona. Questo è il metodo più veloce 

perché non c'è attesa per il caricamento del software, l'esecuzione, ecc. Appare una 
finestra del terminale con i pacchetti da aggiornare; esaminali attentamente, poi clicca 
su OK per completare il processo. 

 
• Cliccate con il tasto destro del mouse sull'icona per usare invece Synaptic. 

 
• Fai clic sull'icona Mark All Upgrades sotto la barra dei menu per 

selezionare tutti i pacchetti disponibili per l'aggiornamento, oppure fai clic 
sul collegamento Installed (upgradable) nel pannello sinistro per rivedere i 
pacchetti o per selezionare gli aggiornamenti individualmente. 

 
• Fai clic su Apply per iniziare l'aggiornamento, ignorando il messaggio di 

avvertimento. Quando il processo di installazione inizia, hai la possibilità 
di guardare i dettagli in un terminale all'interno di Synaptic. 

 
• Con alcuni aggiornamenti dei pacchetti, potrebbe esservi chiesto di confermare una 

finestra di dialogo, inserire informazioni di configurazione o decidere se 
sovrascrivere o meno un file di configurazione che avete modificato. Fate 
attenzione e seguite le istruzioni fino a quando l'aggiornamento non sarà 
completato. 

 
Downgrading 

 



A volte potreste voler fare il downgrade di un'applicazione a una versione precedente, per 
esempio a causa di problemi sorti con quella nuova. Questo è facile da fare in Synaptic: 

 
1. Aprire Synaptic, fornire la password di root e cliccare su Reload. 



2. Clicca su Installed nel pannello a sinistra, poi trova ed evidenzia il pacchetto che 
vuoi declassare nel pannello a destra 

 
3. Sulla barra dei menu, fare clic su Pacchetto > Forza la versione... 

 
4. Seleziona tra le versioni disponibili nell'elenco a discesa. Potrebbero non esserci 

opzioni disponibili. 
 

5. Cliccate su Force Version, poi installate nel solito modo. 
 

6. Per evitare che quella versione inferiore venga immediatamente aggiornata di nuovo, è necessario 
bloccarla. 

 

 
Figura 5-4: usare Force version per fare il downgrade di un pacchetto 

 
Pinning 

 
A volte potreste voler bloccare un'applicazione a una versione specifica per evitare che venga 
aggiornata per evitare problemi con quelle più recenti. Questo è facile da fare: 

 
1. Aprire Synaptic, fornire la password di root e cliccare su Reload. 

 
2. Clicca su Installed nel pannello a sinistra, poi trova ed evidenzia il pacchetto che 

vuoi appuntare nel pannello a destra. 
 

3. Sulla barra dei menu, fare clic su Pacchetto > Blocca versione... 
 

4. Synaptic evidenzierà il pacchetto in rosso e aggiungerà un'icona di blocco alla prima colonna. 
 

5. Per sbloccare, evidenzia nuovamente il pacchetto e clicca su Package > Lock version 
(che avrà un segno di spunta). 

 
6. Si noti che il pinning tramite Synaptic non impedisce che il pacchetto venga 

aggiornato quando si usa la riga di comando. 



5.4 Risoluzione dei problemi 

Synaptic è molto affidabile, ma a volte si può ricevere un messaggio di errore. Una 
discussione completa di tali messaggi può essere trovata nella Wiki di MX/antiX, quindi qui 
menzioneremo solo un paio dei più comuni. 

 
• Si ottiene un messaggio che alcuni repo non sono riusciti a scaricare le informazioni 

del repository. Questo è di solito un evento transitorio e devi semplicemente 
aspettare e ricaricare; oppure puoi usare MX Repo Manger per cambiare repository. 

 
• Se l'installazione di un pacchetto mostra che il software che vuoi conservare sarà 

rimosso, clicca su Annulla per uscire dall'operazione. 
 

• Può succedere con un nuovo repository di vedere un messaggio di errore dopo il 
ricaricamento che dice qualcosa come: W: Errore GPG: [qualche URL del repository] 
Release: Non è stato possibile verificare le seguenti firme. Questo messaggio appare 
perché apt include l'autenticazione dei pacchetti per migliorare la sicurezza, e la 
chiave non è presente. Per risolverlo, clicca su Start menu > Sistema > MX Fix 
GPG keys e segui le istruzioni. Se non viene trovata alcuna chiave, chiedi sul forum. 

 
• Occasionalmente, i pacchetti non si installano perché i loro script di installazione 

falliscono uno o più controlli di sicurezza; per esempio, un pacchetto potrebbe cercare 
di sovrascrivere un file che fa parte di un altro pacchetto, o richiedere il downgrade di 
un altro pacchetto a causa delle dipendenze. Se hai un'installazione o un 
aggiornamento che è bloccato su uno di questi errori, è chiamato un pacchetto "rotto". 
Per risolverlo, clicca sulla voce Broken packages nel pannello di sinistra. Evidenzia il 
pacchetto e prova prima a risolvere il problema cliccando su Edit > Fix Broken 
Packages. Se questo non ha successo, allora fai clic con il tasto destro del mouse sul 
pacchetto per deselezionarlo o disinstallarlo. 

 
• Durante l'installazione o la disinstallazione, a volte appaiono messaggi importanti sul 

processo: 
 

• Disinstallare? Occasionalmente, conflitti nelle dipendenze dei pacchetti 
possono far sì che il sistema APT disinstalli un gran numero di pacchetti 
importanti per installare qualche altro pacchetto. Questo è raro con la 
configurazione predefinita, ma diventa sempre più probabile man mano che si 
aggiungono repo non supportati. SIATE MOLTO ATTENTI ogni volta che 
l'installazione di un pacchetto richiede la rimozione di altri! Se un gran 
numero di pacchetti sta per essere rimosso, potresti voler studiare un altro 
metodo di installazione di questa applicazione. 

 
• Mantenere? Durante l'aggiornamento, a volte si può essere informati che un 

nuovo file di configurazione è disponibile per un certo pacchetto, e viene 
chiesto se si vuole installare la nuova versione o mantenere la versione 

https://mxlinux.org/wiki/applications-system/synaptic-errors


attuale. 
 

• Se il pacchetto in questione proviene da un repository MX, si 
raccomanda di "installare la versione del manutentore". 



• Altrimenti, rispondi "mantenere la versione attuale" (N), che è 
anche la scelta predefinita. 

 
5.5 Altri metodi 

5.5.1 Attitudine 
 

Aptitude è un gestore di pacchetti che può essere usato al posto di apt o Synaptic. È 
disponibile dai repo ed è particolarmente utile quando sorgono problemi di dipendenza. Può 
essere eseguito come una CLI diretta o come una GUI primitiva. 

 

 
Figura 5-5: La schermata iniziale di Aptitude (GUI), che mostra il risolutore di dipendenze. 

 
Per i dettagli su questa opzione, vedere la Wiki di MX/antiX. 

 

5.5.2 Pacchetti Deb 
 

I pacchetti software installati tramite Synaptic (e APT dietro di esso) sono in un formato 
chiamato deb (abbreviazione di Debian, la distribuzione Linux che ha ideato APT). Puoi 
installare manualmente i pacchetti deb scaricati usando lo strumento grafico Gdebi o lo 
strumento a riga di comando dpkg. Questi sono semplici strumenti per installare i pacchetti deb 
locali. NOTA: se le dipendenze non possono essere soddisfatte, riceverete un avviso e il 
programma si fermerà. 

https://mxlinux.org/wiki/applications-system/aptitude


 
 

Figura 5-6: Gdebi pronto per l'installazione. 
 

Installare file *.deb con Gdebi 
 

1. Naviga fino al pacchetto deb che vuoi installare (tipicamente nella cartella 
Downloads) e cliccaci sopra. Gdebi aprirà la finestra di dialogo di installazione. 

 
2. Fare clic su Install. 

 
3. Inserisci la tua password di root quando richiesto. 

 
4. Gdebi tenterà di installare il pacchetto e riporterà i risultati. 

 
Installazione di file *.deb con dpkg 

 
1. Navigate alla cartella che contiene il pacchetto deb che volete installare. 

 
2. Cliccate con il tasto destro del mouse su uno spazio vuoto per aprire un terminale e 

diventare root. In alternativa, clicca sulla freccia per salire di un livello e clicca con il 
tasto destro del mouse sulla cartella con il pacchetto deb > Open Thunar here. 

 
3. Installare il pacchetto con il comando (sostituendo il vero nome del pacchetto, ovviamente): 

dpkg -i packagename.deb 

4. Se state installando più pacchetti nella stessa directory allo stesso tempo (per 
esempio se installate manualmente Libreoffice), potete farlo tutto in una volta 
usando: 

dpkg -i *.deb 

NOTA: In un comando di shell, l'asterisco è un jolly nell'argomento. In questo caso farà 
sì che il programma applichi il comando a qualsiasi file il cui nome finisce con .deb. 



5. Se le dipendenze richieste non sono già installate sul vostro sistema, otterrete errori di 
dipendenze non soddisfatte poiché dpkg non se ne occupa automaticamente. Per 
correggere questi errori e finire l'installazione, esegui questo codice per forzare 
l'installazione: 

apt -f install 

6. apt tenterà di correggere la situazione installando le dipendenze necessarie (se sono 
disponibili nei repo) o rimuovendo i vostri file .deb (se le dipendenze non possono 
essere installate). 

 
NOTA: il comando usato nel passo 5 qui sopra riflette il cambiamento dal nome legacy 

apt-get. 
 

5.5.3 Pacchetti autocontenuti 
 

 Lanciatori e appimages 
 

Appimages, flatpaks e snaps sono pacchetti autocontenuti che non hanno bisogno di essere 
installati nel senso usuale. Siate consapevoli che questi pacchetti non sono testati da Debian 
o MX Linux, quindi potrebbero non funzionare come previsto. 

 
• Appimages: basta scaricare, spostare in /opt (consigliato) e rendere eseguibile con 

un clic destro > Permessi. 
 

• Flatpaks: usa MXPI per ottenere app da flathub. 
 

• Snaps. Inaffidabile su MX Linux a meno che l'utente non abbia avviato systemd. 
Soluzione e dettagli nel riferimento Wiki qui sotto. 

 
Uno dei grandi vantaggi dei pacchetti autocontenuti è che qualsiasi software extra di cui 
hanno bisogno è incluso, e quindi non avrà un impatto negativo sul software già installato. 
Questo li rende anche molto più grandi dei tradizionali pacchetti installati. 

 
AIUTO: il Wiki di MX/antiX 

 

5.5.4 Metodi CLI 
 

È ugualmente possibile utilizzare la riga di comando per installare, rimuovere, aggiornare, 
cambiare i repo e in generale per gestire i pacchetti. Invece di lanciare Synaptic per eseguire 
compiti comuni. 

 
Tabella 5: Comandi comuni per gestire i pacchetti 

 

Comando Azione 

https://www.youtube.com/watch?v=RIvEMLWnkAU&t=3s
http://appimage.org/
https://en.wikipedia.org/wiki/Flatpak
https://snapcraft.io/
https://flathub.org/
https://mxlinux.org/wiki/system/self-contained-packages


apt install packagename Installare un certo pacchetto 
apt remove packagename Rimuovere un certo pacchetto 
apt purge packagename Rimuovere completamente un pacchetto (ma non la 

configurazione/dati in /home) 
apt autoremove Sgomberare i pacchi avanzati dopo un trasloco 

aggiornamento apt Aggiornare l'elenco dei pacchetti dai repo 
aggiornamento apt Installare tutti gli aggiornamenti disponibili 

apt dist-upgrade Gestire in modo intelligente le dipendenze che cambiano con le 
nuove versioni dei pacchetti 

5.5.5 Altri metodi di installazione 
 

Prima o poi alcuni software che vuoi installare non saranno disponibili nei repo e potresti 
aver bisogno di usare altri metodi di installazione. Questi metodi includono: 

 
• Blob. A volte ciò che si desidera non è in realtà un pacchetto installabile, ma un 

"blob" o una raccolta precompilata, non ".deb", di dati binari memorizzati come una 
singola entità, specialmente a sorgente chiusa. Tali blob si trovano tipicamente nella 
directory /opt. Esempi comuni includono Firefox, Thunderbird e LibreOffice. Per 
esempio, per installare la versione più recente di LibreOffice: 

 
• Ricerca sul web "libreoffice download ultima versione". 

Clicca: https://www.libreoffice.org/download/download/ 
 

• Seleziona la versione che vuoi, il tuo sistema operativo (ad esempio, Linux 
x64) e il formato del pacchetto (deb) 

 
• Clicca sul pulsante di download; dato che lo uso sempre, faccio sempre 

una piccola donazione 
 

• Una volta completato il download, vai nella cartella Downloads e fai clic 
con il tasto destro sull'archivio LibreOffice_xxx > Extract Here 

 
• Cliccate sulla cartella che è stata estratta, poi cliccate con il tasto destro 

del mouse sulla cartella DEBS > Open Terminal here 
 

• Inserisci questo codice 
 

sudo dpkg -i *.deb 
 

• Ora è installato e disponibile nella categoria Office del menu 
 

• Probabilmente vorrete rimuovere la vecchia versione, cosa che potete fare 
usando Synaptic per selezionare e rimuovere libreoffice-core, che porterà via 
con sé il resto. Assicurati di non rimuovere quella nuova! 

 

http://www.libreoffice.org/download/download/


• Crea un lanciatore aprendo il menu Start e cliccando con il tasto destro 
del mouse sulla voce LibreOffice > Aggiungi al pannello (o: Aggiungi 
al desktop). 



• Pacchetti RPM: Alcune distribuzioni di Linux usano il sistema di pacchetti RPM. I 
pacchetti RPM sono simili ai pacchetti deb in molti modi, e c'è un programma a riga 
di comando disponibile da MX Linux per convertire i pacchetti RPM in deb chiamato 
alien. Non viene installato con MX Linux, ma è disponibile nei repo di default. Dopo 
averlo installato sul vostro sistema, potete usarlo per installare un pacchetto rpm con 
questo comando (come root): alien -i packagename.rpm. Questo metterà un file deb 
con lo stesso nome nella posizione del file rpm che potrete poi installare come 
descritto sopra. Per informazioni più dettagliate su alien, consultate la versione 
internet della sua pagina man nella sezione Links in fondo a questa pagina. 

 
• Codice sorgente: Qualsiasi programma open-source può essere compilato dal codice 

sorgente originale del programmatore se non ci sono altre opzioni. In circostanze 
ideali, questa è in realtà un'operazione abbastanza semplice, ma a volte si può 
incorrere in errori che richiedono più abilità per risolverli. Il codice sorgente è 
solitamente distribuito come tarball (file tar.gz o tar.bz2). La tua migliore opzione è 
solitamente quella di fare una richiesta di pacchetto sul Forum, ma vedi i Links per un 
tutorial sulla compilazione dei programmi. 

 
• Varie: Molti sviluppatori di software confezionano il software nei loro modi 

personalizzati, di solito distribuiti come tarball o file zip. Possono contenere script di 
installazione, binari pronti all'uso, o programmi di installazione binari simili ai 
programmi setup.exe di Windows. In Linux, l'installatore spesso finisce in .bin. 
Google Earth, per esempio, è spesso distribuito in questo modo. In caso di dubbio, 
consulta le istruzioni di installazione fornite con il software. 

 

5.5.6 Link 
 

• MX/antiX Wiki: Errori sinottici 
 

• MX/antiX Wiki: Installazione di software 
 

• MX/antiX Wiki: Compilazione di 
 

• Gdebi 
 

• Gli strumenti di gestione dei pacchetti Debian 
 

• Strumenti di gestione dei pacchetti Debian 
 

• Guida Debian APT 
 

• Guida Debian APT 
 

• Wikipedia: Alien 

https://mxlinux.org/wiki/applications-system/synaptic-errors
https://mxlinux.org/wiki/system/installing-software
https://mxlinux.org/wiki/system/compiling
https://launchpad.net/gdebi
http://www.debian.org/doc/FAQ/ch-pkgtools.en.html
https://www.debian.org/doc/manuals/apt-guide/ch2.en.html
https://www.debian.org/doc/manuals/apt-guide/ch2.en.html
https://en.wikipedia.org/wiki/Alien_(software)


6 Uso avanzato 
6.1 Programmi Windows sotto MX Linux 

Ci sono un certo numero di applicazioni, sia open-source che commerciali, che permetteranno 
alle applicazioni Windows di girare sotto MX Linux. (Quando solo una particolare applicazione 
è coinvolta, è chiamata un wrapper - per esempio, NDISwrapper). Sono chiamati emulatori, nel 
senso che replicano le funzioni di Windows su una piattaforma Linux. Molte applicazioni MS 
Office, giochi e altri programmi possono essere eseguiti utilizzando un emulatore con vari gradi 
di successo che vanno dalla velocità e funzionalità quasi nativa alle prestazioni di base. 

 

6.1.1 Open-source 
 

Wine è il principale emulatore open-source di Windows per MX Linux. È una sorta di livello di 
compatibilità per eseguire programmi Windows, ma non richiede Microsoft Windows per 
eseguire le applicazioni. È meglio installarlo tramite MX Package Installer (sotto Misc); se si 
installa con Synaptic, selezionare "winehq-staging" per ottenere tutti i pacchetti wine-staging. 
Le versioni di Wine sono rapidamente impacchettate dai membri del Community Repository e 
rese disponibili agli utenti, con l'ultima versione proveniente dal repo di test. 

 
NOTA: Per eseguire Wine quando si esegue Live, è necessario utilizzare la persistenza della 
casa (Sezione 6.6.3). 

 
• Home page del vino 

 
• MX/antiX Wiki: Vino 

 
DOSBox crea un ambiente simile al DOS destinato all'esecuzione di programmi basati su 
MS-DOS, specialmente giochi per computer. 

 
• DOSBox homepage 

 
• Wiki DOSBox 

 
DOSEMU è un software disponibile nei repo che permette di avviare il DOS in una 
macchina virtuale, rendendo possibile eseguire Windows 3.1, Word Perfect per DOS, 
DOOM, ecc. 

 
• Pagina iniziale di DOSEMU 

 
• MX/antiX Wiki: DOSEMU 

https://en.wikipedia.org/wiki/NDISwrapper
https://wine-staging.com/
http://www.winehq.org/
https://mxlinux.org/wiki/system/wine
http://dosbox.sourceforge.net/
http://dosbox.sourceforge.net/wiki
http://www.dosemu.org/
https://mxlinux.org/wiki/system/dosemu


 
 

Figura 6-1: Photoshop 5.5 in esecuzione sotto Wine 
 

6.1.2 Commerciale 
 

CrossOver Office permette di installare molte popolari applicazioni di produttività Windows, 
plugin e giochi in Linux, senza bisogno di una licenza del sistema operativo Microsoft. 
Supporta particolarmente bene Microsoft Word, Excel e PowerPoint (fino al 2003). 

 
• Pagina iniziale di CrossOver Linux 

 
• Wikipedia: Crossover 

 
• Compatibilità delle applicazioni 

 

Link 
 

• Wikipedia: Emulatore 
 

• Emulatori DOS 
 

6.2 Macchine virtuali 

Le applicazioni della macchina virtuale sono una classe di programmi che simulano un computer 
virtuale in memoria, permettendo di eseguire qualsiasi sistema operativo sulla macchina. È utile 
per i test, per eseguire applicazioni non native e per dare agli utenti la sensazione di avere una 
macchina propria. Molti utenti MX Linux fanno uso di software di macchine virtuali per 
eseguire Microsoft Windows "in una finestra" per fornire senza soluzione di continuità l'accesso 
al software scritto per Windows sul loro desktop. È anche usato per i test per evitare 
l'installazione. 

http://www.codeweavers.com/products/cxoffice
http://en.wikipedia.org/wiki/CrossOver
http://www.codeweavers.com/compatibility/browse/rank
http://en.wikipedia.org/wiki/Emulator
https://mxlinux.org/wiki/system/dosemu/


6.2.1 Impostazione 
 

 Virtual Box: impostare una cartella condivisa (14.4) 
 

Esiste un certo numero di applicazioni software per macchine virtuali per Linux, sia open-source 
che proprietarie. MX rende particolarmente facile l'uso di VirtualBox (VB), quindi ci 
concentreremo su questo qui. Per i dettagli e gli sviluppi più recenti, vedi la sezione Link qui 
sotto. Ecco una panoramica dei passi di base per impostare ed eseguire VirtualBox: 

 
• Installazione. Questo è meglio farlo tramite MX Package Installer, dove VB appare 

nella sezione Misc. Questo abiliterà il repository VB, scaricherà e installerà l'ultima 
versione di VB. Il repository sarà lasciato abilitato, permettendo gli aggiornamenti 
automatici tramite MX Updater. 

 
• 64bit. VB richiede il supporto alla virtualizzazione dell'hardware per eseguire un 

guest a 64bit, le cui impostazioni (se esistono) si trovano nel BIOS. Dettagli nel 
manuale VB. 

 
• Riavviare. È una buona idea lasciare che VB si imposti completamente riavviando dopo l'installazione. 

 
• Post-installazione. Controlla che il tuo utente appartenga al gruppo vboxusers. Aprire 

MX User Manager > scheda Group Membership. Seleziona il tuo nome utente e 
assicurati che 'vboxusers' nell'elenco dei gruppi sia spuntato. Confermare e uscire. 

 
• Extension Pack. Se si installa VB dal MX Package Installer, l'Extension Pack sarà 

incluso automaticamente. Altrimenti, dovresti scaricarlo e installarlo dal sito web di 
Oracle (vedi Links). Dopo che il file è stato scaricato, naviga fino ad esso con Thunar e 
clicca sull'icona del file. L'Extension Pack aprirà VB e si installerà automaticamente. 

 
• Posizione. I file della macchina virtuale sono memorizzati di default nella cartella 

/home. Possono essere abbastanza grandi e se hai una partizione dati separata puoi 
considerare di fare la cartella di default lì. Vai su File > Preferenze > scheda Generale e 
modifica la posizione della cartella. 

https://www.youtube.com/watch?v=adpalUl4LqI
https://www.virtualbox.org/wiki/VirtualBox
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests


 
 

Figura 6-2: Windows 2000 in esecuzione in VirtualBox 
 

6.2.2 Usa 
 

• Creare una macchina virtuale. Per creare una macchina virtuale avvia VB, clicca 
sull'icona Nuovo sulla barra degli strumenti. Avrai bisogno di un CD di Windows o di 
una ISO di Linux (solo 32bit). Segui la procedura guidata, accettando tutte le 
impostazioni suggerite a meno che tu non sappia fare di meglio - puoi sempre cambiarle 
in seguito. Se la tua ISO ha PAE, clicca su Sistema > scheda Opzioni e abilitalo. 
Potrebbe essere necessario aumentare la memoria allocata al Guest oltre la cifra minima 
di default, lasciando ancora memoria sufficiente per il vostro sistema operativo host. Per i 
Guest di Windows, considera di creare un HD virtuale più grande dei 10GB predefiniti - 
mentre è possibile aumentare la dimensione in seguito, non è un processo semplice. 
Selezionare un'unità host o un file disco CD/DVD virtuale 

 
• Selezionare un punto di montaggio. Una volta che la macchina è impostata, puoi 

selezionare il punto di montaggio per essere l'unità host o un file disco CD/DVD virtuale 
(ISO). Fai clic su Impostazioni > Archiviazione e si aprirà una finestra di dialogo in cui 
vedrai al centro un albero di archiviazione con un controller IDE e un controller SATA 
sotto di esso. Cliccando sull'icona dell'unità CD/DVD nell'albero dello storage, vedrai 
l'icona dell'unità CD/DVD apparire nella sezione Attributi nella parte destra della 
finestra. Fai clic sull'icona dell'unità CD/DVD nella sezione Attributi per aprire un menu 
a discesa dove puoi assegnare l'unità host o un file disco CD/DVD virtuale (ISO) da 
montare sull'unità CD/DVD. (Puoi selezionare un file ISO diverso cliccando su Choose a 
Virtual CD/DVD disk file e navigando fino al file). Esegui la macchina. Il dispositivo 
che hai selezionato (ISO o CD/DVD) sarà montato quando avvii la macchina virtuale e il 
tuo sistema operativo potrà essere installato. 

 
• GuestAdditions. Una volta che il tuo sistema operativo Guest è installato, assicurati di 

installare VB GuestAdditions avviando il sistema operativo Guest, poi cliccando su 
Devices > Insert GuestAdditions e puntando verso la ISO che individuerà 



automaticamente. Questo ti permetterà di abilitare la condivisione di file tra Guest e Host 
e di regolare il tuo display in vari modi in modo che si adatti 



il tuo ambiente e le tue abitudini. Se l'applicazione non è in grado di localizzarla, 
potrebbe essere necessario installare il pacchetto virtualbox-guest-additions (fatto 
automaticamente se hai usato Package Installer) 

 
• Spostamento. Il modo più sicuro per spostare o cambiare le impostazioni di una 

macchina virtuale esistente è quello di clonarla: cliccate con il tasto destro del mouse sul 
nome di una macchina esistente > Clona, e compilate le informazioni. Per usare il nuovo 
clone, crea una nuova Macchina Virtuale e nella procedura guidata quando selezioni 
l'Hard Disk, scegli "Use existing hard disk" e seleziona il nuovo clone 
*.vdi file. 

 
• Documentazione. La documentazione dettagliata per VB è disponibile attraverso Help 

sulla barra dei menu o come PDF dal sito web. 
 

 
Figura 6-3: schermata delle impostazioni per MX-19.1 in VirtualBox 

 
Link 

 
• Wikipedia: Macchina virtuale 

 
• Wikipedia: Confronto tra software di macchine virtuali 

 
• Pagina iniziale di VirtualBox 

 
• Pacchetto di estensioni di VirtualBox 

http://en.wikipedia.org/wiki/Virtual_machine
http://en.wikipedia.org/wiki/Comparison_of_platform_virtualization_software
http://www.virtualbox.org/
http://www.virtualbox.org/wiki/Downloads


6.3 Gestori di finestre alternativi 
 

Figura 6-4: MATE in esecuzione su MX-15 Linux, con il browser YouTube aperto 
 

Un window manager (originariamente WIMP: Window, Icon, Menu, and Pointing device) in 
Linux è essenzialmente il componente che controlla l'aspetto delle interfacce utente grafiche e 
fornisce i mezzi con cui l'utente può interagire con esse. 

 
Le tre versioni di MX Linux usano Xfce, KDE o Fluxbox per definizione. Ma esistono altre 
possibilità per gli utenti. MX Linux rende facile l'installazione di molte alternative popolari 
attraverso il MX Package Installer, come descritto di seguito. 

 
• Budgie Desktop, un desktop semplice ed elegante che utilizza GTK 

 
• Budgie Desktop 

 
• Compiz, un WM OpenGL con compositing. 

 
• Gestore di finestre Compix 

 
• Gnome Base, un display manager e un desktop basato su GTK+ che fornisce un 

ambiente desktop ultraleggero. 
 

• Gnome Ultra (GOULD), un ambiente desktop ultraleggero 
 

• KDE5 Standard, un ambiente molto grande e potente adattato all'ambiente MX 
Linux. Vedere la Wiki MX/antiX. 

 
• Pagina iniziale di KDE 

http://en.wikipedia.org/wiki/Window_manager
https://budgie-desktop.org/home/
https://en.wikipedia.org/wiki/Compiz#External_links
http://sourceforge.net/projects/gould
http://mxlinux.org/wiki/system/kde-on-mx-linux
http://www.kde.org/


• LXDE è un ambiente desktop veloce e leggero i cui componenti possono essere 
installati separatamente. 

 
• Pagina iniziale di LXDE 

 
• MATE è la continuazione di GNOME 2 che fornisce un ambiente desktop intuitivo e 

attraente. 
 

• Pagina iniziale di MATE 
 

• IceWM è un ambiente desktop all-in-one molto leggero e un gestore di finestre 
impilabili. 

 
• IceWM home page 

 
Una volta installato, puoi scegliere il gestore di finestre che vuoi dal pulsante Session 
nell'angolo superiore destro della barra in alto nella schermata di login predefinita; fai il login 
come faresti normalmente. Se sostituisci il gestore di login con un altro dai repo, assicurati di 
averne sempre almeno uno disponibile al riavvio. 

 
OLTRE: Wikipedia: Gestori di finestre X 

 
6.4 Linea di comando 

Anche se MX offre un set completo di strumenti grafici per installare, configurare e utilizzare il 
sistema, la linea di comando (chiamata anche console, terminale, BASH o shell) è ancora uno 
strumento utile e a volte indispensabile. Ecco alcuni usi comuni: 

 
• Lancia un'applicazione GUI per vedere il suo output di errore. 

 
• Velocizza i compiti di amministrazione del sistema. 

 
• Configurare o installare applicazioni software avanzate. 

 
• Eseguite più compiti rapidamente e facilmente. 

 
• Risolvere i problemi dei dispositivi hardware. 

 
Il programma predefinito per eseguire un terminale in una finestra del desktop MX è XFCE 
Terminal, che può essere trovato in Start Menu > Sistema > Xfce Terminal (Terminal 
Emulator). Alcuni comandi sono riconosciuti solo per il super utente (root), mentre altri possono 
variare l'output a seconda dell'utente. 

 
Per ottenere temporaneamente i permessi di root, usate uno dei metodi descritti nella sezione 
4.7.1. Riconoscerete quando Xfce Terminal è in esecuzione con i privilegi di root guardando la 
riga del prompt 

http://lxde.org/
http://mate-desktop.org/
https://ice-wm.org/
https://ice-wm.org/
http://en.wikipedia.org/wiki/Comparison_of_X_Window_System_desktop_environments


proprio prima dello spazio in cui si digita. Invece di un $, vedrete un #; inoltre, il nome utente 
cambia in root scritto in rosso. 

 
NOTA: Se cercate di eseguire come utente normale un comando che richiede i privilegi di root 
come iwconfig, potreste ricevere un messaggio di errore che il comando non è stato trovato, 
vedere una casella di messaggio che il programma deve essere eseguito come root, o 
semplicemente trovarvi di nuovo al prompt senza alcun messaggio. 

 

 
Figura 6-5: l'utente ha ora privilegi amministrativi (root) 

 
6.4.1 Primi passi 

 
• Per maggiori informazioni sull'uso del Terminale Xfce per risolvere i problemi del 

sistema, fate riferimento all'argomento Risoluzione dei problemi alla fine di questa 
sezione. Inoltre, è consigliabile fare il backup dei file su cui stai lavorando come utente 
root con i comandi cp e mv (vedi sotto). 

 
• Anche se i comandi del terminale possono essere abbastanza complessi, capire la linea 

di comando è solo una questione di mettere insieme cose semplici. Per vedere quanto 
può essere facile, apri il Terminale Xfce e prova alcuni comandi di base. Tutto questo 
avrà più senso se lo farete come esercizio di tutorial piuttosto che semplicemente 
leggendolo. Iniziamo con un semplice comando: ls, che elenca il contenuto di una 
directory. Il comando di base elenca il contenuto di qualsiasi directory in cui ci si trovi 
al momento: 

ls 

• Questo è un comando utile, ma è solo qualche breve colonna di nomi stampata sullo 
schermo. Supponiamo di volere più informazioni sui file in questa directory. Possiamo 
aggiungere uno switch al comando per fargli stampare più informazioni. Uno switch è 
un modificatore che aggiungiamo ad un comando per cambiarne il comportamento. In 
questo caso, lo switch che vogliamo è: 

ls -l 



• Come potete vedere sul vostro schermo se state seguendo, questo interruttore fornisce 
informazioni più dettagliate (specialmente sui permessi) sui file in qualsiasi directory. 

 
• Naturalmente, potremmo voler vedere il contenuto di un'altra directory (senza andarci 

prima). Per fare questo, aggiungiamo un argomento al comando, specificando quale file 
vogliamo vedere. Un argomento è un valore o un riferimento che aggiungiamo a un 
comando per indirizzare la sua operazione. Dando come argomento /usr/bin/, possiamo 
elencare il contenuto di quella directory, invece di quella in cui ci troviamo attualmente. 

ls -l /usr/bin 

• Ci sono molti file in /usr/bin/! Sarebbe bello se potessimo filtrare questo output in modo 
da elencare solo le voci che contengono, per esempio, la parola "fire". Possiamo farlo 
inviando l'output del comando /ls/ ad un altro comando, grep. Il pipe, o carattere │, è 
usato per inviare l'output di un comando all'input di un altro. Il comando grep cerca lo 
schema che gli date e restituisce tutte le corrispondenze, quindi inviando l'output del 
comando precedente ad esso si filtra l'output. 

ls -l /usr/bin | grep fire 

• Infine, supponiamo di voler salvare questi risultati in un file di testo per usarli in seguito. 
Quando diamo dei comandi, l'output è solitamente diretto al display della console; ma 
possiamo reindirizzare questo output da qualche altra parte, come ad esempio ad un file, 
usando il simbolo > (redirect) per istruire il computer a fare una lista dettagliata di tutti i 
file che contengono la parola "fuoco" in una particolare directory (per default la vostra 
directory Home, e creare un file di testo contenente quella lista, in questo caso chiamata 
"FilesOfFire" 

ls -l /usr/bin | grep fire > FilesOfFire.txt 

• Come potete vedere, la linea di comando può essere usata per eseguire compiti 
complessi molto facilmente combinando semplici comandi in modi diversi. 

 

6.4.2 Comandi comuni 

Navigazione del filesystem 
 

Tabella 6: Comandi di navigazione del filesystem 
 

Comando Commento 
cd /usr/share Cambia la directory corrente nel percorso dato: "/usr/share". Senza argomenti, 

cd 
ti porta alla tua home directory. 

pwd Stampa il percorso della directory di lavoro corrente 
ls Elenca il contenuto della directory corrente. Usa l'opzione -a per mostrare anche 

i file nascosti, e l'opzione -l per mostrare i dettagli di tutti i file. Spesso 
combinato con altri termini. lsusb elenca tutti i dispositivi usb, lsmod tutti i 

moduli, ecc. 

Gestione dei file 
 

Tabella 7: Comandi di gestione dei file 



Comment
o 

Comando 
 



cp sourcefile 
destinationfile 

Copia un file in un altro nome di file o posizione. Usa lo 
switch -R ("ricorsivo") per copiare intere 
directory. 

mv sourcefile 
destinationfile 

Spostare un file o una directory da una posizione ad un'altra. Si usa anche 
per rinominare file o directory e per fare un backup: per esempio prima di 

cambiare un file critico come xorg.conf si potrebbe usare questo 
comando per spostarlo in qualcosa come xorg.conf_bak. 

rm nome 
del file 

Cancellare un file. Usa l'opzione -R per cancellare una directory, e 
l'opzione -f ("force") se non vuoi che ti venga chiesto di confermare 
ogni cancellazione. 

cat file.txt Stampa il contenuto di un file sullo schermo. Usare solo su file di 
testo. 

grep Trova una data stringa di caratteri in un dato pezzo di testo, e stampa 
l'intera linea su cui si trova. Di solito usato con una pipe, ad esempio cat 

somefile.txt Ⅰ grep 
/somestring/ visualizzerà la riga di somefile.txt che contiene 

somestring. Per trovare una scheda usb di rete, per esempio, potreste 
digitare: lsusb | grep -i Network. Il comando grep è sensibile alle 

maiuscole per impostazione predefinita, quindi usando lo switch -i lo 
rende insensibile alle maiuscole. 

dd Copia qualsiasi cosa bit per bit, quindi può essere usato per directory, 
partizioni e interi dischi. La sintassi di base è dd if=<qualsiasi file> 
of=<qualsiasi altro file> 

Simboli 
 

Tabella 8: Simboli 
 

Comando Commento 
| Il simbolo di pipe usato per inviare l'output di un comando all'input di un altro. 

Alcune tastiere mostrano invece due brevi barre verticali 
> Il simbolo di reindirizzamento, usato per inviare l'output di un comando in un file 

di dispositivo. Raddoppiando il simbolo di reindirizzamento, l'output di un 
comando sarà aggiunto a un file esistente piuttosto che sostituirlo. 

& L'aggiunta dell'e commerciale alla fine di un comando (con uno spazio prima) fa sì 
che venga eseguito in background, in modo da non dover aspettare che sia 

completato per inviare il comando successivo. La doppia e commerciale indica che 
il secondo comando dovrebbe essere eseguito solo se il primo ha avuto successo. 

Risoluzione dei problemi 
 

Per la maggior parte dei nuovi utenti di Linux, la linea di comando è usata principalmente come 
strumento di risoluzione dei problemi. I comandi da terminale danno informazioni rapide e 
dettagliate che possono essere facilmente incollate in un post di un forum, in una casella di 
ricerca o in una e-mail quando si cerca aiuto sul web. Si raccomanda vivamente di tenere queste 
informazioni a portata di mano quando si chiede aiuto. Essere in grado di fare riferimento alla 
vostra specifica configurazione hardware non solo velocizzerà il vostro processo di ottenere 
aiuto, ma permetterà anche agli altri di offrirvi soluzioni più accurate. Qui ci sono alcuni 
comandi comuni per la risoluzione dei problemi (vedi anche Sezione 3.4.4). Alcuni di essi 
potrebbero non fornire informazioni, o non molte informazioni, a meno che non si sia connessi 
come root. 



 
Tabella 9: Comandi per la risoluzione dei problemi 

 

Comando Commento 
lspci Mostra un rapido riassunto dei dispositivi hardware interni rilevati. Se un 

dispositivo appare come 
/unknown/, di solito avete un problema di driver. L'opzione -v fa sì che vengano 

visualizzate informazioni più dettagliate. 
lsusb Elenca i dispositivi USB collegati. 

dmesg Mostra il log di sistema per la sessione corrente (cioè dall'ultimo avvio). L'output è 
abbastanza lungo, e di solito questo viene convogliato attraverso grep, less (simile 

a most) o tail (per vedere cosa è successo più recentemente). Per esempio, per 
trovare potenziali errori relativi al vostro hardware di rete, provate dmesg Ⅰ grep -i 

net. 
top Fornisce un elenco in tempo reale dei processi in esecuzione e varie statistiche su di 

essi. Disponibile anche dal menu Start come Htop insieme a una bella versione 
grafica Task Manager. 

Accesso alla documentazione dei comandi 
 

• Molti comandi stampano un semplice messaggio di "informazioni sull'uso" quando si usa il comando 
--help o -h. Questo può essere utile per ricordare rapidamente la sintassi di un comando. 
Per esempio: cp --help 

 
• Per informazioni più dettagliate su come usare un comando, consultate la pagina man 

del comando. Per impostazione predefinita, le pagine man sono visualizzate nel less 
pager del terminale, il che significa che solo una schermata del file viene visualizzata 
alla volta. Tenete a mente questi trucchi per navigare nella schermata risultante: 

 
• La barra spaziatrice (o il tasto PageDown) fa avanzare lo schermo. 

 
• La lettera b (o tasto PageUp) sposta lo schermo all'indietro. 

 
• La lettera q esce dal documento di aiuto. 

 
Alias 

 
È possibile creare un alias (nome di comando personale) per qualsiasi comando, breve o lungo, 
che si desidera; più facilmente con lo strumento MX Bash Config. Dettagli nella Wiki di 
MX/antiX. 

 

6.4.3 Link 
 

• Guida per principianti BASH 
 

• Nozioni di base sulla linea di comando 
 

6.5 Script 

http://mxlinux.org/wiki/system/alias
http://mxlinux.org/wiki/system/alias
http://tldp.org/LDP/Bash-Beginners-Guide/html/index.html
http://www.linuxcommand.org/


Uno script è un semplice file di testo che può essere scritto direttamente da una tastiera, e 
consiste in una serie in sequenza logica di comandi del sistema operativo. I comandi sono gestiti 
uno alla volta da un interprete di comandi che a sua volta richiede servizi al sistema operativo. 
L'interprete di comandi predefinito in MX Linux è Bash. I comandi devono essere 
comprensibili a Bash, e sono state stabilite delle liste di comandi per l'uso in programmazione. 
Uno script di shell è la controparte Linux dei programmi batch nel mondo Windows. 



Gli script sono usati in tutto il sistema operativo Linux e nelle applicazioni che vi girano sopra 
come un metodo economico per eseguire più comandi in un modo facilmente creato e 
modificato. Durante l'avvio, per esempio, molti script sono invocati per avviare processi 
specifici come la stampa, il networking, ecc. Gli script sono anche utilizzati per processi 
automatizzati, amministrazione del sistema, estensioni di applicazioni, controlli utente, ecc. 
Infine, gli utenti di tutti i tipi possono utilizzare gli script per i loro scopi. 

 

6.5.1 Un semplice script 
 

Facciamo uno script molto semplice (e famoso) per avere l'idea di base. 
 

1. Aprite il vostro editor di testo (Menu Start > Accessori), e scrivete: 

#!/bin/bash 
clear 
eco Buon giorno, mondo! 

2. Salvate questo file nella vostra directory home con il nome SimpleScript.sh 
 

3. Fai clic con il tasto destro del mouse sul nome del file, seleziona Proprietà e 
spunta "Consenti a questo file di essere eseguito come programma" nella scheda 
Permessi. 

 
4. Aprite un terminale e digitate: 

sh /home/<username>/SimpleScript.sh 

5. La linea "Buon giorno, mondo!" apparirà sul vostro schermo. Questo semplice script non 
fa molto, ma stabilisce il principio che un semplice file di testo può essere usato per 
inviare comandi per controllare il comportamento del sistema. 

 
 NOTA:Tutti gli script si aprono con unoshebang come all'inizio della prima riga: è 
una combinazione di un segno hash (#), un punto esclamativo e il percorso dell'interprete del 
comando. Qui, Bash è l'interprete e si trova nella posizione standard per le applicazioni utente. 

 

6.5.2 Uno script utile 
 

Diamo un'occhiata a uno script utile per l'utente ordinario che riduce tutte le mosse coinvolte nel 
backup di più insiemi di file in una singola pressione di tasti. Lo script qui sotto si basa su uno 
script di sistema chiamato rdiff-backup che dovrebbe essere installato dai repo perché lo script 
funzioni. Copia una directory in un'altra, mantenendo una registrazione delle differenze in una 
speciale sottodirectory in modo da poter ancora recuperare i file persi qualche tempo fa. (Per 
inciso, rdiff-backup si basa a sua volta su uno script chiamato diff). 

 
In questo esempio, un utente chiamato "newbie" vuole impostare uno script per eseguire il 
backup di documenti, musica, posta e immagini dalla directory /home a un disco esterno. 

1 #!/bin/bash 
2 # 
3 # Questo script Rdiff-Backup esegue il backup su un secondo disco rigido. 
4 # Deve essere eseguito come root per montare il secondo disco 

https://en.wikipedia.org/wiki/Shebang_(Unix)


rigido 5 
6 # Per ripristinare i file, eseguire il comando: cp -a /mnt/sda1/username /home 



7 # Per ripristinare, ma non sovrascrivere: 
8 # cp -a -i \SpecialChar nobreakdash\SpecialChar nobreakdash "reply=no 
/mnt/sda1/username /home 
9 
10 # Montare i dispositivi 
esterni 11 
12 montare /dev/sdb1 
13 montare /dev/sdb2 
14 montare 
/dev/sdb3 15 
16 # Eseguire il backup 
17 
18 rdiff-backup /home/newbie/Documents /mnt/sdb2/Documents 
19 rdiff-backup /home/newbie/Music /mnt/sdb1/Music 
20 rdiff-backup /home/newbie/Mail /mnt/sdb2/Mail 
21 rdiff-backup /home/newbie/Pictures 
/mnt/sdb3/Pictures 22 
23 # Smonta i dispositivi esterni 
24 
25 umount /dev/sdb1 
26 umount /dev/sdb2 
27 umount /dev/sdb3 

Ora guardiamo i componenti di questo script: 
 

• Linee 2-8: un hash o un segno numerico è stato messo davanti a queste linee 
(chiamato "commentarle") per indicare a Bash che non fanno parte della sequenza 
di comandi da eseguire. Il loro scopo qui è quello di fornire a chiunque guardi 
questo script informazioni su cose come l'origine dello script, il creatore, lo scopo e 
la licenza (metadati). 

 
• Linea 10: i buoni script separano i comandi in sezioni procedurali chiaramente 

etichettate, anche nelle linee 16 e 22. 
 

• Linee 12-14: i tre dispositivi da usare per il backup devono prima essere montati in 
modo che siano disponibili per il sistema. 

 
• Linee 18-21: qui si dice a bash di usare lo script di sistema rdiff-backup per 

confrontare le directory originali (sorgenti) con le directory di backup (obiettivi), 
copiare le differenze che trova e tenere un registro dei cambiamenti. 

 
• Linee 25-27: una volta terminato il lavoro di backup, i drive esterni vengono smontati 

dal sistema. 
 

Chiunque volesse usare un tale script dovrebbe eseguire alcuni passi di esecuzione: 
 

1. Copia l'intero script. 
 

2. Cliccate con il tasto destro del mouse sul desktop e selezionate Create New > Text file... 



3. Date al file un nome che abbia senso (senza spazi, però), e aggiungete l'estensione "sh" 
in modo da riconoscere che si tratta di uno script. Per questo esempio, potresti 
selezionare Backup_DocsMusicMailPictures.sh 

 
4. Aprite il nuovo file di testo e incollate lo script. 

 
5. Cambiate tutti i nomi, le posizioni, ecc. con quello che sono sul vostro particolare 

sistema. Nell'esempio di cui sopra, potresti avere diversi nomi e/o posizioni per le 
directory di cui fare il backup, e diversi dispositivi dove dovrebbero andare. 

 
6. Salvate lo script in un posto dove potete trovarlo facilmente quando ne avete bisogno, 

diciamo che fate una nuova directory /home/scripts per esso. 
 

7. Cliccate con il tasto destro sullo script, selezionate Proprietà, cliccate sulla scheda 
Permessi e spuntate la casella È eseguibile e cliccate su OK. 

 
8. Quando siete pronti per il backup, aprite un terminale e digitate: 

sh /home/scripts/Backup_DocsMusicMailPictures.sh 

SUGGERIMENTO: usa il tasto tab per completare automaticamente il nome del file dopo aver digitato 
le prime lettere. 

 
Link 

 
• Guida Bash per principianti 

 
• Tutorial sugli script della shell di Linux 

 
• Directory di comandi Linux 

 

6.5.3 Tipi di script speciali 
 

Alcuni script richiedono un software speciale (linguaggio di scripting) per essere eseguiti, 
piuttosto che lanciarli semplicemente in Bash. I più comuni per gli utenti regolari sono gli script 
Python, che hanno la forma *.py. 

 
Per eseguirli, è necessario chiamare python per effettuare l'esecuzione fornendo il percorso 
corretto. Se hai scaricato uno script python chiamato "tryme.py" sul tuo Desktop, per esempio, 
potresti fare una delle tre cose: 

 
◦ Basta cliccarci sopra. MX Linux ha un piccolo programma chiamato Py-Loader 

che lo lancerà usando python. 
 

◦ Aprite un terminale e digitate: 
 

python ~/Desktop/tryme.py 

http://www.tldp.org/LDP/Bash-Beginners-Guide/html/Bash-Beginners-Guide.html
http://www.freeos.com/guides/lsst
http://www.linuxdevcenter.com/linux/cmd/
https://en.wikipedia.org/wiki/Scripting_language


◦ In alternativa, si potrebbe aprire un terminale all'interno della cartella stessa, nel 
qual caso si dovrebbe digitare: 

 
python ./tryme.py 

 
I linguaggi di scripting sono molto avanzati e non rientrano nello scopo di questo manuale. 

 
6.5.4 Script utente preinstallati 

 
I seguenti script permettono agli utenti di aiutare a mantenere la loro installazione di MX Linux 
aggiornata e funzionante come rolling release. 

 
smxi 

 
Quando viene eseguito, smxi permette agli utenti di installare un nuovo kernel, installare i driver 
grafici ATI e Nvidia, eseguire apt-get upgrade o apt-get dist-upgrade in modo sicuro, e molto 
altro! Scritto da un programmatore conosciuto come "h2", lo script è praticamente auto 
esplicativo, ma per le opzioni di utilizzo, eseguite smxi -h. 

 
smxi deve essere eseguito al di fuori del sistema a finestre X (cioè, non dal desktop) per la maggior parte delle 
funzioni. 

 
• Dal tuo desktop: 

 
• Premere Ctrl-Alt-F1 per arrivare al prompt del terminale. 

 
• Accedere come root ("root" e password) 

 
• Eseguire il comando: 

smxi 

• All'avvio: 
 

• Digitare e nel menu di GRUB per poterlo modificare 
 

• Aggiungere "3" alla fine della linea del kernel nella voce di menu di GRUB per 
MX Linux, subito dopo la parola "quiet". 

 
• Il sistema si avvierà direttamente alla console. 

 
• Accedere come "root" (senza virgolette) e fornire la password appropriata 

 
• Eseguire il comando: 

 
smxi 

 
smxi chiederà una serie di domande la prima volta che viene eseguito, incluse le opzioni 

di sistema che  si desideraeseguireLe seguenti opzioni sono raccomandate: 

http://smxi.org/


• continue-no-changes 
 

• apt-get 
 

• apt-get dist-upgrade 
 

Dopo che smxi ha completato le sue operazioni chiederà se si vuole riavviare il desktop. 
NOTA: Eseguire smxi -G in un terminale di root mentre si è all'interno di una sessione X in 
esecuzione permette di eseguire alcune caratteristiche di smxi, come la rimozione di kernel 
indesiderati, ecc. 

 
smxi home page 

 
documentazione smxi 

 

sgfxi 
 

Questo script h-2 viene eseguito all'interno di smxi o separatamente, e si occupa di installare i 
driver grafici. Sgfxi attualmente supporta i driver ATI, fglrx e Nvidia. Supporta anche la 
conversione da o verso i driver liberi di xorg come ati, intel o nv. Seguite la procedura qui sopra 
per avviare lo script, sostituendo smxi con sgfxi. 

 
Sgfxi richiede una connessione internet funzionante! Alcune connessioni internet wireless 
potrebbero essere interrotte quando si opera al di fuori di X. Se questo è il caso della tua 
connessione internet, passa temporaneamente a una connessione internet cablata prima di 
procedere o usa le istruzioni "Installazione parziale in X, completamento al di fuori di X" 
nella prossima sezione. 

 
Lo script sgfxi scarica e installa automaticamente gli header del kernel e tutto il resto di cui ha 
bisogno. Poi scarica gli installatori dei driver grafici binari da Nvidia o ATI, prepara il sistema, 
lo installa, poi imposta xorg.conf, tutto in modo abbastanza pulito e ragionevolmente intuitivo. 
Inoltre si aggiorna da solo, così ogni nuovo driver rilasciato sarà installato. Infine, sgfxi 
permette di passare facilmente da driver proprietari non liberi come fglrx di ATI e nvidia e i 
driver liberi di xorg. 

 
NOTA: l'esecuzione di sgfxi su un sistema con chipset nvidia rimuoverà ddm-mx, il 
pacchetto software utilizzato dagli installatori di MX Tools, quindi è necessario reinstallarlo 
se si desidera utilizzarlo. 

 
manuale sgfxi 

 

inxi 
 

Un terzo script di h-2 incluso in MX Linux è inxi, un comodo script di informazioni di sistema 
a riga di comando. Inserisci inxi -h in un terminale per vedere tutte le opzioni disponibili, che 
includono un'intera gamma dall'uscita dei sensori al meteo. Questo è il comando che sta dietro a 
MX Quick System Info. 

http://smxi.org/
http://smxi.org/docs/
http://smxi.org/docs/sgfxi-manual.htm


 
DI PIÙ: Wiki di MX/antiX 

https://mxlinux.org/wiki/antix-faqs-applications/guide-smxisgfxiinxi


6.5.5 Trucchi e consigli 

• Il doppio clic su uno script di shell lo apre di default nell'editor di Featherpad invece di 
eseguire lo script. Questo è stato progettato come misura di sicurezza per prevenire 
l'esecuzione accidentale di script quando non ne avevi intenzione. Per cambiare questo 
comportamento, clicca su Settings > Mime Type Editor. Individua x-application/x-
shellscript e cambia l'applicazione predefinita in bash. 

 
• Un editor più avanzato per la programmazione di script è geany, installato di default. 

È un IDE/editor decente, con interfaccia grafica, leggero, multipiattaforma, flessibile 
e potente. 

 
6.6 Strumenti MX avanzati 

Oltre alle MX Apps di configurazione discusse nella sezione 3.2, MX Linux include utility per 
l'utente avanzato disponibili da MX Tools. 

 

6.6.1 Scansione di salvataggio Chroot (CLI) 
 

Un insieme di comandi che vi permettono di entrare in un sistema anche se il suo initrd.img è 
rotto. Ti permette anche di entrare in più sistemi senza riavviare. Dettagli e immagini nel file 
HELP. 

 
AIUTO: qui. 

 

6.6.2 Aggiornatore del kernel live-usb (CLI) 
 

  Cambiare il kernel su un antiX o MX live-USB 
 

ATTENZIONE: solo per l'uso in una sessione Live! 
 

Questa applicazione a riga di comando può aggiornare il kernel su un MX LiveUSB con 
qualsiasi kernel che sia stato installato. Questa applicazione apparirà solo in MX Tools quando 
si esegue una sessione Live. 

 

https://www.geany.org/
https://en.wikipedia.org/wiki/Integrated_development_environment
https://mxlinux.org/wiki/system/chroot-rescue-scan/
https://www.youtube.com/watch?v=UWvwbwTGOZ8&t=2s


 
Figura 6-6: Lo strumento di aggiornamento del kernel live-usb pronto a passare a un nuovo kernel 



AIUTO: qui. 
 

6.6.3 MX Live Usb maker   
 

Si usa per creare una live-usb partendo da un file iso, un live -cd/dvd o una live-usb esistente o 
anche un sistema live in esecuzione. Sebbene UNetbootin sia anche disponibile di default (si 
veda la Sezione 2.2.3), live- usb maker ha una serie di vantaggi: 

 
• È più veloce. 

 
• Salva i file di stato attraverso i riavvii 

 
• LiveUSB-Storage per salvare i file direttamente sul live-usb 

 
• Persistenza 

 
• Rimasterizzazione 

 
• Ora offre l'opzione dd 

 
• Aggiornamento live del kernel 

 
NOTA: il modulo CLI (live-usb-maker, eseguito come root) offre molte opzioni avanzate. 

 

 
Figura 6-7: Lo strumento live-usb maker pronto a selezionare la ISO da utilizzare 

 
AIUTO: qui. 

 

6.6.4 Rimasterizzazione/persistenza dal vivo (RemasterCC) 
 

 Fare uno snapshot di un sistema installato

 MX-17: fare un live-USB con persistenza 

https://mxlinux.org/wiki/help-files/help-live-usb-kernel-updater
https://en.wikipedia.org/wiki/Dd_(Unix)
https://mxlinux.org/wiki/help-files/help-live-usb-maker
https://www.youtube.com/watch?v=ExVkxXcVDAw
https://www.youtube.com/watch?v=ExVkxXcVDAw
https://www.youtube.com/watch?v=2vF_dw6Kpo8


 
 

MX-17: installare applicazioni su una live-USB con persistenza 
 

NOTA: questa applicazione apparirà solo in MX Tools quando si esegue una sessione Live. 
 

Remaster 
 

ATTENZIONE: solo per l'uso in una sessione Live! 
 

Lo scopo principale della rimasterizzazione live è quello di rendere il più sicuro, facile e 
conveniente possibile per gli utenti fare la propria versione personalizzata di MX Linux che può 
essere distribuita ad altri computer. 

 
L'idea è quella di usare una LiveUSB (o una LiveHD, una "installazione frugale"; vedi 
MX/antiX Wiki) su una partizione del disco fisso come ambiente di sviluppo e test. Aggiungete 
o sottraete pacchetti e poi, quando siete pronti a rimasterizzare, usate un semplice script di 
rimasterizzazione o una GUI per fare la rimasterizzazione e poi riavviate. Se qualcosa va 
terribilmente male, semplicemente riavviate di nuovo con l'opzione rollback e vi avvierete 
nell'ambiente precedente. 

 
I membri della MX Community usano la rimasterizzazione Live per produrre spin non ufficiali, 
come il set di strumenti noto come Workbench. 

 

 MX 16 - Rimasterizza il tuo Live-

USB  MX Spins: Banco di lavoro! 

 MX Spins: KDE di Stevo! 
 

Persistenza 
 

ATTENZIONE: solo per l'uso in una sessione Live! 
 

ATTENZIONE: può fallire con grandi aggiornamenti che possono sovraccaricare la RAM. 
Sono disponibili procedure alternative. 

 
• Eseguire l'aggiornamento a tappe, utilizzando ogni volta piccole quantità (ad esempio, 200MB) 

 
• Aspettate il prossimo snapshot mensile e reinstallate. Assicuratevi di copiare tutte le 

cartelle non di sistema dalla chiavetta prima 

https://www.youtube.com/watch?v=6BsCx1-v3Ro
https://mxlinux.org/wiki/system/frugal-installation
https://www.youtube.com/watch?v=LpI_a4xPKdM
https://www.youtube.com/watch?v=LpI_a4xPKdM
https://www.youtube.com/watch?v=zwLz2vLc_qg
https://www.youtube.com/watch?v=87Qb3_S8dGA


 
 

USB live con persistenza (modalità legacy) 
 

 Live USB con persistenza (modalità UEFI) 
 

La persistenza è un ibrido tra un LiveMedium e un'installazione completa; permette di 
mantenere qualsiasi file installato o aggiunto durante una sessione live. I programmi installati o 
rimossi da, e le personalizzazioni ai file utente "demo" durante la persistenza live saranno 
riportati al sistema installato. 

 

 
Figura 6-8: Lo strumento di rimasterizzazione e persistenza 

 
AIUTO: qui. 

 

6.6.5 Snapshot 
 

Questo strumento fa una copia del vostro sistema in esecuzione e crea una ISO da essa. 
 

La ISO può essere messa su un LiveMedium nel solito modo (vedi Sezione 2.2). Per installare 
poi dal LiveMedium, aprite un terminale di root e digitate il comando: minstall. 

https://www.youtube.com/watch?v=RC4SmhsG3K0
https://www.youtube.com/watch?v=DJmukS-bSxw
https://mxlinux.org/wiki/help-files/help-live-remasterpersistence-remastercc


 
 

Figura 6-9: Schermata di apertura dell'istantanea 
 

AIUTO: qui. 
 

6.7 SSH 

SSH (Secure Shell) è un protocollo usato per accedere in modo sicuro a sistemi remoti. È il 
modo più comune per accedere a computer remoti Linux e Unix-like. MX Linux viene fornito 
con i principali pacchetti necessari per eseguire SSH in modalità attiva, il principale dei quali è 
OpenSSH, un'implementazione libera della Secure Shell che consiste in un'intera suite di 
applicazioni. 

 
• Avviare o riavviare il demone ssh come root con il comando: 

/etc/init.d/ssh start 

• Per avviare automaticamente il demone ssh all'avvio del computer, cliccate su Tutte le 
impostazioni > Sessione e avvio > Avvio automatico applicazioni. Fai clic sul 
pulsante Add, poi nella finestra di dialogo inserisci un nome come StartSSH, una breve 
descrizione se vuoi, e il comando 

/etc/init.d/ssh start 

Premi OK e hai finito. Al prossimo riavvio, il demone SSH sarà attivo. 
 

• Gli utenti di KDE su MX Linux possono fare lo stesso usando Preferenze > Impostazioni > Start & 
Stop 
> Avvio automatico. 

 

6.7.1 Risoluzione dei problemi 
 

Occasionalmente, SSH non funziona in modalità passiva, inviando un messaggio di 
connessione negata. Allora puoi provare quanto segue: 

 

https://mxlinux.org/wiki/help-files/help-mx-save-system-iso-snapshot
http://en.wikipedia.org/wiki/Secure_Shell


• Modifica come root il file '/etc/ssh/sshd-config'. Alla linea 16 troverete il parametro 
'UsePrivilegeSeparation yes'. Cambiatelo in 



UsePrivilegeSeparation no 

• Aggiungete voi stessi (o gli utenti previsti) al gruppo 'ssh' usando MX User Manager o 
modificando come root il file /etc/group. 

 
• A volte i certificati possono essere mancanti o obsoleti; un modo semplice per 

ricostruirli è eseguire (come root) il comando 

ssh-keygen -A 

• Controllare se sshd è in esecuzione digitando 

/etc/init.d/ssh status 

Il sistema dovrebbe rispondere '[ ok ] sshd è in esecuzione'. 
 

• Se state usando un firewall, controllate che la porta 22 non sia bloccata. Deve 
permettere il traffico IN e OUT. 

 
PIÙ: Manuale Openssh 

 

6.8 Sincronizzazione 
La sincronizzazione dei file (o syncing) permette ai file in luoghi diversi di rimanere identici. 
Prende una delle due forme: 

• a senso unico ("mirroring"), dove un computer sorgente viene copiato su altri ma non il contrario 

• bidirezionale, dove più computer sono tenuti identici 

Per esempio, gli utenti di MX Linux lo trovano utile quando gestiscono installazioni multiple per 
se stessi, membri della famiglia o altri gruppi, eliminando così la necessità di aggiornare più di 
una volta. C'è una grande quantità di software di sincronizzazione disponibile, ma i seguenti due 
sono stati testati e si sono dimostrati utili per gli utenti di MX Linux: 

• unison-gtk (nei repo) 

• FreeFileSync 

http://www.openssh.com/manual.html
https://en.wikipedia.org/wiki/File_synchronization
https://en.wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://www.cis.upenn.edu/%7Ebcpierce/unison/
https://www.freefilesync.org/


7 Sotto il cofano 
7.1 Introduzione 
MX Linux alla fine eredita il suo design fondamentale da Unix, un sistema operativo che è stato 
in giro in varie forme dal 1970, molto prima di MS Windows. Da questo è stato sviluppato 
Linux, da cui Debian produce la sua distribuzione. Il sistema operativo di base è l'argomento di 
questa sezione. Gli utenti che provengono da MS Windows trovano tipicamente un sacco di 
concetti non familiari, e si sentono frustrati cercando di fare le cose nel modo in cui sono 
abituati a farle. 

Questa sezione vi darà una panoramica concettuale di alcuni aspetti di base di MX Linux, e 
come differiscono da altri sistemi per aiutare a facilitare la vostra transizione. 
Link 

• Wikipedia: Unix 

• Pagina iniziale di Linux 

• Wikipedia Debian 
 

7.2 La struttura del file system 
Ci sono due usi fondamentali del termine "file system". 

• Il primo è il Filesystem del sistema operativo. Questo si riferisce ai file e alla loro 
organizzazione che il sistema operativo utilizza per tenere traccia di tutte le risorse 
hardware e software che ha a disposizione durante il funzionamento. 

• L'altro uso del termine file system si riferisce al Disk Filesystem, progettato per la 
memorizzazione e il recupero dei file su un dispositivo di memorizzazione dei dati, più 
comunemente un'unità disco. Il Disk Filesystem viene impostato quando la partizione 
del disco viene formattata per la prima volta, prima di scrivere qualsiasi dato sulla 
partizione. 

 

Il file system del sistema operativo 
Se aprite Thunar e cliccate su File System nel pannello di sinistra, noterete un certo numero di 
directory con nomi basati sul Filesystem Hierarchy Standard di Unix. 

http://en.wikipedia.org/wiki/Unix
http://www.linux.org/
http://en.wikipedia.org/wiki/Debian
https://refspecs.linuxfoundation.org/FHS_3.0/fhs/index.html
https://refspecs.linuxfoundation.org/FHS_3.0/fhs/index.html


 
 

Figura 7-1: Il filesystem MX visto in Thunar 
 
 

Ecco una semplice descrizione delle principali directory in MX Linux insieme ad un esempio di 
quando gli utenti lavorano comunemente con i file in quelle directory: 

• /bin 
 

• Questa directory contiene file di programmi binari che sono usati dal sistema 
durante l'avvio, ma che possono anche essere richiesti dalle azioni dell'utente una 
volta che il sistema è completamente attivo e funzionante. 

• Esempio: Molti programmi di base a riga di comando, come la shell Bash, e 
utility come /dd/, /grep/, /ls/ e /mount/ si trovano qui, oltre ai programmi usati 
solo dal sistema operativo. 

• /boot 

• Come si potrebbe immaginare, i file di cui Linux ha bisogno per l'avvio si 
trovano qui. Il kernel Linux, il nucleo del sistema operativo Linux, è tenuto 
qui, così come i bootloader come GRUB. 

• Esempio: nessun file qui è comunemente accessibile agli utenti. 
 

• /dev 
 
 
 
 
 
 

• /etc 

 
 
• In questa directory ci sono file speciali che si collegano ai vari dispositivi di 

input/output del sistema. 

• Esempio: nessun file qui è comunemente accessibile direttamente dagli 
utenti, tranne che nei comandi di montaggio CLI. 

 
 
• Questa directory contiene i file di configurazione per il sistema e i file di 

configurazione dell'applicazione. 



• Esempio: Il file /etc/fstab specifica punti di montaggio per filesystem aggiuntivi 
su dispositivi, partizioni, ecc. che possono essere configurati per il vostro uso 
ottimale. 

• Esempio: i problemi di visualizzazione a volte coinvolgono la modifica del file 
/etc/X11/xorg.conf. 

• /casa 

• Qui risiedono le directory personali dell'utente (dati e impostazioni). Se c'è più di 
un utente, viene creata una sottodirectory separata per ognuno. Nessun utente 
(tranne root) può leggere la home directory di un altro utente. La directory 
dell'utente contiene sia file nascosti (dove il nome del file è preceduto da un 
punto) che visibili; i file nascosti possono essere rivelati cliccando su View 
>Show Hidden Files (o Ctrl-H) in Thunar. 

• Esempio: gli utenti tipicamente organizzano i loro file all'inizio usando 
directory predefinite come Documenti, Musica, ecc. 

• Esempio: un profilo di Firefox si trova nella directory nascosta .mozilla/firefox/ 
 

• /lib  
 
• Questa directory contiene librerie di oggetti condivisi (analogamente alle DLL di 

Windows) che sono richieste all'avvio. In particolare, i moduli del kernel si 
trovano qui, sotto 
/lib/moduli. 

• Esempio: nessun file qui è comunemente accessibile agli utenti. 
 

• /media 

• I file per i supporti rimovibili come CDrom, unità floppy e chiavette USB 
sono installati qui quando i supporti sono montati automaticamente. 

• Esempio: Dopo aver montato dinamicamente una periferica come un'unità flash, 
si può accedere qui. 

• /mnt 

• I dispositivi di archiviazione fisica devono essere montati qui prima di potervi 
accedere. Dopo che le unità o le partizioni sono definite nel file /etc/fstab, il loro 
file system viene montato qui. 

• Esempio: Gli utenti possono accedere alle unità e alle partizioni montate qui. 
 

• /opt  
 
• Questa è la posizione prevista per i principali sottosistemi applicativi di terze 

parti installati dall'utente. 

• Esempio: se installate Google Earth, è qui che verrà installato. Alcune 
distro mettono anche i programmi installati dall'utente nelle sottodirectory 
/opt. 

• /processo 



• La posizione per le informazioni sul processo e sul sistema 

• Esempio: nessun file qui è comunemente accessibile agli utenti 



• /root 

• Questa è la home directory per l'utente root (amministratore). Notate che non è 
la stessa cosa di "/" la radice del file system. 

• Esempio: nessun file qui è comunemente accessibile agli utenti, ma i file salvati 
durante l'accesso come utente root possono essere salvati qui. 

• /sbin 

• I programmi sono installati qui se sono richiesti dagli script di avvio del 
sistema ma non saranno normalmente eseguiti da utenti diversi da root - in altre 
parole, le utilità di amministrazione del sistema. 

• Esempio: nessun file qui è comunemente accessibile agli utenti, ma qui è dove 
si trovano file come modprobe e ifconfig. 

• /tmp 

• Questa è la posizione dei file temporanei prodotti dai programmi, come i compilatori 
-mentre vengono eseguiti. In generale, questi sono file temporanei a breve 
termine, di uso per un programma solo mentre è in esecuzione. 

• Esempio: nessun file qui è comunemente accessibile agli utenti. 
 

• /usr 
 
 
 
 
 
 
 

• /var 

 
 
• Questa directory contiene molti file per le applicazioni utente, ed è analoga in 

qualche modo alla directory di Windows "Program Files". 

• Esempio: molti eseguibili si trovano in (/usr/bin) 

• Esempio: la documentazione (/usr/docs) e i file di configurazione, la grafica e 
le icone sono in (/usr/share). 

 
 
• Questa directory contiene file che cambiano costantemente mentre Linux è in esecuzione, 

per esempio i log, la posta di sistema e i processi in coda. 

• Esempio: si può guardare in /var/log/ quando si cerca di determinare cosa è 
successo durante un processo come l'installazione di un pacchetto. 

 
 
 

Il file system del disco 
Il file system del disco è qualcosa di cui l'utente medio non ha bisogno di preoccuparsi molto. 
Il file system predefinito del disco usato da MX Linux si chiama ext4, una versione del file 
system ext2 che è journaled - cioè, scrive le modifiche in un log prima di attuarle, rendendolo 
più robusto. Il file system ext4 è impostato durante l'installazione quando il disco rigido viene 
formattato. 



In generale, ext4 ha più anni di esperienza di qualsiasi suo rivale, e combina stabilità e velocità; 
per queste ragioni, non raccomandiamo di installare MX Linux su un diverso file system del 
disco a meno che non si sia ben informati sulle differenze. Tuttavia, MX Linux può leggere e 
scrivere su molti altri filesystem di dischi formattati, e può anche essere installato su alcuni di 
essi, se per qualche motivo uno di essi è preferito a ext4. 

 
 

Link 

• Wikipedia Filesystem 

• Wikipedia. Confronto tra i filesystem 

• Wikipedia Ext4 
 

7.3 Permessi 
MX Linux è un sistema operativo basato su account. Questo significa che nessun programma 
può essere eseguito senza un account utente sotto il quale girare, e qualsiasi programma in 
esecuzione è quindi limitato dai permessi concessi all'utente che lo ha avviato. 

 
 

NOTA: Gran parte della sicurezza e della stabilità per cui Linux è conosciuto dipende dall'uso 
corretto di account utente limitati e dalla protezione fornita dai permessi predefiniti di file e 
directory. Per questo motivo, si dovrebbe operare come root solo per una procedura che lo 
richiede. Mai entrare in MX Linux come root per far funzionare il computer per attività normali 
- eseguire un browser web come utente root, per esempio, è uno dei pochi modi per ottenere un 
virus su un sistema Linux! 

 

Informazioni di base 
La struttura predefinita dei permessi sui file in Linux è abbastanza semplice, ma più che 
adeguata per la maggior parte delle situazioni. Per ogni file o cartella, ci sono tre permessi che 
possono essere concessi, e tre entità (proprietario/creatore, gruppo, altri/mondo) a cui sono 
concessi. I permessi sono: 

• Il permesso di lettura significa che i dati possono essere letti dal file; significa anche che 
il file può essere copiato. Se non hai il permesso di lettura per una directory non puoi 
nemmeno vedere i nomi dei file elencati in essa. 

• Il permesso di scrittura significa che il file o la cartella possono essere cambiati, 
aggiunti o cancellati. Per le directory, specifica se un utente può scrivere sui file nella 
directory. 

• Il permesso di esecuzione significa se l'utente può o meno eseguire il file come script o 
programma. Per le directory, determina se l'utente può entrare e renderla la directory di 
lavoro corrente. Ogni file e cartella acquisisce un singolo utente designato come 
proprietario quando viene creato sul sistema. (Nota che se sposti un file da un'altra 
partizione dove ha un proprietario diverso, manterrà il proprietario originale; ma se lo 
copi e incolli, sarà assegnato a te). Ha anche un singolo gruppo designato come suo 
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gruppo, di default il gruppo a cui appartiene il proprietario. I permessi che concedi ad 
altri hanno effetto su tutti coloro che non sono il proprietario o nel gruppo di 
appartenenza. 



NOTA: Per gli utenti avanzati, ci sono ulteriori attributi speciali oltre a 
lettura/scrittura/esecuzione che possono essere impostati: sticky bit, SUID e SGID. Per maggiori 
informazioni, vedi la sezione Link qui sotto. 

 
Visualizzare, impostare e cambiare i permessi 
Ci sono molti strumenti disponibili in MX Linux per visualizzare e gestire i permessi. 

• GUI 

• Thunar. Per visualizzare o modificare i permessi di un file, fai clic con il tasto 
destro sul file e seleziona Proprietà. Clicca sulla scheda Permessi. Qui puoi 
impostare i permessi concessi al proprietario, al gruppo e ad altri usando i menu a 
tendina. Per alcuni file (come gli script, per esempio), è necessario selezionare la 
casella per renderli eseguibili, e per le cartelle è possibile selezionare una casella 
per limitare la cancellazione dei file al suo interno ai proprietari. 

• NOTA: dovete operare come root per cambiare i permessi di un file o di una 
directory il cui proprietario è root. Su cartelle più grandi si DEVE aggiornare la 
finestra di Thunar, altrimenti i permessi saranno visualizzati in modo errato, 
anche se i permessi sono effettivamente cambiati. Premi F5 per aggiornare la 
finestra, altrimenti vedrai i permessi originali. 

• MX User Manager è un modo semplice per cambiare i permessi associando 
un utente a gruppi specifici. 

• CLI 

• Partizioni interne. Per impostazione predefinita, la password di root/superuser è 
richiesta per montare le partizioni interne. Per cambiare questo 
comportamento, clicca su MX Tweak, Other tab. 

• Nuove partizioni esterne. Formattare una nuova partizione con ext4 richiede i 
permessi di root, il che può portare al risultato inaspettato o indesiderato che 
l'utente normale non sia in grado di scrivere alcun file sulla partizione. Per 
cambiare questo comportamento, consultare la Wiki di MX/antiX. 

• Operazioni manuali. Anche se MX User Manager copre la maggior parte delle 
situazioni quotidiane, a volte può essere preferibile trattare con la linea di 
comando. I permessi di base sono rappresentati da r (lettura), w (scrittura) e x 
(esecuzione); un trattino indica nessun permesso. Per visualizzare i permessi di 
un file sulla riga di comando, digitate questo: ls -l NameofFile. Potrebbe essere 
necessario utilizzare la posizione completa del file (ad esempio, /usr/bin/gimp). 
Lo switch -l farà sì che il file venga elencato in formato lungo, mostrando i suoi 
permessi tra le altre informazioni. 

 

https://mxlinux.org/wiki/system/format-ext4-filesystem-be-owned-regular-user


 
Figura 7-2: visualizzare i permessi dei file 



I caratteri subito dopo il trattino iniziale (che indica che è un file regolare) 
contengono i tre permessi (lettura/scrittura/esecuzione) per proprietario, gruppo 
e altri: 9 caratteri in totale. Qui mostra che il proprietario ha lettura e scrittura 
ma non esecuzione (rw-), ma il gruppo e gli altri possono solo leggere. Il 
proprietario in questo caso è specificato essere "newbie" che appartiene al 
gruppo "users". 

Se per qualche ragione fosse necessario cambiare la proprietà di questo file a root 
usando la linea di comando, usereste il comando chown come in questo esempio: 

chown root /home/newbie/.asoundrc 
Per i dettagli sull'uso di chown, così come il più dettagliato chmod, si veda la sezione Link. 

 
 

Link 

• MX/antiX Wiki: Permessi 

• Permessi per i file 
 

7.4 File di configurazione 

7.4.1 File di configurazione dell'utente 
I file che contengono le impostazioni individuali dell'utente (come i punteggi più alti per i tuoi 
giochi, o il layout del tuo desktop) sono memorizzati all'interno della home directory di un 
utente, tipicamente come file o directory nascosta, e possono essere modificati solo da 
quell'utente o da root. Questi file di configurazione personale sono in realtà meno spesso 
modificati direttamente dei file di sistema perché la maggior parte della configurazione utente è 
fatta graficamente attraverso le applicazioni stesse. Quando si apre un'applicazione e si clicca su 
Modifica > Preferenze, per esempio, le selezioni vengono scritte in un file di configurazione (di 
solito nascosto) nella propria directory utente. Allo stesso modo in Firefox, quando digiti 
about:config nella barra degli indirizzi, stai modificando i file di configurazione nascosti. I file di 
configurazione di Xfce sono memorizzati in ~/.config/. 

 

7.4.2 File di configurazione del sistema 
I file che contengono le configurazioni o le impostazioni predefinite del sistema (come il file 

che determina quali servizi vengono lanciati automaticamente all'avvio) sono in gran parte 
memorizzati nella directory /etc/ e sono modificabili solo da root. La maggior parte di questi file 
non sono mai toccati direttamente dagli utenti regolari, come questi per esempio: 

• /etc/rc.d/rc5.d - Contiene i file per controllare il runlevel 5 in cui MX Linux si avvia 
dopo il login. 

• /etc/sysconfig/keyboard - Usato per configurare la tastiera. 

• /etc/network/interfaces - Definisce le interfacce internet sul sistema. 

Alcuni file di configurazione possono contenere solo poche righe, o anche essere vuoti, mentre 
altri possono essere piuttosto lunghi. Il punto importante è che se state cercando un file di 
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configurazione per un'applicazione o un processo, andate nella directory /etc e guardatevi 
intorno. Attenzione: poiché questi file influenzano l'intero sistema, 1) fai un backup di qualsiasi 
file che intendi modificare (il più semplice in Thunar: copia e incolla di nuovo, aggiungendo 
BAK alla fine del nome del file), e 2) fai molta attenzione! 



7.4.3 Esempio 
I problemi di suono possono essere risolti con un certo numero di strumenti grafici e a riga di 
comando, ma una volta ogni tanto un utente ha bisogno di modificare direttamente il file di 
configurazione dell'intero sistema. Per molti sistemi, questo sarà /etc/modprobe.d/snd-hda-
intel.conf. È un semplice file il cui paragrafo superiore assomiglia a questo: 

 
 

# alcuni chip richiedono che il modello sia 
impostato manualmente # per esempio la serie asus 
g71 può richiedere model=g71v 

opzioni snd-hda-intel model=auto 
 

Per cercare di ottenere il suono, potreste decidere di sostituire le informazioni esatte sul 
modello di suono al posto della parola "auto". Per scoprire il vostro modello di suono, potreste 
aprire un terminale e digitare: 

lspci | grep Audio 
L'output dipenderà dal sistema, ma avrà la seguente forma: 

00:05.0 Dispositivo audio: nVidia Corporation MCP61 High Definition Audio (rev a2) 
Ora potete inserire queste informazioni nel file di configurazione: 

# alcuni chip richiedono che il modello sia 
impostato manualmente # per esempio la serie asus 
g71 può richiedere le opzioni model=g71v snd-hda-
intel model=nvidia 

Dovreste salvare il file, riavviare la macchina e, se tutto va bene, il vostro suono dovrebbe 
funzionare. Potresti anche provare con più precisione usando model=nvidia mcp61 invece, se il 
primo non ha funzionato. 

 
 

Link 

• Capire i file di configurazione di Linux 

• Permessi per i file 
 

7.5 Runlevels 
MX Linux si avvia di default usando sysVinit (un metodo diverso, systemd, è anche presente 
come opzione; non usa i runlevel allo stesso modo). Dopo aver completato il processo di avvio, 
init esegue tutti gli script di avvio in una directory specificata dal runlevel di default (questo 
runlevel è dato dalla voce per id in /etc/inittab). Come la maggior parte delle altre versioni di 
Linux, MX Linux ha 7 runlevel: 

 
 

Tabella 10: Livelli di esecuzione in MX Linux 
 

Runlevel Commento 
0 Fermare il sistema 
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1 Modalità utente singolo: fornisce una console di root 
senza logon. 

Utile se si perde la password di root 
2 Multiutente senza rete 
3 Accesso da console, senza X (cioè senza GUI) 
4 Non usato/personalizzato 
5 Accesso GUI predefinito 
6 Riavviare il sistema 

MX Linux ha come impostazione predefinita il runlevel 5, quindi qualsiasi script init impostato 
nel file di configurazione di livello 5 verrà eseguito all'avvio. 

 
Usa 
Capire i runlevel può essere utile. Quando gli utenti hanno un problema con X Window 
Manager, per esempio, non possono correggerlo sul runlevel 5 di default, perché X è in 
esecuzione su quel livello. Ma possono arrivare al runlevel 3 per lavorare sul problema in uno 
dei due modi. 

• Dal desktop: premete Ctrl-Alt-F1 per uscire da X. Per scendere effettivamente al 
runlevel 3, diventate root e digitate telinit 3; questo fermerà tutti gli altri servizi 
ancora in funzione sul runlevel 5. 

• Dal menu di GRUB: premete e (per modificare) quando vedete la schermata di GRUB. 
Nella schermata successiva, aggiungete uno spazio e il numero 3 alla fine della linea (di 
default dove si trova la parola "quiet") che inizia con "linux" situata una sopra la linea 
più bassa (il comando di avvio vero e proprio). Premete F-10 per avviare. 

Una volta che il cursore è su un prompt, fate il login con il vostro normale nome utente e 
password. Se necessario, potete anche effettuare il login come "root" e fornire la password 
amministrativa. Comandi utili quando state guardando il prompt su runlevel 3 includono: 



Tabella 11: Comandi comuni di runlevel 3 
 

Comando Commento 
runlevel Restituisce il numero del runlevel in cui ti 

trovi. 
fermare Esegui come root. Spegne la macchina. Se questo non funziona sul tuo 

sistema, prova poweroff. 
riavvio Esegui come root. Riavvia la macchina. 

<applicazione
> 

Esegue l'applicazione, purché non sia grafica. Per esempio, puoi usare il comando 
nano per modificare i file di testo, ma non leafpad. 

Ctrl-Alt-F7 Se hai usato Ctrl-Alt-F1 per uscire da un desktop in esecuzione ma non hai 
continuato fino al runlevel 3, questo comando ti riporta al tuo desktop. 

telinit 5 Esegui come root. Se sei sul runlevel 3, inserisci questo comando per 
arrivare al login manager lightdm. 

NOTA: questi comandi potrebbero cambiare in futuro se MX Linux passa a un nuovo gestore di 
sistema. 

 
 

Link 

• Wikipedia: Runlevel 

• Il Linux Information Project: Definizione di runlevel 
 
 
 

7.6 Il kernel 

7.6.1 Introduzione 

Questa sezione copre le comuni interazioni con il kernel incentrate sull'utente. Consultate i link 
per altri aspetti più tecnici 

7.6.2 Upgrade/Downgrading 

Base 
A differenza di altri software sul vostro sistema, il kernel non viene aggiornato automaticamente 
se non al di sotto del livello di revisione minore (indicato dal terzo numero nel nome del kernel). 
Prima di cambiare il vostro kernel attuale, fareste bene a porvi alcune domande: 

• Perché voglio aggiornare il kernel? C'è un driver di cui ho bisogno per un nuovo 
hardware, per esempio? 

• Dovrei fare un downgrade del kernel? Per esempio, i processori Core2 Duo tendono 
ad avere strani problemi con il kernel di default di MX-Linux che si risolvono 
passando al kernel di default Debian 4.9 (usando MX Package Installer). 

• Sono consapevole che i cambiamenti non necessari potrebbero portare problemi di un tipo o di un altro? 

MX Linux fornisce un metodo semplice per aggiornare/downgradare il kernel di default: aprite 
MX Package Installer e cliccate sulla categoria "Kernel". Lì vedrete un certo numero di kernel 
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che 



sono disponibili per l'utente. Scegliete quello che volete usare (chiedete sul forum se non siete 
sicuri) e installatelo. 

Una volta controllato e installato il nuovo kernel, riavvia e assicurati che il nuovo kernel sia 
evidenziato; se non lo è, clicca sulla linea delle opzioni e seleziona quello che vuoi. 

 

 
Figura 7-3: Opzioni del kernel in MX Package Installer per l'architettura a 64 bit 

 
Avanzato 
Ecco un approccio di base per aggiornare manualmente il kernel Linux sul tuo sistema. 

• Per prima cosa, scoprite cosa avete attualmente installato. Aprite un terminale e 
digitate inxi S. Per esempio, un utente della versione MX-19 64 bit potrebbe vedere 
qualcosa del genere: 

Kernel: 5.8.0-2-amd64 x86_64 bit 
Assicuratevi di scrivere il nome del kernel dall'output di quel comando. 

• In secondo luogo, selezionate e installate un nuovo kernel. Aprite Synaptic, cercate su 
linux-image e cercate un numero di kernel superiore che corrisponda all'architettura (per 
esempio, 686) e al processore (per esempio, PAE) che avete già, a meno che non abbiate 
una buona ragione per cambiare. Installate quello che volete o di cui avete bisogno nel 
solito modo. 

• Terzo, installate il pacchetto linux-headers che corrisponde al nuovo kernel che avete 
selezionato. Ci sono due metodi per farlo. 

• Guardate attentamente le voci di Synaptic che iniziano linux-headers e 
abbinate al kernel. 

• In alternativa, potete installare gli header più facilmente dopo aver riavviato il 
nuovo kernel digitando il seguente codice in un terminale di root: 

apt-get install linux-headers-$(uname -r) 
Le intestazioni saranno installate anche se si usa un comando come m-a prepare. 

• Quando si riavvia, si dovrebbe avviare automaticamente con il kernel più alto 
disponibile. Se non funziona, hai la possibilità di tornare a quello che stavi usando: 
riavvia, e quando vedi la schermata di GRUB evidenzia le Opzioni avanzate per qualsiasi 
partizione in cui vuoi fare il boot, poi seleziona il kernel e premi Invio. 

 

7.6.3 Aggiornamento del kernel e dei driver 
Dynamic Kernel Module Support (DKMS) ricompila automaticamente tutti i moduli driver 
DKMS quando viene installata una nuova versione del kernel. Questo permette ai driver e ai 
dispositivi al di fuori del kernel principale di continuare a funzionare dopo un aggiornamento 
del kernel Linux. L'eccezione riguarda i driver grafici proprietari (Sezione 3.3.2). 

https://en.wikipedia.org/wiki/Dynamic_Kernel_Module_Support


• Driver NVidia 

• Se installati con sgfxi, devono essere ricostruiti con sgfxi, vedi sezione 6.5.3 

• Se installato con il programma di installazione dei driver MX Nvidia o tramite 
synaptic/apt-get, i moduli del kernel potrebbero aver bisogno di essere ricostruiti. 
Eseguire nuovamente il programma di installazione dei driver MX Nvidia dal 
menu dovrebbe offrire la possibilità di reinstallare e ricostruire i moduli. Se il tuo 
riavvio si blocca al prompt della console, diventa root e inserisci "ddm-mx -i 
nvidia" per reinstallare e ricostruire i moduli del driver. 

• Driver Intel 

• Potrebbe essere necessario aggiornare il driver, a seconda del kernel 
selezionato come destinazione dell'aggiornamento. 

 
 
 

7.6.4 Altre opzioni 
Esistono altre considerazioni e scelte rispetto ai kernel: 

• Esistono altri kernel pre-rollati come il kernel Liquorix, che è una versione del kernel 
Zen ed è destinato a fornire una migliore esperienza di utilizzo del desktop in termini 
di reattività, anche sotto carichi pesanti come durante il gioco, più una bassa latenza 
(importante per il lavoro audio). MX Linux aggiorna il kernel Liquorix 
frequentemente, quindi è più facilmente installabile attraverso il MX Package Installer, 
nella sezione Kernel. 

• Le distro (ad esempio, la distro sorella di MX, antiX) spesso si rollano da sole. 

• Persone competenti possono compilare un kernel specifico per un hardware particolare. 
 

7.6.5 Link 
• Wikipedia: Kernel Linux 

• Anatomia del kernel Linux 

• Archivi del kernel Linux 

• Mappa interattiva del kernel Linux 
 

7.6.6 Panico del kernel e recupero 
Un panico del kernel è un'azione relativamente rara intrapresa dal sistema MX Linux quando 
rileva un errore fatale interno dal quale non può riprendersi in sicurezza. Può essere causato da 
una serie di fattori diversi che vanno da problemi hardware a un bug nel sistema stesso. Quando 
si ottiene un panico del kernel, provare a riavviare con MX Linux LiveMedium, che supererà 
temporaneamente qualsiasi problema software e, si spera, vi permetterà di vedere e scaricare i 
vostri dati. Se questo non funziona, allora scollegate tutto l'hardware non necessario e riprovate. 

La vostra prima preoccupazione è quella di accedere e proteggere i vostri dati. Si spera che 
abbiate fatto il backup da qualche parte. In caso contrario, potete usare uno dei programmi di 
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recupero dati come ddrescue che viene fornito con MX Linux. La tua ultima risorsa è portare il 
tuo disco rigido a un'azienda di recupero professionale. 



Ci sono una serie di passi che potreste dover fare per recuperare un sistema MX Linux 
funzionale una volta che i vostri dati sono al sicuro, anche se alla fine potreste dover 
reinstallare usando il LiveMedium. A seconda del tipo di guasto, si possono intraprendere i 
seguenti passi: 

1. Rimuovere i pacchetti che hanno rotto il sistema. 

2. Reinstallare il driver grafico. 

3. Reinstallare GRUB usando MX Boot Repair. 

4. Reimpostare la password di root. 

5. Reinstallate MX Linux, selezionando la casella di controllo sullo schermo 2 per 
mantenere /home in modo che le vostre configurazioni personali non vadano perse. 

Assicuratevi di chiedere sul forum se avete domande su queste procedure. 
 
 

Link 

• Pagina iniziale della libreria GNU C 

• Ddrescue 
 
 
 

7.7 Le nostre posizioni 

7.7.1 Systemd 

MX Linux viene fornito con due sistemi di init: SysVinit (predefinito) e systemd. Poiché l'uso 
di "systemd" come gestore di sistemi e servizi è stato controverso, vogliamo essere chiari 
sulla sua funzione in MX Linux: systemd è incluso ma non abilitato. Potete scansionare il 
vostro sistema MX e scoprire file con nomi di systemd*, ma questi forniscono semplicemente 
un hook/entrypoint di compatibilità quando necessario. 

 
MX Linux usa systemd-shim, che emula le funzioni di systemd che sono richieste per eseguire 
gli helper senza usare effettivamente il servizio. Questo significa che SysVinit rimane l'init 
predefinito, ma MX Linux può utilizzare i pacchetti Debian che hanno dipendenze da systemd 
come CUPS e Network Manager. Questo approccio permette anche all'utente di mantenere la 
possibilità di scegliere il suo init preferito all'avvio selezionando la voce systemd. 

 

7.7.2 Software non libero 
MX Linux è fondamentalmente orientato all'utente, quindi include una certa quantità di 
software non libero per assicurare che il sistema funzioni il più possibile fuori dalla scatola. 
L'utente può vedere una lista aprendo una console o un terminale e digitando: 

vrms 
 

Esempi: 
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https://fossbytes.com/difference-between-shell-console-terminal/


• Il driver "wl" (broadcom-sta) e il firmware non libero con componenti proprietari. 

• Uno strumento dedicato all'installazione dei driver grafici Nvidia. 

• Adobe Flash Player (distribuito su autorizzazione). 

La nostra motivazione: è molto più facile per gli utenti avanzati rimuovere questi driver che 
per gli utenti regolari installarli. Ed è particolarmente difficile installare un driver per una 
scheda di rete senza accesso a Internet! 



8 Glossario 
I termini di Linux possono essere confusi e sgradevoli all'inizio, quindi questo glossario 
fornisce una lista di quelli usati in questo manuale per iniziare. 

• applet: Un programma progettato per essere eseguito dall'interno di un'altra 
applicazione. A differenza di un'applicazione, le applet non possono essere eseguite 
direttamente dal sistema operativo. 

• backend: Anche /back-end./ Il backend include i vari componenti di un programma 
che elaborano l'input dell'utente inserito attraverso il frontend. Vedi anche frontend. 

• backport: I backport sono nuovi pacchetti che sono stati ricompilati per funzionare su 
una distribuzione rilasciata al fine di mantenerla aggiornata. 

• BASH: La shell predefinita (interprete della linea di comando) sulla maggior parte dei 
sistemi Linux e su Mac OS X, BASH è un acronimo per Bourne-again shell. 

• BitTorrent: Anche/bit torrent/ o /torrent./ Un metodo inventato da Bram Cohen per 
distribuire file di grandi dimensioni senza la necessità che un singolo individuo fornisca 
le risorse hardware, di hosting e di banda necessarie. 

• blocco di avvio: Un'area di un disco al di fuori del MBR che contiene 
informazioni per il caricamento del sistema operativo necessario per avviare un 
computer. 

• bootloader: Programma che inizialmente sceglie un sistema operativo da caricare dopo 
che il BIOS ha finito di inizializzare l'hardware. Di dimensioni estremamente ridotte, 
l'unico compito del bootloader è quello di passare il controllo del computer al kernel del 
sistema operativo. I bootloader avanzati offrono un menu per scegliere tra diversi sistemi 
operativi installati. 

• chainloading: Anche /chain loading./ Invece di caricare direttamente un sistema 
operativo, un boot manager come GRUB può usare il chain loading per passare il 
controllo da se stesso a un settore di boot su una partizione del disco rigido. Il settore 
d'avvio di destinazione viene caricato dal disco (sostituendo il settore d'avvio da cui è 
stato caricato il gestore d'avvio stesso) e viene eseguito il nuovo programma d'avvio. 
Oltre a quando è necessario, come nell'avvio di Windows da GRUB, il vantaggio del 
chainloading è che ogni sistema operativo sul disco rigido -e ce ne potrebbero essere 
dozzine- può essere responsabile di avere i dati corretti nel proprio settore di avvio. Così 
GRUB che risiede nell'MBR non ha bisogno di essere riscritto ogni volta che ci sono dei 
cambiamenti. GRUB può semplicemente caricare a catena le informazioni rilevanti dal 
settore di avvio di una data partizione, sia che sia cambiata o che sia rimasta la stessa 
dall'ultimo avvio. 

• codice cheat: I codici possono essere inseriti quando si avvia un LiveMedium per 
cambiare il comportamento di avvio. Sono usati per passare opzioni al sistema 
operativo MX Linux per impostare parametri per ambienti particolari. 

• interfaccia a riga di comando (CLI): Conosciuta anche come console, terminale, 
prompt dei comandi, shell o bash. Si tratta di un'interfaccia di testo in stile UNIX, a cui 
anche MS-DOS è stato progettato per assomigliare. Una console di root è quella in cui 
sono stati acquisiti i privilegi amministrativi dopo aver inserito la password di root. 

• ambiente desktop: il software che fornisce un desktop grafico (finestre, icone, desktop, 



barra delle applicazioni, ecc.) per un utente del sistema operativo. 
• immagine del disco: Un file che contiene il contenuto completo e la struttura di 

un supporto di memorizzazione dei dati o di un dispositivo come un disco rigido o 
un DVD. Vedi anche ISO. 



• Distribuzione: Una distribuzione Linux, o distro, è una particolare confezione del kernel 
Linux con vari pacchetti software GNU, e diversi desktop o gestori di finestre. Poiché, a 
differenza del codice proprietario usato nei sistemi operativi di Microsoft e Apple, 
GNU/Linux è un software libero e open source, letteralmente chiunque nel mondo che ne 
abbia la capacità può costruire liberamente su ciò che è stato fatto e innovare una nuova 
visione di un sistema operativo GNU/Linux. MX Linux è una distro basata sulla famiglia 
Debian Linux. 

• file system: Anche file system. Si riferisce al modo in cui i file e le cartelle sono 
organizzati logicamente sui dispositivi di archiviazione di un computer in modo che 
possano essere trovati dal sistema operativo. Può anche riferirsi al tipo di formattazione 
su un dispositivo di archiviazione, come i comuni formati di Windows NTFS e FAT32, 
o i formati di Linux ext3, ext4 o ReiserFS, e in questo senso si riferisce al metodo 
effettivamente utilizzato per codificare i dati binari sul disco rigido, floppy, flash drive, 
ecc. 

• firmware. I piccoli programmi e le strutture di dati che controllano internamente i 
componenti elettronici 

• libero come in un discorso: La parola inglese "free" ha due possibili significati: 1) 
senza costi, e 2) senza restrizioni. In parte della comunità del software open-source, 
un'analogia usata per spiegare la differenza è 1) "libero" come la birra vs. 2) "libero" 
come il discorso. La parola 
/freeware/ è usato universalmente per riferirsi al software che è semplicemente senza 
costo, mentre la frase /free software/ si riferisce vagamente al software che è più 
propriamente chiamato software open-source, concesso in licenza sotto qualche tipo di 
licenza open source. 

• frontend: Anche front-end. Il frontend è la parte di un sistema software che 
interagisce direttamente con l'utente. Vedi anche backend. 

• GPL: La GNU General Public License. Questa è una licenza sotto la quale vengono 
rilasciate molte applicazioni open-source. Specifica che è possibile visualizzare, 
modificare e ridistribuire il codice sorgente delle applicazioni rilasciate sotto di essa, 
entro certi limiti; ma che non si può distribuire il codice eseguibile a meno che non si 
distribuisca anche il codice sorgente a chiunque lo richieda. 

• GPT: Uno schema di partizionamento usato da UEFI nativo 
• Interfaccia grafica utente (GUI): Si riferisce a un programma o a un'interfaccia del 

sistema operativo che usa immagini (icone, finestre, ecc.), al contrario delle interfacce di 
testo (riga di comando). 

• directory home: Una delle 17 directory di primo livello che si diramano dalla directory 
principale in MX Linux, /home contiene una sottodirectory per ogni utente registrato del 
sistema. All'interno di ogni directory home degli utenti, questi ha pieni privilegi di 
lettura e scrittura. Inoltre, la maggior parte dei file di configurazione specifici dell'utente 
per vari programmi installati sono memorizzati in sottodirectory nascoste all'interno 
della directory /home/username/, così come la posta elettronica scaricata. Altri file 
scaricati di solito vanno di default nella directory home/username/Documents o 
/home/username/Desktop sottodirectory. 

• IMAP: L'Internet Message Access Protocol è un protocollo che permette a un client di 
posta elettronica di accedere a un server di posta remoto. Supporta modalità di 



funzionamento sia on-line che off-line. 
• interfaccia: Un punto di interazione tra i componenti del computer, spesso riferito al 

collegamento tra un computer e una rete. Esempi di nomi di interfacce in MX Linux 
includono WLAN (wireless) e eth0 (cablato di base). 

• IRC: Internet Relay Chat, un vecchio protocollo per facilitare lo scambio di 
messaggi di testo. 



• ISO: Un'immagine disco secondo uno standard internazionale che contiene file di dati e 
metadati del file system, compreso il codice di avvio, le strutture e gli attributi. Questo 
è il metodo normale per fornire versioni di Linux come MX Linux su Internet. Vedi 
anche immagine disco. 

• kernel: Il livello di software in un sistema operativo che interagisce direttamente 
con l'hardware. 

• LiveCD/DVD: Un compact disc avviabile da cui si può eseguire un sistema 
operativo, di solito con un ambiente desktop completo, applicazioni e funzionalità 
hardware essenziali. 

• LiveMedium: un termine generale che include sia LiveCD/DVD che LiveUSB. 
• LiveUSB: Una chiavetta USB su cui è stato caricato un sistema operativo in modo 

che possa essere avviato ed eseguito. Vedi LiveDVD. 
• indirizzo mac: un indirizzo hardware che identifica univocamente ogni nodo (punto di 

connessione) di una rete. È formato da una stringa di solito di sei serie di due cifre o 
caratteri, separati da due punti. 

• pagina man: Abbreviazione di manuale, le pagine man contengono tipicamente 
informazioni dettagliate su interruttori, argomenti e talvolta il funzionamento interno di 
un comando. Anche i programmi con interfaccia grafica hanno spesso pagine man, che 
descrivono in dettaglio le opzioni della linea di comando disponibili. Disponibile nel 
menu Start digitando un # prima del nome della pagina man che vuoi nella casella di 
ricerca, per esempio: #pulseaudio. 

• MBR: Master Boot Record: il primo settore di 512 byte di un disco rigido avviabile. Dati 
speciali scritti nel MBR permettono al BIOS del computer di passare il processo di avvio 
a una partizione con un sistema operativo installato. 

• md5sum: Un programma che calcola e verifica l'integrità dei dati di un file. L'hash MD5 
(o checksum) funziona come un'impronta digitale compatta di un file. È estremamente 
improbabile che due file non identici abbiano lo stesso hash MD5. Poiché quasi ogni 
modifica a un file farà cambiare anche il suo hash MD5, l'hash MD5 è comunemente 
usato per verificare l'integrità dei file. 

• specchio: Anche sito speculare. Una copia esatta di un altro sito Internet, 
comunemente utilizzato per fornire più fonti della stessa informazione per fornire 
un accesso affidabile a grandi download. 

• modulo: I moduli sono pezzi di codice che possono essere caricati e scaricati nel kernel 
su richiesta. Estendono la funzionalità del kernel senza la necessità di riavviare il sistema. 

• punto di montaggio: Il posto sul file system principale dove un dispositivo fisso o 
rimovibile è collegato (montato) e accessibile come sottodirectory. Tutto l'hardware del 
computer deve avere un punto di montaggio nel file system per essere utilizzabile. La 
maggior parte dei dispositivi standard come la tastiera, il monitor e l'hard disk primario 
sono montati automaticamente all'avvio. 

• mtp: MTP è l'acronimo di Media Transfer Protocol e opera a livello di file in modo 
che il dispositivo non esponga l'intero dispositivo di archiviazione. I vecchi dispositivi 
Android usavano la memoria di massa USB per trasferire i file avanti e indietro con un 
computer. 

• NTFS®: Il New Technology File System di Microsoft ha debuttato nel 1993 sul sistema 
operativo Windows NT, orientato alle reti aziendali, e con le revisioni è entrato nei 



computer desktop degli utenti Windows mainstream nelle versioni successive di 
Windows 2000. Ha 



è stato il file system standard da quando Windows XP è stato introdotto alla 
fine del 2001. Quelli orientati a Unix/Linux dicono che sta per "Nice Try 
File System"! 

• open-source: Software il cui codice sorgente è stato reso disponibile al pubblico sotto 
una licenza che permette agli individui di modificare e ridistribuire il codice sorgente. In 
alcuni casi, le licenze open-source limitano la distribuzione del codice binario 
eseguibile. 

• pacchetto: Un pacchetto è un insieme discreto e non eseguibile di dati che include 
istruzioni per il tuo gestore di pacchetti per l'installazione. Un pacchetto non sempre 
contiene una singola applicazione; potrebbe contenere solo una parte di una grande 
applicazione, diverse piccole utility, dati di font, grafica o file di aiuto. 

• gestore di pacchetti: Un gestore di pacchetti come (Synaptic o Gdebi) è un insieme 
di strumenti per automatizzare il processo di installazione, aggiornamento, 
configurazione e rimozione di pacchetti software. 

• Pannello: Il pannello altamente configurabile in Xfce4 appare di default sul lato 
sinistro dello schermo e contiene icone di navigazione, programmi aperti e notifiche di 
sistema. 

• Tabella delle partizioni: Una tabella delle partizioni è un'architettura del disco rigido che 
espande il vecchio schema di partizionamento Master Boot Record (MBR) usando 
identificatori unici globali (GUID) per permettere l'esistenza di più delle quattro 
partizioni originali. 

• persistenza: la capacità, quando si esegue una LiveUSB, di mantenere le modifiche 
fatte durante una sessione live. 

• porta: Una connessione dati virtuale che può essere usata dai programmi per scambiare 
dati direttamente, invece di passare attraverso un file o un altro luogo di archiviazione 
temporanea. Le porte hanno numeri assegnati per specifici protocolli e applicazioni, 
come 80 per HTTP, 5190 per AIM, ecc. 

• purge: Un comando che rimuove non solo il pacchetto nominato, ma anche qualsiasi file 
di configurazione e dati associati ad esso (anche se non quelli nella home directory di un 
utente). 

• repo: Una forma abbreviata di repository. 
• repository: Un repository di software è un luogo di archiviazione su internet da cui i 

pacchetti software possono essere recuperati e installati tramite un gestore di 
pacchetti. 

• radice: Root ha due significati comuni in un sistema operativo UNIX/Linux; 
sono intimamente connessi, ma la distinzione è importante da capire. 

• Il file system di root è la struttura logica di base di tutti i file a cui il sistema 
operativo può accedere, siano essi programmi, processi, pipe o dati. Dovrebbe 
seguire il Filesystem Hierarchy Standard di Unix, che specifica dove nella 
gerarchia localizzare tutti i tipi di file. 

• L'utente root che possiede il file system di root -e quindi ha tutti i permessi 
necessari per fare qualsiasi cosa a qualsiasi file. Mentre a volte è necessario 
assumere temporaneamente i poteri dell'utente /root/ per installare o configurare 
programmi, è pericoloso e viola la struttura di sicurezza di base di Unix/Linux 
accedere e operare come /root/ a meno che non sia assolutamente necessario. In 



un'interfaccia a riga di comando, un utente normale può diventare 
temporaneamente root dando il comando su e inserendo la password di root. 

• runlevel: Un runlevel è uno stato operativo preimpostato su un sistema operativo Unix-
like. Un sistema può essere avviato in uno qualsiasi dei diversi runlevel, ognuno dei 
quali è rappresentato da un numero intero a una cifra. Ogni runlevel designa una diversa 
configurazione del sistema e permette l'accesso a un 



diversa combinazione di processi (cioè istanze di programmi in esecuzione). Vedere la 
sezione 7.5. 

• script: Un file di testo eseguibile, contenente comandi in un linguaggio 
interpretato. Di solito si riferisce agli script BASH che sono usati ampiamente 
"sotto il cofano" del sistema operativo Linux, ma possono essere usati anche altri 
linguaggi. 

• sessione: Una sessione di login è il periodo di attività tra un utente che entra e esce da 
un sistema. In MX Linux, questo indica tipicamente la durata di un particolare 
"processo" utente (il codice del programma e la sua attività corrente) che Xfce invoca. 

• SSD: Un'unità a stato solido (SSD) è un dispositivo di archiviazione non volatile che 
memorizza dati persistenti su una memoria flash a stato solido. 

• codice sorgente: Il codice leggibile dall'uomo in cui il software è scritto prima di 
essere assemblato o compilato in codice di linguaggio macchina. 

• switch: Uno switch (anche /flag/, /option/ o /parameter/) è un modificatore aggiunto a 
un comando per cambiarne il comportamento. Un esempio comune è -R (ricorsivo), 
che dice al computer di eseguire il comando attraverso tutte le sottodirectory. 

• link simbolico: Anche link simbolico e soft link. Un tipo speciale di file che punta a un 
altro file o directory e non ai dati. Permette allo stesso file di avere nomi e/o posizioni 
diverse. 

• tarball: Un formato di archiviazione, come lo zip, popolare sulla piattaforma Linux. A 
differenza dei file zip, però, i tarball possono usare uno dei diversi formati di 
compressione, come gzip o bzip2. Di solito terminano con estensioni di file come .tgz, 
.tar.gz, o .tar.bz2. 
Molti formati di archivio sono supportati in MX con un'applicazione grafica chiamata 
Archive Manager. Di solito un archivio può essere estratto semplicemente cliccando con 
il tasto destro del mouse su di esso in Thunar. 

• (U)EFI: Unified Extensible Firmware Interface è un tipo di firmware di sistema 
utilizzato su macchine recenti. Definisce un'interfaccia software tra un sistema 
operativo e il firmware della piattaforma, e rappresenta il successore del vecchio 
BIOS. 

• Unix: Anche UNIX. Il sistema operativo su cui è modellato Linux, sviluppato alla fine 
degli anni '60 ai Bell Labs e usato principalmente per server e mainframe. Come Linux, 
Unix ha molte varianti. 

• UUID (Universally Unique IDentifier). Un identificatore universalmente unico (UUID) 
è un numero di 128 bit che identifica oggetti o dati Internet unici. 

• gestore di finestre: Un componente di un ambiente desktop che fornisce le funzioni 
base di massimizzazione/minimizzazione/chiusura/spostamento delle finestre 
nell'ambiente GUI. A volte può essere usato come alternativa ad un ambiente desktop 
completo. In MX Linux, il window manager predefinito è Xfce4. 

• X: Anche X11, xorg. L'X Window System è un protocollo di rete e di visualizzazione 
che fornisce finestre su display bitmap. Fornisce il toolkit e il protocollo standard per 
costruire interfacce utente grafiche (GUI) su sistemi operativi Unix-like e OpenVMS, 
ed è supportato da quasi tutti gli altri sistemi operativi moderni. 
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